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Overview of the Printer

This section shows the component names of the printer and describes their functions.

Main Components

Front View
Rear View
Inside View

4 Page top
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Main Components

m Front View

(1) (2 (3

(10)(3) & (V)

(1) Paper Guide

Pinch and slide it to align with the left side of the paper stack.

(2) Paper Support
Open to load paper in the Rear Tray.

(3) Rear Tray

Load various sizes or types of paper which you can use on the printer.

Two or more sheets of the same size and type of paper can be loaded at the same time, and fed
automatically one sheet at a time.

See Loading Paper.

(4) Front Cover

Open it when replacing the FINE Cartridges or removing jammed paper inside the printer.

(5) Paper Thickness Lever

Switches the clearance between the Print Head and the loaded paper to match the media type.

Note

Position of the Paper Thickness Lever
# Set to the right when printing on envelopes or T-shirt transfers.
# Set to the left when printing on paper other than envelopes or T-shirt transfers.
For details on the media types and the position of the Paper Thickness Lever, see Media
Types You can Use.

(6) Paper Output Slot

Printouts are output.

(7) Power Button

Turns the power on or off.

\‘ Important

Disconnecting the Power Plug
# When disconnecting the power plug after turning off the power, be sure to confirm that
the Power lamp is not lit. If the power plug is disconnected from the wall outlet while the
Power lamp is lit or flashing, the printer may become unable to print since the Print Head is
not protected.

(8) RESUME/CANCEL Button

Press to cancel a print job in progress. You can also press this button after resolving a printer error to
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dismiss an error message and resume printing.

(9) Alarm Lamp

Lights or flashes orange when an error, such as paper-out or ink-out, occurs.

(10) Power Lamp

Lights green after flashing when the power is turned on.

EEI Note

Power and Alarm lamps
# You can check the status of the printer by the Power and Alarm lamps.

- Power lamp Off: The power is off.

- Power lamp lit green: The printer is ready to print.

- Power lamp flashing green: The printer is getting ready to print, or printing is in progress.

- Alarm lamp flashing orange: An error has occurred and the printer is not ready to print. For
details, refer to the "Troubleshooting "in the on-screen manual: Advanced Guide.

- Power lamp flashes green once and Alarm lamp flashes orange once alternately: An error
that requires contacting your Canon service representative may have occurred. For details,
refer to the "Troubleshooting" in the on-screen manual: Advanced Guide.

m Rear View

(11) Power Cord Connector
Plug in the supplied power cord.

(12) USB Port

Plug in the USB cable to connect with a computer.

ﬁ Caution

# Do not touch the metal casing.

m Inside View

(13)

(13) FINE Cartridge Holder
Install the FINE Cartridges.

Ctp
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The Black FINE Cartridge should be installed into the left slot (B) and the Color FINE Cartridge should be
installed into the right slot (C).

(14) FINE Cartridges (Ink Cartridges)

A replaceable cartridge that is integrated with Print Head and ink tank.

Note

# For details on installing the FINE Cartridges, refer to the printed manual: Getting Started.

\‘ Important

# The area (A) indicated in the figure below may be splattered with ink. It does not affect the
performance of the printer.
Do not touch the area (A). The printer may not print out properly if you touch it.

4 Page top
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Printing

This section describes how to print documents or photos.
You can easily print photos taken with your digital camera by using Easy-PhotoPrint EX supplied with

your printer.

Printing Photos (Easy-PhotoPrint EX)

Using Various Functions of Easy-PhotoPrint EX
Printing Documents (Windows)

Printing Documents (Macintosh)

For Mac OS X v.10.5.x
For Mac OS X v.10.4.x or Mac OS X v.10.3.9

C
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Printing Photos (Easy-PhotoPrint EX)

Print image data saved on your computer by using Easy-PhotoPrint EX supplied with your printer.

This section describes the procedure, using print setting for borderless photo print on 4" x 6"/ 10 x 15 cm
photo paper as a sample.

For details on Easy-PhotoPrint EX, refer to the on-screen manual: Advanced Guide-

Note

# The screens used in this section are for printing with Windows. The operations are also the same
for printing with Macintosh.

# Install Easy-PhotoPrint EX from the Setup CD-ROM when it has not been installed or has been
uninstalled. To install Easy-PhotoPrint EX, select Easy-PhotoPrint EX in Custom Install.

1. Prepare for printing.

(1) Make sure that the printer is turned on.
See Front View.

(2) Load paper.
See Loading Paper.

Here we load 4" x 6"/ 10 x 15 cm photo paper.

2. Start Easy-PhotoPrint EX, and select Photo Print.
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(1) Start Easy-PhotoPrint EX.
[ VVindows |
fs
Double-click (## (Easy-PhotoPrint EX) on the desktop.

"“ Click Here: Easy-PhotoPrint EX

_ acinipsh|
Select the Go menu, Applications, Canon Utilities, Easy-PhotoPrint EX, then double-click Easy-
PhotoPrint EX.



Printing Photos (Easy-PhotoPrint EX)

E.j Note
| VWindaws |

|
# To start Easy-PhotoPrint EX from Solution Menu, double-click H (Solution Menu) on the

desktop and click a' (Print photos or albums, etc.).
See To Start Solution Menu.

# To start Easy-PhotoPrint EX from the Start menu, select All Programs (Programs in
Windows 2000), Canon Utilities, Easy-PhotoPrint EX, then Easy-PhotoPrint EX.

# To start Easy-PhotoPrint EX from Solution Menu, click H (Solution Menu) in the Dock and

click 3} (Print photos or albums, etc.).
See To Start Solution Menu,

(2) Click Photo Print.

E.j Note

# You can select Album, Calender, Stickers, etc., besides Photo Print.
See Using Various Functions of Easy-PhotoPrint EX .

3. Select a photo to print.

(1) Select the folder in which images are saved.

(2) Click the image to print.

The number of copies appears as "1", and the image you selected appears in the selected image area (A).

You can select two or more images at the same time.

E2 Note

# To print two or more copies, click = (Up arrow) to change the number of copies.

# To cancel the selection, click the image to cancel in the selected image area and click
(Delete Imported Image) . You can also use '*! (Down arrow) to change the number of
copies to zero.

# You can also correct or enhance the selected image.

See Using Various Functions of Easy-PhotoPrint EX .

(3) Select Select Paper.

4. Select the loaded paper.

C1p. 9 n3 334 c1p.
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(1) Make sure that your printer's name is selected in Printer.

(2) Select the loaded paper in Paper Size and Media Type.

Here we select 4"x6" 10x15cm in Paper Size and the type of loaded photo paper in Media Type.

Note

# If you select the wrong media type, the printer may not print with the proper print quality.

(3) Click Layout/Print.

5. Select a layout and start printing.
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(1) Select the layout of the photo.

Here we select Borderless [full].

The preview appears in the selected layout for confirmation of the required print result.

Note

# You can change the direction of a photo or crop a part of photo (trimming) to print.
For details on the operation, refer to the on-screen manual: Advanced Guide.

(2) Click Print.

Note
Windows|

# To cancel a print job in progress, press the RESUME/CANCEL button on the printer or click
Cancel Printing on the printer status monitor. To display the printer status monitor, click
Canon XXX (where "XXX" is your printer's name) on the taskbar.

' acinipsh
# Click the printer icon in the Dock to display the list of print jobs in progress.
# To cancel a print job in progress, select the desired job in the Name list and click Delete.

QC

4 Page top
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m Using Various Functions of Easy-PhotoPrint EX

This section describes a few of the useful functions of Easy-PhotoPrint EX.
For details, refer to the on-screen manual: Advanced Guide.

#® Creating Your Own Prints

You can create an album or calendar using your photos.

[ R
o g
MIETIE
P R

Stickers Layout Print

® Correcting Images

You can use Red-Eye Correction, Face Sharpener, Digital Face Smoothing, Brightness, Contrast, etc. to
adjust, correct, or enhance images automatically or manually.

Sample of the correction
: :-‘“E |

Brightness

QC
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Printing Documents (Windows)
Note

# Operations may vary depending on your software application. For details of the operation, refer to

the instruction manual of your application.
# The screens used in this section are for printing with Windows Vista operating system Ultimate

Edition (hereafter referred to as "Windows Vista").

1. Make sure that the printer is turned on.

See Front View.

2. Load paper.
See Loading Paper,

3. Create (or open) a document to print using an appropriate software application.

4. Open the printer properties dialog box.
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(1) Select Print in the File menu or from the command bar in your software

application.
The Print dialog box appears.

(2) Make sure that your printer's name is selected.

Note

# If another printer's name is selected, click and select your printer's name.

(3) Click Preferences (or Properties).

5. Specify the required print settings.
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(1) Select the media type of the loaded paper in Media Type.

E.j Note

# If you select the wrong media type, the printer may not print with the proper print quality.

(2) Specify the print quality, etc. in Print Quality and Color/Intensity as required.

E.j Note

# For details on the print quality, refer to the on-screen manual: Advanced Guide.

(3) Click OK.
EEI Note

# To confirm the page size, click the Page Setup tab. If the setting does not match the
document's page size already set in the software application, you need to reset the page size,
or otherwise use Scaled Printing or Fit-to-Page Printing.

For details, refer to the on-screen manual: Advanced Guide.

# For details on other printer driver functions, click Help or Instructions to view the online help or
the on-screen manual: Advanced Guide. The Instructions button appears on the Main and
Maintenance sheets if the on-screen manual is installed on your computer.

# To display the preview to confirm the print result, select the Preview before printing check box
in the Main sheet. Some software applications may not have a preview function.

6. Start printing.
Click Print (or OK) to start printing.
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EEI Note

# The message asking to confirm the position of the Paper Thickness Lever may appear. If the
message appears, make sure that the Paper Thickness Lever is set properly. See Loading
Paper.

® To cancel a print job in progress, press the RESUME/CANCEL button on the printer or click
Cancel Printing on the printer status monitor.

To display the printer status monitor, click Canon XXX (where " XXX" is your printer's name) on
the taskbar.

# |f printed ruled lines are misaligned or print results are unsatisfactory, adjust the print head
position. See Aligning the Print Head.

Ctp. 13 u3 334 cTp.
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Printing Documents (Macintosh)
Note

# Operations may vary depending on your software application. For details of the operation, refer to
the instruction manual of your application.

m For Mac OS X v.10.5.x

1. Make sure that the printer is turned on.
See Front View.

2. Load paper.
See Loading Paper,

3. Create (or open) a document to print using an appropriate software application.

4. Open the Print dialog box.
Select Print on the File menu in your software application.
The Print dialog box appears.

Note

# If the dialog box below appears, click #l(Down arrow).

5. Specify the required print settings.
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(1) Make sure that your printer's name is selected in Printer.
(2) Select the page size of the loaded paper in Paper Size.
(3) Select Quality & Media in the pop-up menu.

(4) Select the media type of the loaded paper in Media Type.

E.j Note

# If you select the wrong media type, the printer may not print with the proper print quality.

(5) Select the print quality in Print Quality.

E2 Note

# For details on the print quality, refer to the on-screen manual: Advanced Guide.

EEI Note

# For details on other printer driver functions, click ® (Question) on the Quality & Media, Color
Options, Borderless Printing, or Margin screen to view the on-screen manual: Advanced
Guide. If the on-screen manual is not installed, it does not appear even if  (Question) is
clicked.

# The preview appears on the left of the dialog box to confirm the print result. Some software
applications may not have a preview function.

6. Start printing.
Click Print to start printing.

EEI Note

# Click the printer icon in the Dock to display the list of print jobs in progress.

# To cancel a print job in progress, select the desired job in the Name list and click Delete. To
temporarily stop a job in progress, click Hold. To temporarily stop all the jobs in the list, click
Pause Printer.

# |f printed ruled lines are misaligned or print results are unsatisfactory, adjust the print head
position. See Aligning the Print Head.

C1p. 16 n3 334 crp.
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m For Mac OS X v.10.4.x or Mac OS X v.10.3.9

Note

# The screens used in this section are for printing in Mac OS X v.10.4.x.

1. Make sure that the printer is turned on.
See Front View.

2. Load paper.
See Loading Paper,

3. Create (or open) a document to print using an appropriate software application.

4. Specify the page size.
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(1) Select Page Setup on the File menu in your software application.
The Page Setup dialog box appears.

(2) Make sure that your printer's name is selected in Format for.
(3) Select the page size of the loaded paper in Paper Size.
(4) Click OK.

5. Specify the required print settings.
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(1) Select Print on the File menu in your software application.
The Print dialog box opens.

(2) Make sure that your printer's name is selected in Printer.
(3) Select Quality & Media in the pop-up menu.
(4) Select the media type of the loaded paper in Media Type.

Note




Printing Documents (Macintosh) Ctp

# If you select the wrong media type, the printer may not print with the proper print quality.

(5) Select the print quality in Print Quality.

E.j Note

# For details on the print quality, refer to the on-screen manual: Advanced Guide.

EEI Note

® For details on other printer driver functions, click ® (Question) on the Quality & Media, Color
Options, Special Effects, Borderless Printing, or Margin screen to view the on-screen manual:
Advanced Guide. If the on-screen manual is not installed, it does not appear even if &
(Question) is clicked.

# To display the preview to confirm the print result, click Preview. Some software applications

may not have a preview function.

6. Start printing.
Click Print to start printing.

E:I Note

# Click the printer icon in the Dock to display the list of print jobs in progress.

® To cancel a print job in progress, select the desired job in the Name list and click Delete. To
temporarily stop a job in progress, click Hold. To temporarily stop all the jobs in the list, click
Stop Jobs.

# |f printed ruled lines are misaligned or print results are unsatisfactory, adjust the print head
position. See Aligning the Print Head,

“+ Page top
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Using More Utilities

This section describes the useful functions to start supplied software applications on the desktop.

Solution Menu and My Printer

4 Page top
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Solution Menu and My Printer

Using Solution Menu or My Printer (Windows only), you can easily get the information of the printer, or
change the print settings by only clicking buttons on a screen.

With Solution Menu, you can start the software applications supplied with the printer or display the
operating instructions. It also provides you with the information on troubleshooting.

With My Printer, you can display the printer properties dialog box of the printer driver. It also provides you
with the information on how to take an action when you have trouble with the operation. My Printer is nof
available in Macintosh.

@ To Start Solution Menu
-
Double-click *# (Solution Menu) on the desktop.

S Click Here: Solution Menu
[_acinios
Click & (Solution Menu) in the Dock.

* The screens below are for Windows Vista.

Click the button of a function to use.
| | -
" After starting Solution Menu, click |~ (Window size: small) on the title bar to reduce the window size.

Sedunian Mares OE -1

fLTREwHRBa9

Note

# Install Solution Menu from the Setup CD-ROM when it has not been installed or has been
uninstalled. To install Solution Menu, select Solution Menu in Custom Install.
# The buttons displayed on the screen may vary depending on the country or region of purchase.
e
# To start Solution Menu from the Start menu, select All Programs (Programs in Windows 2000),
Canon Utilities, Solution Menu, then Solution Menu.
| acinlos!
# To start Solution Menu from the command bar, select the Go menu, Applications, Canon Utilities,
Solution Menu, then double-click Solution Menu.

® To Start My Printer

| VWindaws |
Double-click ® (My Printer) on the desktop.
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E.j Note

# You can also start My Printer from Solution Menu.
# Install My Printer from the Setup CD-ROM when it has not been installed or has been uninstalled. To
install My Printer, select My Printer in Custom Install.

# To start My Printer from the Start menu, select All Programs (Programs in Windows 2000), Canon
Utilities, My Printer, then My Printer.

- Page top
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Loading Paper

This section describes types of paper you can load and how to load printing paper in the Rear Tray.

Loading Paper

Media Types You can Use
Media Types You cannot Use
Loading Paper

Loading Envelopes

4 Page top
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Loading Paper

m Media Types You can Use

Choose papers suitable for printing, for the best print results. Canon provides you various types of paper

to enhance the fun of printing, such as stickers as well as papers for photo or document. We
recommend the use of Canon genuine paper for printing your important photos.

® Media Types

Commercially available papers

Plain Paper (Recycled Approx 100 Pla|n Paper
paper)*2 sheets
Envelopes 5 envelopes Right Envelope

Canon genuine papers

For printing documents:

<HR-101N>

Super White Paper Approx. 80 sheets Left Plain Paper
<SW-201>
For printing photos:
Photo Paper Pro Il A4, Letter, 5" x 7"/ 13 x 18 cm Left Photo Paper Pro Il
<PR-201>"3 and 8" x 10" /20 x 25 cm: 10
sheets

Glossy Photo Paper 4" x 6" /10 x 15 cm: 20 sheets Left Glossy Photo Paper
"Everyday Use"
<GP-501>"3
Photo Paper Glossy Left Glossy Photo Paper
<GP-502>"3
Photo Paper Plus Left Photo Paper Plus
Glossy Il Glossy I
<PP-201>"3
Photo Paper Plus Left Photo Paper Plus Semi-
Semi-gloss gloss
<SG-201>"3
Matte Photo Paper Left Matte Photo Paper
<MP-101>
For printing business documents:

— ?

h=F
High Resolution Paper |80 sheets Left High Resolution Paper

For creating your own prints:
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T-Shirt Transfers 1 sheet Right T-Shirt Transfers
<TR-301>

Photo Stickers 1 sheet Left Glossy Photo Paper
<PS-101>

*1 Paper with a Model Number is Canon genuine paper. Refer to the instruction manual supplied with
the paper for detailed information on the printable side and notes on handling paper. For information on
the page sizes available for each Canon genuine paper, visit our website. You may not be able to
purchase some Canon genuine papers depending on the country or region of purchase. Paper is not
sold in the US by Model Number. Purchase paper by name.

*2 Proper feeding of paper may not be possible at the maximum capacity depending on the type of paper
or environmental conditions (either very high or low temperature or humidity). In such cases, reduce the
number of paper you load at a time to less than half (100% recycled paper can be used).

*3 When loading paper in stacks, the print side may become marked as it is fed or paper may not feed
properly. In this case, load one sheet at a time.

® Page Sizes

You can use the following page sizes.
In Macintosh, Choukei 3 and Choukei 4 are not available.
Standard sizes:

® | etter (8.50 x 11.00 inches / 215.9 x 279.4 # |egal (8.50 x 14.00 inches / 215.9 x 355.6 mm)
mm)

® A5 (5.83 x 8.27 inches / 148.0 x 210.0 mm) ® A4 (8.27 x 11.69 inches / 210.0 x 297.0 mm)
® B5 (7.17 x 10.12 inches / 182.0 x 257.0 mm) ® 4" x 6" (4.00 x 6.00 inches / 10 x 15 cm)

# 4" x 8" (4.00 x 8.00 inches / 101.6 x 203.2 # 5" x 7" (5.00 x 7.00 inches / 13 x 18 cm)
mm)

# 8" x 10" (8.00 x 10.00 inches / 20 x 25 cm) # | (3.50 x 5.00 inches / 89.0 x 127.0 mm)
#® 2| (5.00 x 7.01 inches / 127.0 x 178.0 mm) # Hagaki (3.94 x 5.83 inches / 100.0 x 148.0 mm)

® Hagaki 2 (7.87 x 5.83 inches / 200.0 x 148.0 ® Comm. Env. #10 (4.12 x 9.50 inches / 104.6 x 241.3
mm) mm)

® DL Env. (4.33 x 8.66 inches / 110.0 x 220.0 #® Choukei 3 (4.72 x 9.25 inches / 120.0 x 235.0 mm)
mm)

# Choukei 4 (3.54 x 8.07 inches / 90.0 x 205.0 # Youkei 4 (4.13 x 9.25 inches / 105.0 x 235.0 mm)
mm)

® Youkei 6 (3.86 x 7.48 inches / 98.0 x 190.0 # Card (2.16 x 3.58 inches / 55.0 x 91.0 mm)
mm)

# Wide (4.00 x 7.10 inches / 101.6 x 180.6 mm)

Non-standard sizes:

You can also specify a custom size within the following range.
# Minimum size: 2.17 x 3.58 inches / 55.0 x 91.0 mm

& Maximum size: 8.50 x 23.00 inches / 215.9 x 584.2 mm

® Paper Weight

17 to 28 Ib / 64 to 105 gsm (plain paper except for Canon genuine paper)
Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the printer.

® Notes on Storing Paper

# Take out only the necessary number of paper from the package, just before printing.
# To avoid curling, when you do not print, put unused paper back into the package and keep it on a
level surface. And also, store them avoiding heat, humidity, and direct sunlight.
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m Media Types You cannot Use

Do not use the following types of paper. Using such paper will not only produce unsatisfactory results,
but can also cause the printer to jam or malfunction.

# Folded, curled, or wrinkled paper

# Damp paper

# Paper that is too thin (weighing less than 17 Ib / 64 gsm)

# Paper that is too thick (plain paper, except for Canon genuine paper, weighing more than 28 Ib / 105

gsm)
# Paper thinner than a postcard, including plain paper or notepad paper cut to a small size (when
printing on A5 or smaller sized paper)

# Picture postcards

# Postcards affixed with photos or stickers

# Envelopes with a double flap (or sticker flaps)

# Envelopes with an embossed or treated surface

# Envelopes with pressure seals

# Envelopes whose gummed flaps are already moistened and adhesive

# Any type of paper with holes

# Paper that is not rectangular

# Paper bound with staples or glue

# Paper with adhesives

# Paper decorated with glitter, etc.

Q0
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m Loading Paper
\‘ Important

#® If you cut plain paper into small paper such as 4" x 6"/ 10 x 15 cm, 4" x 8"/ 101.6 x 203.2 mm, 5" x
7"/ 13 x 18 cm, or 2.16" x 3.58" / 55.0 x 91.0 mm (Card size) to perform trial print, it can cause
paper jams.

#® Always load paper in the portrait orientation (A). Loading paper in the landscape orientation (B) can
cause paper jams.

(A) (B}

# When performing duplex printing, make sure that there is no uneven surface or no dust and stain on
the area (desk, etc.) where the printed paper is ejected. If there is uneven surface or dust and
stain on that area, the printing result and printer can be badly effected.

Note

# We recommend Canon genuine photo paper for printing photos.
For details on the Canon genuine paper, see Media Types You can Use.

#® You can use general copy paper. When printing on both sides, we recommend Canon's Super
White Paper.
For the page size and paper weight you can use for the printer, see Media Types You can Use.

1. Flatten the four corners of paper before loading it.

Note

# Align the edges of paper neatly before loading. Loading paper without aligning the edges may
cause paper jams.

# [f paper is curled, hold the curled corners and gently bend them in the opposite direction until
the paper becomes completely flat.
For details on flattening curled paper, refer to the "Troubleshooting" in the on-screen manual:
Advanced Guide.

2. Prepare for loading the paper.
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(1) Open the Paper Support.
(2) Adjust the position of the Paper Thickness Lever.

This lever switches the clearance between the Print Head and the loaded paper to match the media type.
Set it to the left when printing on plain paper.

Set it to the right when printing on envelopes or T-shirt transfers.

Note

# If the corners or edges of paper are smudged, try to print with the Paper Thickness Lever
set to the right. It may improve print quality.
Reset the Paper Thickness Lever to the left when you finish printing.

3. Load paper.

(1) Align the paper stack against the right side of the Rear Tray (A) and load it WITH
THE PRINT SIDE FACING YOU and WITH THE BOTTOM UP.

Note
# Do not load higher than the Load Limit Mark (B).
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(2) Pinch the Paper Guide and slide it against the left side of the paper stack.
Do not slide the Paper Guide too hard. The paper may not be fed properly.

Note

# The printer may make operating noise when feeding paper.

Note

After loading paper
# Select the size and type of the loaded paper in Page Size (or Paper Size) and Media Type in the
printer driver. See Printing Documents (Windows) or Printing Documents (Macintosh).

Q0
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Contents > Loading Paper > Loading Paper > Loading Envelopes

m Loading Envelopes

You can print on European DL and US Comm. Env. #10-sized envelope.
The address is automatically rotated and printed according to the envelope's direction by specifying with
the printer driver properly.

\‘ Important

# You cannot use the following envelopes.
- Envelopes with an embossed or treated surface
- Envelopes with a double flap (or sticker flaps)
- Envelopes with pressure seals
- Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.
# Press down on all four corners and edges of the envelopes to flatten them.

= If the envelopes are curled, hold the opposite corners and gently twist them in the
opposite direction.

e B

# If the corner of the envelope flap is folded, flatten it.

# Use a pen to press the leading edge in the inserting direction flat and sharpen the
crease.

The figures above show a side view of the leading edge of the envelope.

\‘ Important

# The envelopes may jam in the printer if they are not flat or the edges are not aligned. Make
sure that no curl or puff exceeds 0.1 inches / 3 mm.

2. Load the envelopes.



Loading Envelopes Ctp. 31 n3 334 cTp.

(B) Rear side
(C) Address side

(1) Align the envelopes against the right side of the Rear Tray (A) and load it WITH
THE ADDRESS SIDE FACING YOU.

The folded flap of the envelope will be faced down on the left side.

Up to 5 envelopes can be loaded at once.

(2) Pinch the Paper Guide and slide it against the left side of the envelopes.
Do not slide the Paper Guide too hard. The paper may not be fed properly.

(3) Set the Paper Thickness Lever to the right.

Reset the Paper Thickness Lever to the left when you finish printing.

3. Specify the settings in the printer driver.
(1) Select Envelope in Media Type.

(2) Select the size for envelopes.

[ VVindaws |
Select DL Env. or Comm. Env. #10 in Page Size.

Select DL Envelope or #10 Envelope in Paper Size.

(3) Select Landscape in Orientation.
\‘ Important

# |f you do not specify Page Size (or Paper Size) or Orientation properly, the address will be
printed upside down or will be turned to 90 degrees.

EEI Note

# The printer may make operating noise when feeding envelopes.
# In Windows, if the print result is upside down, select Rotate 180 degrees on the Page Setup
sheet in the printer properties dialog box of the printer driver.

O
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Basic Guide -

Contents > Routine Maintenance

Routine Maintenance

This section describes how to clean the printer when the print result is faint, to replace a FINE Cartridge
when it runs out, or to take an action when paper does not feed properly.

When Printing Becomes Faint or Colors Are Incorrect

Printing the Nozzle Check Pattern
Examining the Nozzle Check Pattern
Cleaning the Print Head

Cleaning the Print Head Deeply
Aligning the Print Head

Replacing a FINE Cartridge

Checking the Ink Status
Replacing Procedure

Cleaning the Paper Feed Roller

Opening the Maintenance Screens

Opening the Printer Properties Dialog Box (Windows)
Opening the Canon IJ Printer Utility (Macintosh)

C
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Basic Guide u u

Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect

When Printing Becomes Faint or Colors Are Incorrect

If print results are blurred or colors are not printed correctly, the print head nozzles (FINE Cartridges) are
probably clogged. Follow the procedure below to print the nozzle check pattern, check the print head
nozzle condition, then clean the Print Head.

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, aligning the Print Head
may improve print quality.

A Caution

# Do not rinse or wipe the FINE Cartridges. This can cause trouble with the FINE Cartridges.

% Note

Before performing maintenance

# Make sure that a FINE Cartridge has not run out of ink. See Checking the Ink Status.

# Make sure that FINE Cartridges are installed properly. See Replacing a FINE Cartridge.

# Make sure that the orange protective tape is removed from the bottom of a FINE Cartridge.

# If the Alarm lamp flashes orange, refer to the " Troubleshooting" in the on-screen manual:
Advanced Guide.

# |Increasing the print quality in the printer driver settings may improve the print result.
For details, refer to the on-screen manual: Advanced Guide.

® \When the Print Results Are Blurred or Uneven:

If the pattern is missing:

v

After cleaning the Print Head, print
and examine the nozzle check
pattern.

If the problem is not resolved after cleaning the Print Head
twice:

v

If the problem is not resolved after cleaning the Print Head
deeply twice:

v

® When the Print Results Are Not Even Such As the Ruled Lines
Are Misaligned:

QC
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Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Printing the Nozzle Check
Pattern

m Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzles.

You need to prepare: a sheet of A4 or Letter-sized plain paper

Note

# |f the remaining ink level is low, the nozzle check pattern will not be printed correctly. Replace the
FINE Cartridge whose ink is low.
See Replacing a FINE Cartridge,

-

1. Make sure that the power is turned on and a sheet of A4 or Letter-sized plain paper
are loaded in the Rear Tray.

Set the Paper Thickness Lever to the left. See Front View.

2. Open the printer properties dialog box.
See Opening the Printer Properties Dialog Box (Windows) .

3. Print the nozzle check pattern.
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(1) Click the Maintenance tab.
(2) Click Nozzle Check.
(3) Confirm the displayed message and click Print Check Pattern.

The nozzle check pattern will be printed. Do not open the Front Cover while printing is in progress.

Note

# Clicking Initial Check Items displays the items to be checked before printing the pattern.

4. Examine the pattern.
See Examining the Nozzle Check Pattern.

LW pimi
SALA TLLI D |

1. Make sure that the power is turned on and a sheet of A4 or Letter-sized plain paper



Printing the Nozzle Check Pattern

are loaded in the Rear Tray.
Set the Paper Thickness Lever to the left. See Front View.

2. Open the Canon IJ Printer Utility dialog box.
See Opening the Canon IJ Printer Utility (Macintosh).

3. Print the nozzle check pattern.
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e

(1) Select Test Print in the pop-up menu.
(2) Click Nozzle Check.
(3) Confirm the displayed message and click Print Check Pattern.

The nozzle check pattern will be printed. Do not open the Front Cover while printing is in progress.

Note

# Clicking Initial Check ltems displays the items to be checked before printing the pattern.

4. Examine the pattern.
See Examining the Nozzle Check Pattern.

QO
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Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Examining the Nozzle Check
Pattern

m Examining the Nozzle Check Pattern
Examine the nozzle check pattern, and clean the Print Head if necessary.

1. Check if lines are missing in the pattern (1), or if there are white streaks in the
pattern (2).

-1 Fo
11
-1
Tl —(2
i-1
-1
R |

(1) Check if lines are missing in this pattern.
If yes, the cleaning is required.

=8 A

(A) (B)

(A) Good
(B) Bad (Lines are missing)

(2) Check if there are white streaks in this pattern.
If yes, the cleaning is required.

(A) (B)

(A) Good
(B) Bad (White streaks present)

2. Take necessary action.

* When the cleaning is not required
Click Exit (Windows) or Quit (Macintosh) on the Pattern Check dialog box to exit nozzle check
pattern examination.

= When the cleaning is required

i
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Click Cleaning.

Make sure that a sheet of A4 or Letter-sized plain paper are loaded in the Rear Tray, and then
proceed to the procedure below.

v
Go to the procedure of (3) in step 3.

M=

Go to the procedure of (3) in step 3.

Q0
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Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Cleaning the Print Head

m Cleaning the Print Head

Clean the Print Head if lines are missing or if there are white streaks in the printed nozzle check pattern.
Cleaning unclogs the nozzles and restores the print head condition. Cleaning the Print Head consumes
ink, so clean the Print Head only when necessary.

You need to prepare: a sheet of A4 or Letter-sized plain paper

.-."-'f-
If you click Cleaning on the Pattern Check dialog box that appears after printing the nozzle check pattern,

the printer starts cleaning the Print Head. Make sure that a sheet of A4 or Letter-sized plain paper are
loaded in the Rear Tray, then go to the procedure of (3) in step 3.

1. Make sure that the power is turned on and a sheet of A4 or Letter-sized paper are
loaded in the Rear Tray.

Set the Paper Thickness Lever to the left. See Front View.

2. Open the printer properties dialog box.
See Opening the Printer Properties Dialog Box (Windows) .

3. Clean the Print Head.
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(1) Click the Maintenance tab.
(2) Click Cleaning.

The printer starts cleaning the Print Head when the Power lamp starts flashing green.

Do not perform any other operations until the printer completes the cleaning of the Print Head. This takes
about 1 minute.

(3) Confirm the displayed message and click Print Check Pattern.

The nozzle check pattern will be printed.

Do not perform any other operations until the printer completes the printing of the nozzle check pattern.

4. Check the printed nozzle check pattern.
See Examining the Nozzle Check Pattern.

Note

# |f the problem is not resolved after cleaning the Print Head twice, clean the Print Head deeply.
See Cleaning the Print Head Deeply.
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If you click Cleaning on the Pattern Check dialog box that appears after printing the nozzle check pattern,
the printer starts cleaning the Print Head. Make sure that a sheet of A4 or Letter-sized plain paper are
loaded in the Rear Tray, then go to the procedure of (3) in step 3.

1. Make sure that the power is turned on and a sheet of A4 or Letter-sized paper are
loaded in the Rear Tray.

Set the Paper Thickness Lever to the left. See Front View.

2. Open the Canon IJ Printer Utility dialog box.
See Opening the Canon IJ Printer Utility (Macintosh).

3. Clean the Print Head.
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(1) Make sure that Cleaning is selected in the pop-up menu.
(2) Click Cleaning.
(3) Confirm the displayed message and click OK.

The printer starts cleaning the Print Head when the Power lamp starts flashing green.

Do not perform any other operations until the printer completes the cleaning of the Print Head. This takes
about 1 minute.

E.j Note

# Clicking Initial Check Items displays the items to be checked before cleaning.

(4) Confirm the displayed message and click Print Check Pattern.

The nozzle check pattern is printed.

Do not perform any other operations until the printer completes the printing of the nozzle check pattern.

4. Check the printed nozzle check pattern.
See Examining the Nozzle Check Pattern.

EEI Note

# |f the problem is not resolved after cleaning the Print Head twice, clean the Print Head deeply.
See Cleaning the Print Head Deeply.

QO
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Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Cleaning the Print Head
Deeply

m Cleaning the Print Head Deeply

If print quality does not improve by standard Print Head Cleaning, clean the Print Head deeply. Print Head
Deep Cleaning consumes more ink than standard Print Head Cleaning, so clean the Print Head deeply
only when necessary.

i

1. Make sure that the power is turned on.

2. Open the printer properties dialog box.
See Opening the Printer Properties Dialog Box (Windows) .

3. Clean the Print Head deeply.
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(1) Click the Maintenance tab.
(2) Click Deep Cleaning.
(3) Confirm the displayed message and click Execute.

Note

# Clicking Initial Check Items displays the items to be checked before cleaning the Print Head
deeply.

(4) Confirm the displayed message and click OK.

The printer starts cleaning the Print Head deeply when the Power lamp starts flashing green.

Do not perform any other operations until the printer completes the deep cleaning of the Print Head. This
takes about 1 or 2 minutes.

4. Print the nozzle check pattern to check the print head condition.
See Printing the Nozzle Check Pattern.

Note

# |f the problem is not resolved, clean the Print Head deeply again.

# [f this does not solve the problem, ink may have run out. Replace the FINE Cartridge with a new
one. See Replacing a FINE Cartridge,

SALATLO |

1. Make sure that the power is turned on.
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2. Open the Canon |J Printer Utility dialog box.
See Opening the Canon IJ Printer Utility (Macintosh).

3. Clean the Print Head deeply.
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(1) Make sure that Cleaning is selected in the pop-up menu.
(2) Click Deep Cleaning.
(3) Confirm the displayed message and click OK.

The printer starts cleaning the Print Head deeply when the Power lamp starts flashing green.

Do not perform any other operations until the printer completes the deep cleaning of the Print Head. This
takes about 1 or 2 minutes.

E2 note

# Clicking Initial Check Items displays the items to be checked before cleaning the Print Head
deeply.

4. Print the nozzle check pattern to check the print head condition.
See Printing the Nozzle Check Pattern.

EEI Note

# |f the problem is not resolved, clean the Print Head deeply again.
# [f this does not solve the problem, ink may have run out. Replace the FINE Cartridge with a new
one. See Replacing a FINE Cartridge,

QC

4 Page top



Aligning the Print Head Ctp. 42 13 334 c1p.

Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Aligning the Print Head

m Aligning the Print Head

If printed ruled lines are misaligned or print results are not even, adjust the print head position.
You need to prepare: a sheet of A4 or Letter-sized plain paper
.-ﬁg

1. Make sure that the power is turned on and a sheet of A4 or Letter-sized plain paper
are loaded in the Rear Tray.

Set the Paper Thickness Lever to the left. See Front View.

2. Open the printer properties dialog box.
See Opening the Printer Properties Dialog Box (Windows) .

3. Print the print head alignment pattern.
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(1) Click the Maintenance tab.

(2) Click Print Head Alignment.

(3) Confirm the displayed message, and click OK.

The print head alignment pattern will be printed. Do not open the Front Cover while printing is in progress.
Printing takes about 3 minutes to complete.

(4) After the pattern below is printed, make sure that the pattern is printed properly,
and click Yes.
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Aligning the Print Head

4. Adjust the print head position.

o -

(1) Look at the printout and select the pattern number in column A that has the least
noticeable streaks.

Ewncute prri head shgrment. Examne ihe prrted patters. and enter tha
patiem nusmbesr of the puatbem weth the beaes notceable smncs in the feids
for columns Ato L
Acstment in Coluena Ao F (Sig +5)
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Cooluemn E o
Cobusn F i
eramrrtrmeN) Achustmant in Coluena Gito L (500 5
Cokmn G 0
Coolurmn H "
"uirr_ [¥
Coluen o
Coluen K [id
Coluen | o
| O | Carcel Heig
I:.:I Note

# If it is difficult to pick the best pattern, pick the setting that produces the least noticeable
white streaks.

(A) (8)
— =
(© (D)

(A) Less noticeable vertical white streaks
(B) Noticeable vertical white streaks
(C) Less noticeable horizontal white streaks

(D) Noticeable horizontal white streaks

(2) Repeat the procedure until you finish selecting the pattern number for column L,
and click OK.

(3) Confirm the displayed message, and click OK.

Make sure that the power is turned on and a sheet of A4 or Letter-sized plain paper
are loaded in the Rear Tray.
Set the Paper Thickness Lever to the left. See Front View.

. Open the Canon IJ Printer Utility dialog box.

See Opening the Canon IJ Printer Utility (Macintosh).

Print the print head alignment pattern.
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(1)

(2)

(1) Select Test Print in the pop-up menu.

(2) Click Print Head Alignment.

(3) Confirm the displayed message, and click OK.

The print head alignment pattern will be printed. Do not open the Front Cover while printing is in progress.
Printing takes about 3 minutes to complete.
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4. Adjust the print head position.
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(1) Look at the printout and select the pattern number in column A that has the least

noticeable streaks.

Print Head Alkgnment

Execute head alignment, Examine the printed patterns, and enter the pattern number of
the patters with the least naticeable streaks in the fields for columns A te L
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# If it is difficult to pick the best pattern, pick the setting that produces the least noticeable
white streaks.

(A) (8)
=—— =
(© (D)

(A) Less noticeable vertical white streaks
(B) Noticeable vertical white streaks
(C) Less noticeable horizontal white streaks

(D) Noticeable horizontal white streaks

(2) Repeat the procedure until you finish selecting the pattern number for column L,
and, click Send.

QO
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Replacing a FINE Cartridge
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Contents > Routine Maintenance > Replacing a FINE Cartridge

Replacing a FINE Cartridge

When ink runs out while printing is in progress, the Alarm lamp flashes orange four times and the error

message will appear on your computer screen. Make sure which ink has run out and replace it with a
new FINE Cartridge.

Note

# If the error message appears, confirm the displayed message and take an appropriate action

For details, refer to the "Four Flashes: Ink has run out." of the "Alarm Lamp Flashes Orange" in the "
Troubleshooting" of the on-screen manual: Advanced Guide.

# For information on compatible FINE Cartridges, refer to the printed manual: Getting Started

m Checking the Ink Status

You can check the ink status of each FINE Cartridge on the printer status monitor (Windows) and
Canon IJ Printer Utility (Macintosh).

Note

# The ink level detector is mounted on the printer to detect the remaining ink level. The printer
considers as ink is full when a new FINE Cartridge is installed, and then starts to detect a
remaining ink level. If you install a used FINE Cartridge, the indicated ink level of it may not be
correct. In such case, refer to the ink level information only as a guide.

Windows| _acintosh
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(A) Check if any symbol appears on the screen.

# Ink with & (Ink low) is running low. You can continue printing for a while, but we
recommend you to have a new FINE Cartridge available.

Follow the procedure below to open each of the confirmation screens.
.-."-'f-
(1) Open the printer properties dialog box.

See Opening the Printer Properties Dialog Box (Windows) .

(2) Click the Maintenance tab, and View Printer Status.
To confirm the ink level information, click the Ink Details menu.

Note

# You can also display the printer status monitor by clicking Canon XXX (where " XXX" is
your printer's name) which appears on the taskbar during printing.

;4?9'?"-'-\

ALATILLN ]

(1) Open the Canon |J Printer Utility.
See Opening the Canon IJ Printer Utility (Macintosh).

(2) Select Ink Level Information in the pop-up menu.
To confirm the ink level information, click Ink Details.



Replacing a FINE Cartridge Ctp. 47 n3 334 cTp.

Q0

 Page top



Replacing Procedure Ctp. 48 n3 334 ctp.

Contents > Routine Maintenance > Replacing a FINE Cartridge > Replacing Procedure

m Replacing Procedure

When FINE Cartridges run out of ink, follow the procedure below to replace them.
\‘ Important

Handling FINE Cartridges
# Do not touch the electrical contacts (A) or print head nozzles (B) on a FINE Cartridge. The
printer may not print out properly if you touch it.

# To maintain optimal printing quality, we recommend the use of specified Canon brand FINE
Cartridges.

Refilling ink is not recommended.

# If you remove a FINE Cartridge, replace it immediately. Do not leave the printer with FINE
Cartridges removed.

# Replace empty cartridges with new ones. If you insert FINE Cartridges that have been
removed once, the printer may not print out properly due to some reasons such as clogging of
the nozzles.

Furthermore, with such cartridges, the Low Ink Warning may not appear properly.

# To maintain optimal print quality, install FINE Cartridges in the printer within the date indicated on
the package box. And also use up FINE Cartridges within six months after the installation (We
recommend you to put down the date when installing them).

Note

# If a FINE Cartridge runs out of ink, you can print with either Color or Black FINE Cartridge, in
whichever ink remains, only for a while. However the print quality may be reduced compared
to when printing with both cartridges. We recommend to use new FINE cartridges in order to
obtain optimum qualities.

Even when printing with one ink only, print with leaving the empty FINE Cartridge installed. If
either of the Color FINE Cartridge or Black FINE Cartridge is not installed, an error occurs and
the printer cannot print.

For information on how to configure this setting, refer to the on-screen manual: Advanced
Guide.

# Color ink may be consumed even when printing a black-and-white document or when black-
and-white printing is specified.

Every ink is also consumed in Print Head Cleaning and Print Head Deep Cleaning, which may
be necessary to maintain the printer's performance. When ink has run out, replace the FINE
Cartridge immediately with a new one.

1. Make sure that the power is turned on, and open the Front Cover.
The FINE Cartridge Holder moves to the replacement position.

ﬁ Caution

# Do not hold the FINE Cartridge Holder to stop or move it forcibly.
# Do not touch the metallic parts or other parts inside the printer.




Replacing Procedure

\‘ Important

# |f the Front Cover is left open for more than 10 minutes, the FINE Cartridge Holder moves to the
right. In this case, close and reopen the Front Cover.

2. Remove the empty FINE Cartridge.

'... e i

(1) Push down the FINE Cartridge.
(2) Remove the FINE Cartridge.

\‘ Important

# Handle FINE Cartridges carefully to avoid staining of clothing or the surrounding area.
# Discard empty FINE Cartridges according to the local laws and regulations regarding disposal
of consumables.

3. Prepare the new FINE cartridge.

Take the new FINE Cartridge out of its package and remove the orange protective tape (A) gently.

\‘ Important

# [f you shake a FINE Cartridge, ink may spill out and stain your hands or the surrounding area.
Handle FINE Cartridges carefully.

# Be careful not to stain your hands or surrounding area with ink on the removed protective
tape.

# Do not reattach the protective tape once you have removed it. Discard it according to the local
laws and regulations regarding disposal of consumables.

# Do not touch the electrical contacts or print head nozzles on a FINE Cartridge. The printer may

C1p. 49 n3 334 cTp.
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not print properly if you touch it.

4. Install the FINE Cartridge.

(1) Insert a new FINE Cartridge all the way into the appropriate slot.
The Black FINE Cartridge should be installed into the left slot (B) and the Color FINE Cartridge should be into
the right slot (C).

(2) Push up the FINE Cartridge until it clicks into place.
\‘ Important

# The printer cannot print unless both the Black and Color FINE Cartridges are installed. Be sure
to install both the FINE Cartridges.

5. Close the Front Cover.

EEI Note

# |f the Alarm lamp still flashes orange after the Front Cover is closed, refer to the "
Troubleshooting" in the on-screen manual: Advanced Guide-

# When you start printing after replacing the FINE Cartridge, the printer starts cleaning the Print
Head automatically. Do not perform any other operations until the printer completes the
cleaning of the Print Head. The Power lamp flashes green during cleaning.

# |f the printed ruled lines are misaligned or the print head position is misaligned, align the print
head position.

See Aligning the Print Head,

QO
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Cleaning the Paper Feed Roller

If the Paper Feed Roller is dirty or paper powder is attached to it, paper may not be fed properly. In this
case, clean the Paper Feed Roller. Cleaning will wear out the Paper Feed Roller, so perform this only
when necessary.

You need to prepare: three sheets of A4 or Letter-sized plain paper

1. Make sure that the power is turned on, and remove any paper from the Rear Tray.

2. Open the printer properties dialog box.
See Opening the Printer Properties Dialog Box (Windows) .

3. Clean the Paper Feed Roller.
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(1) Click the Maintenance tab.
(2) Click Roller Cleaning.
(3) Confirm the displayed message, and click OK.

The Paper Feed Roller will rotate as they clean.

4. Make sure that the Paper Feed Roller stops rotating. When the message appears,
load paper.
Load three sheets of A4 or Letter-sized plain paper in the Rear Tray.
Set the Paper Thickness Lever to the left. See Front View.

5. Confirm the displayed message, and click OK.
The paper that is loaded in the printer will feed through the printer and be ejected.
Do not perform any other operations until the printer completes the cleaning of the Paper Feed Roller.

6. When the completion message appears, click OK.

If the problem is not resolved, turn off the printer, disconnect the power plug, and then wipe the
Paper Feed Roller (A) located on the right side inside the Rear Tray with a moistened cotton swab
or the like. Rotate the roller manually in the direction of the arrow (B) as you clean it. Do not touch
the roller with your fingers; rotate it with the cotton swab. If this does not solve the problem, contact
your Canon service representative.
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1. Make sure that the power is turned on, and remove any paper from the Rear Tray.

2. Open the Canon |J Printer Utility dialog box.
See Opening the Canon IJ Printer Utility (Macintosh).

3. Clean the Paper Feed Roller.
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(1) Make sure that Cleaning is selected in the pop-up menu.
(2) Click Roller Cleaning.
(3) Confirm the displayed message, and click OK.

The Paper Feed Roller will rotate as they clean.

4. Make sure that the Paper Feed Roller stops rotating. When the message appears,
load paper.
Load three sheets of A4 or Letter-sized plain paper in the Rear Tray.
Set the Paper Thickness Lever to the left. See Front View.

5. Confirm the displayed message, and click OK.
The paper that is loaded in the printer will feed through the printer and be ejected.
Do not perform any other operations until the printer completes the cleaning.
If the problem is not resolved, turn off the printer, disconnect the power plug, and then wipe the
Paper Feed Roller (A) located on the right side inside the Rear Tray with a moistened cotton swab
or the like. Rotate the roller manually in the direction of the arrow (B) as you clean it. Do not touch
the roller with your fingers; rotate it with the cotton swab. If this does not solve the problem, contact
your Canon service representative.
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Opening the Maintenance Screens

You can maintain the printer from the printer properties dialog box (Windows) or Canon IJ Printer Utility
(Macintosh).

m Opening the Printer Properties Dialog Box (Windows)

1. Click Control Panel, and Printer under Hardware and Sound.

In Windows XP, click Control Panel, Printers and Other Hardware, then Printers and Faxes.
In Windows 2000, click Control Panel, and Printers.

2. Right-click the Canon XXX icon (where "XXX" is your printer's name), and select
Printing Preferences.
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The printer properties dialog box opens.

Note

# You can also open the printer properties dialog box from your software application or My
Printer on a desktop.

Refer to the on-screen manual: Advanced Guide.

m Opening the Canon IJ Printer Utility (Macintosh)

1. Open System Preferences, and click Print & Fax.

2. Select your printer's name in Printers, and click Open Print Queue.
The list of printer jobs appears.

3. Click Utility.
The print list dialog box appears.

4. Select your printer's name in the Product list, and click Maintenance.
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The Canon |J Printer Utility starts up.

Note

# You can also open Canon IJ Printer Utility by the procedure below.
Select Applications from the Go menu, double-click the Ultilities folder, then double-click Printer
Setup Utility.
Refer to the on-screen manual: Advanced Guide.
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Basic Guide

Contents > Appendix

Appendix

Safety Precautions

Legal Limitations on Use of Your Product and Use of Images

Tips on How to Use Your Printer
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& Safety Precautions

Please read the safety warnings and cautions provided in this manual to ensure that you use the printer
safely. Do not attempt to use the printer in any way not described in this manual. It causes unexpected
accident, fire, or electrical shock.

ﬁWarning

# You may cause an electric shock, fire, or damage the printer if you ignore any of these safety

precautions.
Choosinga |Do not place the printer close to flammable solvents such as
location alcohol or thinners.
Power Never attempt to plug in or unplug the printer from the power
supply supply when your hands are wet.

Cleaning the
printer

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or
“ilexcessively bend or twist the power
cord. Do not place heavy objects on
the power cord.

Never plug the printer into a power
socket that is shared with other
equipment (extension lead/cord, 2- or
3-way adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around
the printer, immediately unplug the printer at the power supply
and call for service.

Periodically, unplug the printer and
use a dry cloth to wipe off any dust or
dirt collected on the plug and the
power outlet. If the printer is placed at
alocation exposed to a lot of dust,
smoke, or high humidity, the dust
collected on the plug absorbs
moisture and may cause insulation

failure and fire.

If you hear thunder, disconnect the power supply of the printer
and refrain from using it. Leaving the printer plugged in may
cause fire, electric shock, or damage to the printer, depending
on the thunder storm.

Use the power cable included with the printer.

Use a damp cloth to clean the printer.
| Never use flammable solvents such
“Jas alcohol, benzene or thinners.

| If flammable solvents come in contact with
electrical components inside the printer, it
could cause a fire or electric shock.

Always unplug the printer from the power outlet before
cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could
injure yourself or damage the printer.
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Maintaining |Do not attempt to disassemble or modify the printer. There are
the printer no user serviceable parts inside the printer.
The printer contains high-voltage components. Never attempt any
maintenance procedure not described in this guide.

Working Do not use highly flammable sprays near the printer.
ar(_)und the This could cause a fire or electric shock if the spray comes into contact
printer with electrical components inside the printer.

A Caution

# You may cause injury or damage the printer if you ignore any of these safety precautions.

Choosing a Do not install the printer in a location that is unstable or
location subject to excessive vibration.

Do not install the printer in locations that are very humid or
dusty, in direct sunlight, outdoors, or close to a heating
source.

To avoid the risk of fire or electric shocks, install the printer
in a location with an ambient temperature range of 5°C to
35°C (41°F to 95°F) and humidity of 10% to 90% (condensation
free).

Do not place the printer on a thick rug or carpet.

Do not place the printer with its back attached to the wall.

Never remove the plug by pulling
on the cord.

Power supply

Do not use an extension lead/cord.

Ensure that the area around the
power outlet is kept clear at all
times so you can easily unplug the
power cord if necessary.

Working around |Never put your hands or fingers in the printer while it is
the printer printing.

When moving the printer, carry the printer at both ends.
Do not place any object on the printer.

Do not place metal objects (paper clips, staples, etc.) or
containers of flammable solvents (alcohol, thinners, etc.) on
top of the printer.

If any foreign object (metal or liquid) fall into the printer,
unplug the power cord and call for service.

Do not transport or store the printer on a slant, vertically or
upside-down, as the ink may leak and damage the printer.

FINE Cartridges |Keep FINE Cartridges (Ink Cartridges) out of the reach of
(Ink Cartridges) children.
In case ink is accidentally licked or swallowed, rinse out mouth or
give one or two glasses of water to drink.
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If irritation or discomfort occurs, obtain medical advice immediately.

In case ink gets in contact with eyes, rinse with water
immediately.

In case ink gets in contact with skin, wash with soap and
water immediately.

If irritation to eyes or skin persists, obtain medical advice immediately.

Do not shake FINE Cartridges (Ink Cartridges).
Ink may spill out and stain clothing or the surrounding area.

Never touch the electrical contacts
or print head nozzles on a FINE
Cartridge (Ink Cartridge) after
printing.

The metal parts may be very hot and
could cause burns.

Do not throw FINE Cartridges (Ink Cartridges) into fire.

Do not attempt to disassemble or modify the FINE
Cartridges.

Do not handle the FINE Cartridges roughly such as applying
them excessive pressure or dropping them.

Do not rinse or wipe the FINE
Cartridges.

Once you have installed the FINE Cartridges, do not remove
them unnecessarily.

# Note when you place the printer near other electrical appliances such as fluorescent lamps
Place the printer at least 5.91 inches / 15 cm away from other electrical appliances such as
fluorescent lamps. If the printer is placed closer to those, it may not be able to work properly due to
fluorescent noises.

# When you turn off the power
When you turn off the power, always press the Power button and be sure that the Power lamp (in
green) has gone out. If you disconnect the power plug from the power outlet when the Power lamp
flashes or is lit, the Print Head cannot be protected and you may not be able to print later.

QO
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Legal Limitations on Use of Your Product and Use of Images

It may be unlawful to print the following documents.
The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

& Paper money #® Traveler's checks
# Money orders # Food stamps
# Certificates of deposit # Passports
# Postage stamps (canceled or # Immigration papers
uncanceled) # Internal revenue stamps (canceled or
# |dentifying badges or insignias uncanceled)
# Selective service or draft papers # Bonds or other certificates of indebtedness
# Checks or drafts issued by # Stock certificates
governmental agencies # Copyrighted works/works of art without
# Motor vehicle licenses and permission of copyright owner

certificates of title

QC
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Tips on How to Use Your Printer

This section introduces the tips on how to use your printer and for printing with optimal quality.
W InkK is used for various purposes.

® How is ink used for various purposes other than printing?

Ink may be used for purposes other than printing. Ink is not only used for printing, but also for cleaning
the Print Head to maintain the optimal printing quality.

The printer has the function to automatically clean the ink jet nozzles to prevent clogging. In the cleaning
procedure, ink is pumped out from the nozzles. Used ink for nozzle cleaning is limited to a small amount.

\‘ Important

# The ink pumped out from the nozzles, such as when cleaning the Print Head, is absorbed by ink
absorber in the printer. The ink absorber needs to be replaced when it is full. You cannot replace it

by yourself. When the error message appears, contact your Canon service representative as soon
as possible.

Refer to the "Troubleshooting” in the on-screen manual: Advanced Guide.

#® Does black-and-white printing use color ink?

The use of color or black ink varies depending on the color of image to be printed or the contents of

document. Black-and-white printing may also use color ink. So, color ink is consumed even when
printing in black-and-white.

m Printing on special paper: How to print with optimal quality!?

® Tip!: Check the printer status before printing!

# Is the Print Head ok?

If print head nozzles are clogged, print will be faint and papers will be wasted. Print the nozzle
check pattern to check the Print Head.

See When Printing Becomes Faint or Colors Are Incorrect -

¢ Is the inside of the printer smeared with ink?

After printing large quantities of paper or performing borderless printing, the area where papers
go through may get smeared with ink. Clean the inside of your printer with Bottom Plate
Cleaning.

Refer to the on-screen manual: Advanced Guide.
® Tip!: Check how to load the paper correctly!

¢ Is the paper loaded in the correct orientation?

&

To load paper in the Rear Tray, load paper with the printing side facing you.
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e Is the paper curled?

The curled paper causes paper jam. Flatten the curled paper, then reload it.

Refer to the "Troubleshooting” in the on-screen manual: Advanced Guide-

® Tip!: After loading paper, be sure to specify the paper settings!

After loading paper, be sure to select the loaded paper in Media Type of the printer driver. If the type of
paper is not selected, you may not be able to get the satisfactory print result.

See Printing-

There are various types of paper: paper with special coating on the surface for printing photos with
optimal quality and paper suitable for documents. Media Type of the printer driver has different settings
for each type of paper in advance (such as using ink, ejecting ink, or distance from nozzles) so that you
can print on each paper with the optimal image quality. You can print with different settings in Media Type
suitable for each type of loaded paper.

m Use the RESUME/CANCEL button to cancel printing!

® Tip!: Never press the Power button!

If you press the Power button while printing is in progress, the print data sent from the computer queues
in the printer and you may not be able to continue to print.
Press the RESUME/CANCEL button to cancel printing.

E.j Note

# |f you cannot cancel printing by pressing the RESUME/CANCEL button while printing from a
computer, open the printer properties dialog box to delete the unnecessary print jobs from the
printer status monitor (Windows).

m How to maintain the optimal printing quality?

The key to printing with the optimal printing quality is to prevent the Print Head from drying or clogging.
Always follow the following steps for optimal printing quality.

e Follow the procedure below to turn the power off.
1 Press the Power button on the printer to turn it off.
2 Be sure that the Power lamp is not lit.
3 Unplug the power cord from the wall outlet, or turn off the extender cable connector.
If you press the Power button to turn off the power, the printer caps the Print Head (nozzles)
automatically to prevent from drying. If you unplug the power cord from the wall outlet or turn off
the extender cable connector before the Power lamp is turned off, the Print Head will not be

capped properly and this will cause drying or clogging.

To turn off the power, be sure to follow this procedure.

« Print periodically!

Just as the tip of a felt pen becomes dry and unusabile if it has not been used for a long time,
even if it is capped, the Print Head too, may become dried or clogged if the printer has not been
used for a long time.

We recommend the printer to be used at least once a month.

E.j Note

#® Depending on the type of paper, ink may blur if you trace the printed area with a highlight
pen or paint-stick, or bleed if water or sweat comes in contact with the printed area.

m Dose the printer need to be handled with care when storing or
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transporting?

® Tip!: Do not store or transport the printer vertically or slanted!

If the printer is stored or transported vertically or slanted, the printer may become damaged or ink may
leak from the printer.
Be sure not to store or transport the printer vertically or slanted.

Des

m Lamp on the printer is flashing: What can | do?

+ Alarm lamp is flashing orange.

L X X | (X X ]
T (A) (B) (A)
(C)

(A) Alarm lamp flashes
(B) Alarm lamp is off
(C) Alarm lamp flashes repeatedly

—Your printer has an error. Refer to the " Troubleshooting" in the on-screen manual: Advanced
Guide, then resolve the error.

« Power lamp flashes green once and Alarm lamp flashes orange once
alternately.

—An error that requires repair has occurred. Contact your Canon service representative.

m Colors are uneven, and print results are blurred.

® Tip!: Print the nozzle check pattern to check if the nozzles
are clogged.

If the print head nozzles are clogged, colors may become uneven or the print results may be blurred.

In this case
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Print the nozzle check pattern

Check the printed check pattern to see if the nozzles are clogged.
See When Printing Becomes Faint or Colors Are Incorrect -

O
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iP1900 series

MC-2578-V1.00

Basic Guide —-

Printing

Troubleshooting Printing from a Computer
How to Use This Manual Printing with the Bundled Application Software
o : What Is Easy-PhotoPrint EX?
Printing This Manual
Printing Photos

Starting Easy-PhotoPrint EX

Changing the Printer Settings Selecting a Photo
Selecting the Paper
overs
Printing
When you display this On-screen Creating an Album

Manual in a language environment Starting Easy-PhotoPrint EX
other than English, some English

descriptions may be displayed.

Selecting the Paper and Layout
Selecting a Photo
Editing
Printing

Printing Calendars
Starting Easy-PhotoPrint EX
Selecting the Paper and Layout
Selecting a Photo
Editing
Printing

Printing Stickers
Starting Easy-PhotoPrint EX
Selecting the Paper and Layout
Selecting a Photo
Editing
Printing

Printing Layout
Starting Easy-PhotoPrint EX
Selecting the Paper and Layout
Selecting a Photo
Editing
Printing

Correcting and Enhancing Photos
Using the Auto Photo Fix Function
Using the Red-Eye Correction Function
Using the Face Brightener Function
Using the Face Sharpener Function
Using the Digital Face Smoothing Function
Using the Blemish Remover Function
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Adjusting Images

Correct/Enhance Images Window
Questions and Answers

How Can | Move (or Copy) the Saved File?

Which Side of the Displayed Image Does the Printing
Start from?

How Do | Print with Even Margins?
What Is "C1" or "C4"?
Appendix 1: Easy-PhotoPrint EX Settings

Printing Vivid Photos
Reducing Photo Noise
Cropping Photos (Photo Print)
Printing Dates on Photos (Photo Print)
Printing Multiple Photos on One Page
Printing an Index
Printing ID Photos (ID Photo Print)
Printing Photo Information
Saving Photos
Opening Saved Files
Changing Layout
Changing Background
Adding Photos
Swapping Positions of Photos
Replacing Photos
Changing Position, Angle and Size of Photos
Cropping Photos
Framing Photos
Printing Dates on Photos
Attaching Comments to Photos
Adding Text to Photos
Saving
Setting Holidays
Setting Calendar Display

Printing with Other Application Software

Various Printing Methods

Printing with Easy Setup
Setting a Page Size and Orientation
Setting the Number of Copies and Printing Order
Setting the Stapling Margin
Borderless Printing
Fit-to-Page Printing
Scaled Printing
Page Layout Printing
Poster Printing
Booklet Printing
Duplex Printing
Stamp/Background Printing
Saving a Stamp Setting
Saving Image Data to be Used as a Background

Printing an Envelope



iP1900 series Advanced Guide

Displaying the Print Results before Printing
Setting Paper Dimensions (Custom Size)
Changing the Print Quality and Correcting Image Data

Selecting a Combination of the Print Quality Level
and a Halftoning Method

Printing a Color Document in Monochrome
Specifying Color Correction
Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles
Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
Simulating an lllustration
Representing Image Data with a Single Color
Presenting Image Data with Vivid Colors
Smoothing Jagged Outlines
Changing Color Properties to Improve Coloration
Reducing Photo Noise

Overview of the Printer Driver
Canon IJ Printer Driver
How to Open the Printer Driver Setup Window
Maintenance Tab
Canon |J Status Monitor

The Canon |J Preview

Troubleshooting
Troubleshooting

If an Error Occurs
The Printer Can Not Be Powered On
Alarm Lamp Flashes Orange

Power Lamp Flashes Green and Alarm Lamp Flashes
Orange Alternately

Cannot Install the Printer Driver
Cannot Connect to Computer Properly

The Printer Is Not Recognized Properly
Print Results Not Satisfactory

Cannot Print to End of Job

No Printing Results/Printing Is Blurred/Colors Are Wrong/
White Streaks

Colors Are Unclear
Lines Are Misaligned
Printed Paper Curls or Has Ink Blots
Paper Is Smudged/Printed Surface Is Scratched
Back of the Paper Is Smudged
Colors Are Uneven or Streaked
Printing Does Not Start
Printing Stops Before It Is Completed
Printer Moves But Ink Is Not Ejected
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Printing Speed Not as Fast as Expected

FINE Cartridge Holder Does Not Move to the Position for
Replacing

Paper Does Not Feed Properly

Paper Jams

Message Appears on the Computer Screen
Service Error 5100 Is Displayed
Writing Error/Output Error/Communication Error
Error Number: 300 Is Displayed
Error Number: 1700 Is Displayed
Ink Info Number: 1688 Is Displayed
Ink Info Number: 1686 Is Displayed
Other Error Messages

For Windows Users
Printer Status Monitor Is Not Displayed

The Inkjet Printer/Scanner Extended Survey Program
screen is displayed

FAQs
If You Cannot Resolve the Problem

Instructions for Use (Printer Driver)

Using Easy-PhotoPrint EX

About Solution Menu
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How to Use This Manual

= Operating the Contents Screen
= Operating the Explanation Screen
= Printing This Manual

= Using Keywords to Find a Topic
= Registering Topics to My Manual
=+ Symbols Used in this Document
= Trademarks
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Operating the Contents Screen
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When you click a title displayed in the Contents screen found to the left of the On-screen Manual, the

pages of that title are displayed in the Description window.

When you click Q found to the left of [+, the titles found in the lower hierarchies are displayed.

E Note

= Click "8 ==t 45 close or display the Contents screen.
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Operating the Explanation Screen

[ e e e

(m-b-ﬂ_iﬂcm + My Manusl Pm&.m-lﬁ

I; Bnced i de .

Gvanced Gude > How 1o Use This Wanual

How to Use This Manual
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(1) Click the green characters to jump to the corresponding page.
(2) The cursor jumps to the top of this page.
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Printing This Manual

[gh % sesies Onscreen Mancal [E=nE=n ==

Use This Manuad ¥ Prining This M3

Canon

saries

On-screen Manual

. =

Advanced Guide Troubleshootin

Click ™ Pt = to display the Print window to the left of the On-screen Manual.

Note

= Click [® = = to close or display the Print window.

= Click ", and then click Option Settings to display the Option Settings dialog box. You can then set up
the printing operation.

The following four methods of printing are available:
e Current Document
e Selected Documents
e My Manual

e All Documents

Current Document

You can print the currently displayed topic.

1. From Select Target, select Current Document
The title of the currently displayed topic is displayed in the Documents to Be Printed list.

Note

= By selecting Print linked documents, you can also print documents that are linked to the current
document. The linked documents are added to the Documents to Be Printed list.

= Click Print Preview to display and check what the print results will look like before you actually
print the document.

2. Click Start Printing

The Print Page Count Confirmation dialog box is displayed.

3. Execute print
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Confirm the number of pages to be printed, and then click Yes.

The topics that are currently displayed are printed.

Selected Documents
You can select and print the topics that you want printed.

1. From Select Target, select Selected Documents
The titles of all topics are displayed in the Documents to Be Printed list.

2. Select the topics to be printed
From the Documents to Be Printed list, select the title check boxes of the topics to be printed.

E.j Note

When you select the Automatically select documents in lower hierarchies check box, the check
boxes of all titles found in the lower hierarchies are selected.

Click Select All to select the check boxes of all titles.

Click Clear All to clear the check boxes of all titles.

Click Print Preview to display and check what the print results will look like before you actually
print the document.

3. Click Start Printing
The Print Page Count Confirmation dialog box is displayed.

4. Execute print
Confirm the number of pages to be printed, and then click Yes.

All topics with selected check boxes are printed.

My Manual
You can select and print topics registered in My Manual.
For details about My Manual, see " Registering Topics to My Manual ."

1. From Select Target, select My Manual

The titles of the topics that have been registered to My Manual are displayed in the Documents to Be
Printed list.

2. Select the topics to be printed
From the Documents to Be Printed list, select the title check boxes of the topics to be printed.

E.j Note
Click Select All to select the check boxes of all titles.
Click Clear All to clear the check boxes of all titles.
Click Print Preview to display and check what the print results will look like before you actually

print the document.

3. Click Start Printing
The Print Page Count Confirmation dialog box is displayed.

4. Execute print
Confirm the number of pages to be printed, and then click Yes.

All topics with selected check boxes are printed.

All Documents
You can print all topics of the On-screen Manual.

1. From Select Target, select All Documents
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The titles of all topics are displayed in the Documents to Be Printed list, and the check boxes are
automatically selected.

E.j Note
If you clear the check box of a topic, that topic is not printed.
Click Select All to select the check boxes of all titles.
Click Clear All to clear the check boxes of all titles.
Click Print Preview to display and check what the print results will look like before you actually
print the document.

2. Click Start Printing
The Print Page Count Confirmation dialog box is displayed.

3. Execute print
Confirm the number of pages to be printed, and then click Yes.

All topics are printed.

\‘ Important

A large amount of paper is necessary to print all topics. Before printing, be sure to check the
number of print pages displayed in the Print Page Count Confirmation dialog box.
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Using Keywords to Find a Topic

You can enter a keyword to search for a target page.
All installed On-screen Manuals (user's guides) are searched.

[ g #88 ceries Oresereen Manial [ [0 ]

* How o Use This Manuall 3 Prinfing This M3

Canon
[Eryep—— " senas

— e On-screen Manual

1 Protrsy Prsdecs (Sasy PrstaPrrd EX)
Ll Prrtirg Desurnarts (Windows)

] Prntirg Doourments (Maciriosh)

1 Sohution Menu and My Prnter

1 Claaung thee Evie Hasd

] Clmaring the Faper Fasd Roler
1 Prntirg Thia Wanual
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1. Click | sexch

A search window is displayed to the left of the On-screen Manual.

Note

= Click [#** {0 close or display the Search window.

2. Enter a keyword
In Keyword, enter a keyword for the item to be checked.
If you want to enter multiple keywords, insert a space between the keywords.

Note

= You can enter up to 10 keywords or up to 255 characters.
= Uppercase and lowercase are not discriminated.
= The program can also search for keywords that contain spaces.

3. Click Start Searching

The search is started, and the titles of topics containing the keyword are displayed in the search
results list.

When you execute a search by entering multiple keywords, the search results are displayed as
shown below.

[Documents Containing Perfect Match]

Topics containing the entire search character string (including spaces) exactly as entered (perfect
match)

[Documents Containing All Keywords]
Topics containing all keywords that were entered

[Documents Containing Any Keyword]
Topics containing at least one of the keywords that were entered
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4. Display the topic that you want to read

From the search results list, double-click (or select and press Enter) the title of the topic you want to
read.
When the pages of that title are displayed, the keywords found on those pages are highlighted.
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Registering Topics to My Manual

Register frequently read pages as My Manual topics so that you can refer to those pages easily at any
time.

g % sesies Coscrenn Manual F=n|EcE—=|
o Back = p o~ &4
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. e - Canon Use This Manual 3 Prinking This M:
List of By Mol

sarias

On-screen Manual

1. Display the topic
Display the topic to be added to My Manual.

2. Click | MyMenuad

The My Manual window is displayed to the left of the On-screen Manual.

Note

= Click /= MvMeust 46 close or display the My Manual window.

3. Register the topic to My Manual
Click Add.
The currently displayed topic is added to List of My Manual.

Note

= Alternatively, from the Recently Displayed Documents list, double-click (or select and press
Enter) the topic to be added to My Manual to display that topic, and then click Add.

4. Display My Manual

When you double-click (or select and press Enter) a topic displayed in List of My Manual, that topic is
displayed in the Description window.

Note

= To delete a topic from List of My Manual, select that topic from the list, and then click Delete (or
press Delete).

Page top



Symbols Used in this Document C1p. 78 n3 334 ctp.

Adyanced Ginde’

Advanced Guide > How to Use This Manual > Symbols Used in this Document

Symbols Used in this Document

ﬁ Warning

Instructions that, if ignored, could result in death or serious personal injury caused by incorrect operation
of the equipment. These must be observed for safe operation.

A Caution

Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

\‘ Important

Instructions that must be observed for safe operation.

EE Note

Instructions as notes for operation or additional explanations.
"T

Indicates operations in Windows.

Indicates operations in Macintosh.
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Trademarks

e Microsoft is a registered trademark of Microsoft Corporation.

® Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

® Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

e Macintosh and Mac are trademarks of Apple Inc., registered in the U.S. and other countries.

e Adobe, Adobe Photoshop, Adobe RGB and Adobe RGB (1998) are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and or other countries.
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Printing from a Computer

= Printing with the Bundled Application Software
=k Printing with Other Application Software

Page top
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Printing with the Bundled Application Software

= What Is Easy-PhotoPrint EX?

= Printing Photos

= Creating an Album

= Printing Calendars

= Printing Stickers

= Printing Layout

= Correcting and Enhancing Photos

= Questions and Answers

= Appendix 1: Easy-PhotoPrint EX Settings
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EX?

What Is Easy-PhotoPrint EX?

Easy-PhotoPrint EX allows you to create albums, calendars and stickers easily using photos taken with
digital cameras.

You can also print borderless photos easily.
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\‘ Important

Easy-PhotoPrint EX does not support Windows 95, Windows 98, Windows Me, or Windows NT4.
Easy-PhotoPrint EX can only be used with Canon inkjet printers. It does not support some printers,
including Canon compact printers (SELPHY CP series).

If a printer that supports Easy-PhotoPrint EX is not installed, you cannot print items you create.

If Easy-PhotoPrint EX is installed on a computer that already has Easy-LayoutPrint installed, Easy-
LayoutPrint will be replaced by Easy-PhotoPrint EX.

EEI Note

Printing on paper larger than A4 is available with supported printers only. See your printer manual
for details.

See Help of Easy-PhotoPrint EX for descriptions of Easy-PhotoPrint EX screens.

Click Help in a screen or dialog box, or select Easy-PhotoPrint EX Help from the Help menu. Help
appears.

About Exif Print

Easy-PhotoPrint EX supports "Exif Print." Exif Print is a standard for enhancing the communication
between digital cameras and printers.

By connecting to an Exif Print-compliant digital camera, the image data at the time of shooting is used
and optimized, yielding extremely high quality prints.

Starting Easy-PhotoPrint EX from Other Applications

Easy-PhotoPrint EX can be started from other applications.

See the application's manual for details on the procedure for starting.

The Album function is available with the following applications:

e MP Navigator EX Ver.1.00 or later

e ZoomBrowser EX Ver.5.8 or later
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The Photo Print function is available with the following applications:

e MP Navigator EX Ver.1.00 or later

o ZoomBrowser EX Ver.6.0 or later

e Digital Photo Professional Ver.3.2 or later

E.j Note

C1p. 83 u3 334 crp.

Easy-PhotoPrint EX is subject to the following restrictions when started from Digital Photo
Professional:

- Menu does not appear in the step button area on the left side of the screen.

- Images cannot be corrected/enhanced.

- Image display order cannot be changed.

- Edited images cannot be saved.

- Options other than Enable ICC Profile cannot be selected for Color correction for printing on the
Advanced tab of the Preferences dialog box. Therefore, you cannot use the Vivid Photo and Photo
Noise Reduction functions.

Supported Image File Formats (Extensions)

BMP (.bmp)
JPEG (.jpg, .jpeg)
TIFF (.tif, .tiff)
PICT (.pict, .pct)

Easy-PhotoPrint image files (.epp)

\‘ Important

When selecting an image, if there is a TIFF file in the selected folder, the image may not be
displayed correctly or Easy-PhotoPrint EX may shut down depending on the TIFF format. In such
cases, move the TIFF file to another folder or recreate the file in a different file format, and then
select the folder again.

-----

The thumbnails of files in unsupported formats are displayed as (Question Mark).

E.j Note

When Easy-PhotoPrint EX is started from Digital Photo Professional, all image files supported by

Digital Photo Professional will be displayed.

File Formats (Extensions) Supported by Easy-PhotoPrint EX

Easy-PhotoPrint EX Photo Print file (.el6)
Easy-PhotoPrint EX Album file (.el1)
Easy-PhotoPrint EX Stickers file (.el2)
Easy-PhotoPrint EX Calendar file (.el4)

Easy-PhotoPrint EX Layout file (.el5)
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Printing Photos

Easy-PhotoPrint EX allows you to print your favorite photos in a variety of layouts.
You can also create borderless photos easily.
Corrections suitable for photos will be applied automatically when printing.

' Ty

‘
%

Steps

1. Starting Easy-PhotoPrint EX
2. Selecting a Photo

3. Selecting the Paper

4. Printing

Try This

= Correcting and Enhancing Photos

= Printing Vivid Photos

= Reducing Photo Noise

=} Cropping Photos (Photo Print)

= Printing Dates on Photos (Photo Print)
= Printing Multiple Photos on One Page
= Printing an Index

=k Printing ID Photos (ID Photo Print)

= Printing Photo Information

= Saving Photos

= Opening Saved Files

Questions and Answers

= How Can | Move (or Copy) the Saved File?

=+ Which Side of the Displayed Image Does the Printing Start from?
= How Do | Print with Even Margins?
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Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Selecting a Photo

Selecting a Photo

1. Click Photo Print from Menu.

The Select Images screen appears.
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@ Important

= The reduced images (thumbnails) displayed in the screen may appear as follows:
- A black line appears along an edge of the image.
- An edge of the image appears cropped.
However, such images will be displayed normally when enlarged or previewed, and print
results will not be affected.

2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

Note

= |f Easy-PhotoPrint EX is started from another application (MP Navigator EX, ZoomBrowser EX
or Digital Photo Professional), the folder tree area will not be displayed.
The images opened in the application will be displayed as thumbnails.

3. Click the image you want to print.

The number of copies appears as "1" below the clicked image, while the selected image itself will
appear in the selected image area.

Note
|

To delete an image in the selected image area, select the image you want to delete and click
e
(Delete Imported Image).

To delete all images from the selected image area, click (Delete All Imported Images).
= To print two or more copies of an image, click E' (Up arrow) until the number of copies you

want is reached. To reduce the number of copies shown in the box, click EI (Down arrow).
= You can change the order of photos using the list located at the top right corner of the screen.
You can select the printing order from Sort by Date and Sort by Name.
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Note

= You can correct or enhance the selected image before printing.
Correcting and Enhancing Photos
= See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Photos >
Selecting the Paper

Selecting the Paper

1. Click Select Paper.

The Select Paper screen appears.
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2. Set the following items according to the printer and paper to be used:
Printer
Paper Source
Paper Size
Media Type

Note

= The paper sizes and media types may vary depending on the printer. See Help for details.
= The paper sources may vary depending on the printer and the media type.

\‘ Important

= When Fine Art Photo Rag is selected for Media Type, a 1.38 inch (35 mm) margin is automatically
left at the top and bottom of the paper.
It is recommended that you check the print range with the image shown in Preview before printing.

Note

= You can print photos with more vivid colors or you can reduce the photo noise.
= Printing Vivid Photos
= Reducing Photo Noise

= See Help for details on the Select Paper screen.

QC
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Printing

1. Click Layout/Print.

The Layout/Print screen appears.
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\.‘ Important

= The reduced images (thumbnails) displayed in the screen may appear as follows:
- A black line appears along an edge of the image.
- An edge of the image appears cropped.
However, such images will be displayed normally when enlarged or previewed, and print
results will not be affected.

2. Select a layout you want to use.

Click a borderless layout to print borderless photos.

Note

= The layouts that can be selected may vary depending on the printer, paper size, and media
type.

3. Click Print.
\‘ Important

= When you print on large size paper such as A3/A3+, some computers cannot print properly if you
print more than one page or copy at a time. It is recommended that you print page by page when
you print on such paper.

= While printing on paper larger than A4 or printing high-resolution images, data may be printed only
to the middle if many images are printed at one time. In such cases, select the Spool print job page
by page checkbox in the Preferences dialog box, and then print again.

To display the Preferences dialog box, click = (Settings) or select Preferences... from the File
menu.

= When Fine Art Photo Rag is selected for Media Type in the Select Paper screen, a 1.38 inch (35
mm) margin is automatically left at the top and bottom of the paper.
It is recommended that you check the print range with the image shown in Preview before printing.

Note

= The photo print settings will be discarded if you exit Easy-PhotoPrint EX without saving the settings.
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It is recommended that you save the printed image if you want to print it again.
Saving Photos
When you print on a bordered layout, the margins on the left and right or the top and bottom may
become wider than the other.
How Do | Print with Even Margins?
You can crop images or print dates on photos.
Cropping Photos (Photo Print)
Printing Dates on Photos (Photo Print)
You can correct or enhance the selected image before printing.
Correcting and Enhancing Photos
You can specify advanced Photo Print settings (number of copies, print quality, etc.) in the
Preferences dialog box.

e
To display the Preferences dialog box, click L‘-?-T (Settings) or select Preferences... from the File
menu.
See Help for details on the Layout/Print screen.
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Creating an Album

Easy-PhotoPrint EX allows you to create your own personalized photo album.

' Ty

ﬁ
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Steps

1. Starting Easy-PhotoPrint EX
2. Selecting the Paper and Layout
3. Selecting a Photo

4. Editing

5. Printing

Try This

= Correcting and Enhancing Photos
=k Changing Layout

= Changing Background

=+ Adding Photos

= Swapping Positions of Photos

=+ Replacing Photos

= Changing Position, Angle and Size of Photos
= Cropping Photos

= Framing Photos

= Printing Dates on Photos

=} Attaching Comments to Photos

= Adding Text to Photos

= Saving

= Opening Saved Files

Questions and Answers
= How Can | Move (or Copy) the Saved File?
= What Is "C1" or "C4"?

Page top#-



Starting Easy-PhotoPrint EX Ctp. 92 n3 334 cTp.

ndiranced iGinde

Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >
Starting Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Selecting the Paper and Layout

1. Click Album from Menu.

The Page Setup screen appears.
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2. Set the following items in the General Settings section:
Paper Size
Orientation
Cover
Double page album
Page number

——1 Note

See Help on the paper size that can be selected.

You can select whether to display images on the inside of the front and back covers in the
Cover Options dialog box. To display the Cover Options dialog box, select Front or Front & Back
for Cover and click Options....

Select the Double page album checkbox to enable the spread page layout (consisting of two-
page master). In a double-page album, you can arrange an image across the left and right
pages.

You can customize the page numbers (position, font size, etc.) in the Page Number Settings
dialog box. To display the Page Number Settings dialog box, select the Page number checkbox
and click Settings....

You can customize the margins of the front cover, inside pages and back cover in the Margin
Settings dialog box. To display the Margin Settings dialog box, click Margins....

3. Select the theme you want to use from Theme in Sample Layout.

4. If you want to change the layout, click Layout....

The Change Layout dialog box appears.

In the Change Layout dialog box, you can change the layout or select whether to print the date (on
which the picture was taken) on the photo.

E Note
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The album layouts that can be selected may vary depending on the Paper Size, Orientation,
Double page album, or the type of page selected (front cover, inside pages or back cover).
You can customize the date (position, size and color) in the Date Settings dialog box. To
display the Date Settings dialog box, select the Print date checkbox in the Change Layout
dialog box and click Date Settings....

5. If you want to change the background, click Background....
The Change Background dialog box appears.

In the Change Background dialog box, you can paint the background in a single color or paste an
image file to it.

E Note

See Help for details on the Page Setup screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >
Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.
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2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

Note

= |If Easy-PhotoPrint EX is started from another application (MP Navigator EX or ZoomBrowser
EX), the folder tree area will not be displayed.
The images opened in MP Navigator EX or ZoomBrowser EX will be displayed as thumbnails.

3. Select the image(s) you want to print, and click one of the buttons below.

To print on the front cover, click (Import to Front Cover).
To print on the inside pages, click (Import to Inside Pages).
To print on the back cover, click (Import to Back Cover).

The selected images are displayed in the selected image area.
You can also select the image(s) you want to print by dragging them into the selected image area.

Note

= To delete an image in the selected image area, select the image you want to delete and click
(Delete Imported Image).

To delete all images from the selected image area, click (Delete All Imported Images).

Note

= See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >
Editing

Editing

1. Click Edit.

The Edit screen appears.
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2. Edit your album if necessary.
=+ Changing Layout
=+ Changing Background
=+ Adding Photos
=+ Swapping Positions of Photos
= Replacing Photos
=+ Changing Position, Angle and Size of Photos
= Cropping Photos
= Framing Photos
= Printing Dates on Photos
= Attaching Comments to Photos
= Adding Text to Photos

Note

= The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited
album. It is recommended that you save the item if you want to edit it again.
The page numbers on the front and back covers of the album are displayed as follows:

C1: Front cover

—1

2 C2: Inside the front cover
3 C3: Inside the back cover
4 C4: Back cover

=+ Saving
= See Help for details on the Edit screen.
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Adyanced Gide

Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >
Printing

Printing

1. Click Print Settings.

The Print Settings screen appears.
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2. Set the following items according to the printer and paper to be used:

Printer

Media Type
Copies
Paper Source
Print Quality

Borderless Printing

——1 Note

= The media types may vary depending on the printer and the paper size.

= Duplex Printing appears if the selected printer and media type support duplex printing. Select
this checkbox to print on both sides of the paper.

= Automatic appears if you select the Duplex Printing checkbox after selecting a printer that
supports automatic duplex printing and media type that supports duplex printing. Select this
checkbox to print on both sides of the paper automatically.

= The paper sources may vary depending on the printer and the media type.

= You can set a custom print quality level in the Print Quality Settings dialog box. To display the
Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....

= Select the Borderless Printing checkbox to print borderless photos.

= You can specify the print range and the amount of extension for borderless printing in the Print
Settings dialog box. To display the Print Settings dialog box, click Advanced....

3. Click Print.

——I Note

= See Help for details on the Print Settings screen.
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Printing Calendars
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars

Printing Calendars

Easy-PhotoPrint EX allows you to create your own calendar using your favorite photos.

, .
N

1. Starting Easy-PhotoPrint EX
2. Selecting the Paper and Layout
3. Selecting a Photo

4. Editing

5. Printing

Try This

= Correcting and Enhancing Photos
=k Changing Layout

= Changing Background

=+ Adding Photos

= Swapping Positions of Photos

=+ Replacing Photos

= Changing Position, Angle and Size of Photos
= Cropping Photos

= Framing Photos

= Printing Dates on Photos

= Adding Text to Photos

= Setting Calendar Display

=} Setting Holidays

= Saving

= Opening Saved Files

Questions and Answers
= How Can | Move (or Copy) the Saved File?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >
Starting Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >

Selecting the Paper and Layout

Selecting the Paper and Layout

1. Click Calendar from Menu.

The Page Setup screen appears.
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2. Set the following items in the General Settings section:
Paper Size
Orientation
Start from
Period

Note

= See Help on the paper size that can be selected.
= You can add holidays to your calendar.
= Setting Holidays

3. Select a layout.
If necessary, make advanced settings on the calendar and set the background.

Note

= You can customize the calendar display (font colors of the dates and days of the week, position

and size of the calendar, etc.).
= Setting Calendar Display
= You can paint the background in a single color or paste an image file to it in the Change

Background dialog box. To display the Change Background dialog box, click Background....

Note

= See Help for details on the Page Setup screen.

Q0
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >
Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.

| 55 Moew Calemsdar - Eagy-PhotaPring £X = |
File fdit Yiew Hep

Selact mapes for cakindar, You £an ako addrephce imegas biter in the edung progass.
Create Calendar To gomest of anhange magaes, ok the Comacy/Enhange butmen.
Agoly ooetg hions & grancaments in the rasuting soraan.

i B = __"l_ B2 SobyDate & -

et
i

'L. R

MG _sfog HGO00E_sjap PEGOO0E_sfog

| Insde Pagas(Ori)

2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

3. Select the image(s) you want to print and click (Import to Inside Pages).
The selected images are displayed in the selected image area.
You can also select the image(s) you want to print by dragging them into the selected image area.

Note

= To delete an image in the selected image area, select the image you want to delete and click
i
(Delete Imported Image).

To delete all images from the selected image area, click (Delete All Imported Images).

Note

= See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >
Editing

Editing

1. Click Edit.

The Edit screen appears.
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2. Edit the calendar if necessary.
=+ Changing Layout
=+ Changing Background
=+ Adding Photos
=+ Swapping Positions of Photos
= Replacing Photos
=+ Changing Position, Angle and Size of Photos
=+ Cropping Photos
= Framing Photos
= Printing Dates on Photos
= Adding Text to Photos
= Setting Calendar Display
= Setting Holidays

Note

= The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited
calendar. It is recommended that you save the item if you want to edit it again.
=+ Saving

= See Help for details on the Edit screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >
Printing

Printing

1. Click Print Settings.

The Print Settings screen appears.
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2. Set the following items according to the printer and paper to be used:

Printer

Media Type
Copies
Paper Source
Print Quality

Borderless Printing

Note
n

The media types may vary depending on the printer and the paper size.

= Duplex Printing appears if the selected printer and media type support duplex printing. Select
this checkbox to print on both sides of the paper.

= Automatic appears if you select the Duplex Printing checkbox after selecting a printer that
supports automatic duplex printing and media type that supports duplex printing. Select this
checkbox to print on both sides of the paper automatically.

= The paper sources may vary depending on the printer and the media type.

= You can set a custom print quality level in the Print Quality Settings dialog box. To display the
Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....

= You can specify the print range and the amount of extension for borderless printing in the Print
Settings dialog box. To display the Print Settings dialog box, click Advanced....

3. Click Print.

Note

= See Help for details on the Print Settings screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers

Printing Stickers

You can print your favorite photos on compatible sticker sheets.

' Ty

Steps

1. Starting Easy-PhotoPrint EX
2. Selecting the Paper and Layout
3. Selecting a Photo

4. Editing

5. Printing

Try This

= Correcting and Enhancing Photos
=+ Adding Photos

= Swapping Positions of Photos

=+ Replacing Photos

= Changing Position, Angle and Size of Photos
= Cropping Photos

= Framing Photos

= Adding Text to Photos

= Saving

= Opening Saved Files

Questions and Answers
=+ How Can | Move (or Copy) the Saved File?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >
Starting Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >
Selecting the Paper and Layout

Selecting the Paper and Layout

1. Click Stickers from Menu.

The Page Setup screen appears.
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2. Set the following items in the General Settings section:
Paper Size
Orientation
Print date
Use the same image in all frames

Note

= Paper sizes other than Photo Stickers cannot be selected.

= Select the Use the same image in all frames checkbox to use the same image in all the
frames on the page.

= You can customize the date (position, size and color) in the Date Settings dialog box. To
display the Date Settings dialog box, select the Print date checkbox and click Date Settings....

Note

= See Help for details on the Page Setup screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >
Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.
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2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

3. Select the image(s) you want to print and click (Import to Inside Pages).
The selected images are displayed in the selected image area.
You can also select the image(s) you want to print by dragging them into the selected image area.

Note

= To delete an image in the selected image area, select the image you want to delete and click

:
(Delete Imported Image).

To delete all images from the selected image area, click (Delete All Imported Images).

Note

= See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers > Editing

Editing

1. Click Edit.

The Edit screen appears.
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2. Edit the stickers if necessary.
= Adding Photos
= Swapping Positions of Photos
=+ Replacing Photos
=+ Changing Position, Angle and Size of Photos
=+ Cropping Photos
= Printing Dates on Photos
=+ Adding Text to Photos

Note

= The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited
stickers. It is recommended that you save the item if you want to edit it again.
=+ Saving

= See Help for details on the Edit screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >
Printing

Printing

1. Click Print Settings.

The Print Settings screen appears.
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2. Set the following items according to the printer and paper to be used:
Printer
Media Type
Copies
Paper Source
Print Quality
Borderless Printing

- Note

The media types may vary depending on the printer and the paper size.

The paper sources may vary depending on the printer and the media type.

You can set a custom print quality level in the Print Quality Settings dialog box. To display the
Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....
You can adjust the printing position in the Adjust Print Position dialog box. To display the Adjust
Print Position dialog box, click Print Position....

You can specify the print range and the amount of extension for borderless printing in the Print
Settings dialog box. To display the Print Settings dialog box, click Advanced....

3. Click Print.

Note

= See Help for details on the Print Settings screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout

Printing Layout

You can add text to your favorite photos and print them in a variety of layouts.

.,

Steps

1. Starting Easy-PhotoPrint EX
2. Selecting the Paper and Layout
3. Selecting a Photo

4. Editing

5. Printing

Try This

= Correcting and Enhancing Photos
=k Changing Layout

=+ Adding Photos

=k Swapping Positions of Photos

= Replacing Photos

=k Changing Position, Angle and Size of Photos
= Cropping Photos

= Printing Dates on Photos

= Adding Text to Photos

= Saving

= Opening Saved Files

Questions and Answers
= How Can | Move (or Copy) the Saved File?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout > Starting
Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.

Salact tha Kam yow WanT T0 £raat2 from the manu.
Selact Ly T 300855 s3ved Rams.

Phato Pront Alburn Calerwlar
.-'_{‘ﬁ-""‘a = 1.‘

LS < .
Stickers Layout Print Library

Page top+-



Selecting the Paper and Layout Ctp. 11513 334 cTp.

}!'l?‘ﬂ..l:";'l C.":IH!';

Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout >
Selecting the Paper and Layout

Selecting the Paper and Layout

1. Click Layout Print from Menu.

The Page Setup screen appears.
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2. Set the following items in the General Settings section:
Paper Size
Orientation
Print date

Note

= See Help on the paper size that can be selected.
= You can customize the date (position, size and color) in the Date Settings dialog box. To
display the Date Settings dialog box, select the Print date checkbox and click Date Settings....

3. Select a layout from Layouts.

Note

= The layouts displayed may vary depending on the Orientation.

Note

= See Help for details on the Page Setup screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout >

Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.
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2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

3. Select the image(s) you want to print and click (Import to Inside Pages).

The selected images are displayed in the selected image area.

You can also select the image(s) you want to print by dragging them into the selected image area.

Note

= To delete an image in the selected image area, select the image you want to delete and click

:
(Delete Imported Image).

To delete all images from the selected image area, click (Delete All Imported Images).

Note

= See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout > Editing

Editing

1. Click Edit.

The Edit screen appears.

Edr Brpout prng alamants a5 neaded,

Ele fdit Yiew Help
Layout Print
| Edit Tooks [[nzde Pages
T
0 Page Setup [ [)
=i

I
L] Edit General Tools 5|
=] x|
& Print Settings || 2 |

=]

Inganm feur, 3dd magas or ghanga lyaut.

2. Edit the layout if necessary.
=+ Changing Layout
=+ Adding Photos
= Swapping Positions of Photos
= Replacing Photos

=+ Changing Position, Angle and Size of Photos

= Cropping Photos
= Printing Dates on Photos
=+ Adding Text to Photos

Note

= The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited layout.
It is recommended that you save the item if you want to edit it again.

= Saving
= See Help for details on the Edit screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout > Printing

Printing

1. Click Print Settings.

The Print Settings screen appears.
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2. Set the following items according to the printer and paper to be used:

Printer

Media Type
Copies

Paper Source

Print Quality
Borderless Printing

Note
= The media types may vary depending on the printer and the paper size.

Duplex Printing appears if the selected printer and media type support duplex printing. Select

this checkbox to print on both sides of the paper.

Automatic appears if you select the Duplex Printing checkbox after selecting a printer that

supports automatic duplex printing and media type that supports duplex printing. Select this

checkbox to print on both sides of the paper automatically.

The paper sources may vary depending on the printer and the media type.

= You can set a custom print quality level in the Print Quality Settings dialog box. To display the

Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....

Select the Borderless Printing checkbox to print borderless photos.

= You can specify the print range and the amount of extension for borderless printing in the Print

Settings dialog box. To display the Print Settings dialog box, click Advanced....

3. Click Print.

Note

= See Help for details on the Print Settings screen.

O
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting and
Enhancing Photos

Correcting and Enhancing Photos

You can correct and enhance images.

Click -’é (Correct/Enhance Images) in the Select Images or Edit screen, or in the Layout/Print screen of
Photo Print. You can make the following corrections and enhancements in the Correct/Enhance Images
window.

\‘ Important

For Photo Print, if you select Enable ICC Profile in the Advanced tab of the Preferences dialog box,
you cannot correct/enhance images.

E Note

See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.

Auto Photo Fix
This function will automatically analyze the captured scene and apply suitable corrections.
Using the Auto Photo Fix Function

Red-Eye Correction Function
You can correct red eyes caused by a camera flash.

Using the Red-Eye Correction Function

Face Brightener Function
You can brighten dark faces caused by bright background.
Using the Face Brightener Function

Face Sharpener Function
You can sharpen out-of-focus faces in a photo.
Using the Face Sharpener Function

Digital Face Smoothing Function
You can enhance skin beautifully by removing blemishes and wrinkles.
Using the Digital Face Smoothing Function

Blemish Remover Function
You can remove moles.
Using the Blemish Remover Function

Image Adjustment
You can make fine adjustments to the overall brightness, contrast, etc. of images.
Adjusting Images
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting and
Enhancing Photos > Using the Auto Photo Fix Function

Using the Auto Photo Fix Function

Apply optimum corrections automatically to the photos used for an album or calendar.

\‘ Important

= The Auto Photo Fix function is not available for Photo Print. Photo Print allows you to automatically
apply suitable corrections to all photos when printing. Select this option in Image on the Advanced

tab of the Preferences dialog box. To display the Preferences dialog box, click f'—ffl-'l' (Settings) in the
Layout/Print screen or select Preferences... from the File menu.

= Once image is corrected with Auto Photo Fix and saved, it cannot be corrected again with Auto
Photo Fix.
Also, Auto Photo Fix may not be available for images edited using an application, digital camera,
etc. manufactured by other companies.

1. Select photos in the Select Images screen, then click f (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

e NI
ﬁﬁ At Phets Fie
- FledEys Conection

4
‘?_bﬁ Face Shapenst

RO DidiseSosting | -

MBS sz IMGIGep GO0t

Ext

O Userd UderHame IMIG0005 1 iy Seleered: 3

Note

= You can also display the Correct/Enhance Images window by clicking f‘ib (Correct/Enhance
Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview
can be corrected/enhanced.

= See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

= If only one image is selected, the thumbnail does not appear below Preview.

3. Make sure that Auto is selected.
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4. Click Auto Photo Fix, then click OK.

The entire photo is corrected automatically and the ¢ (Correction/Enhancement) mark appears on
the upper left of the image.

E.fl Note

Click (Compare) to display the images before and after the correction side by side so that
you can compare and check the result.

Click Reset Selected Image to undo the correction operation.

If you want to apply the correction to all the selected images at once, select the Apply to all
images checkbox.

5. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

——! Note

To save only the image you like, click Save Selected Image. To save all images, click Save All
Corrected Images.
Only JPEG/EXif file format is available for corrected images.

6. Click Exit.

-1 Note

The corrections will be lost if you exit before saving corrected images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting and
Enhancing Photos > Using the Red-Eye Correction Function

Using the Red-Eye Correction Function

You can correct red eyes caused by a camera flash.
You can perform the Red-Eye Correction function either automatically or manually.

E Note

= Photo Print allows you to automatically correct red eyes when printing. To correct automatically,
select Enable Auto Photo Fix in Color correction for printing on the Advanced tab of the Preferences
dialog box and select the Enable Red-Eye Correction checkbox.

1. Select photos in the Select Images screen, then click f (Correct/Enhance
Images).

The Correct/Enhance Images window appears.
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E Note

= You can also display the Correct/Enhance Images window by clicking f (Correct/Enhance
Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview
can be corrected/enhanced.

= See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

EEI Note

= If only one image is selected, the thumbnail does not appear below Preview.

Auto Correction
3. Make sure that Auto is selected.

4. Click Red-Eye Correction.
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5. Click OK.

Red eyes are corrected and the & (Correction/Enhancement) mark appears on the upper left of
the image.

\‘ Important

Areas other than the eyes may be corrected depending on the image.

EEI Note

Click (Compare) to display the images before and after the correction side by side so that
you can compare and check the result.

Click Reset Selected Image to undo the correction operation.

If you want to apply the correction to all the selected images at once, select the Apply to all
images checkbox.

Manual Correction
3. Click Manual, then click Correct/Enhance.

4. Click Red-Eye Correction.

Move the cursor over the image. The shape of the cursor changes to {\. (Paintbrush).
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5. Drag to select the red area you want to correct, then click OK that appears over the
image.

Red eye is corrected and the o (Correction/Enhancement) mark appears on the upper left of the
image.
EEI Note

Click Undo to undo the preceding correction operation.
Effect levels can be changed using the slider below Red-Eye Correction.
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6. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

——! Note

C1p. 124 n3 334 cT1p.

To save only the image you like, click Save Selected Image. To save all images, click Save All
Corrected Images.
Only JPEG/EXxif file format is available for corrected images.

7. Click Exit.

——! Note

The corrections will be lost if you exit before saving corrected images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting and

Enhancing Photos > Using the Face Brightener Function

Using the Face Brightener Function

You can brighten dark faces caused by bright background.

1. Select photos in the Select Images screen, then click 3} (Correct/Enhance

Images).
The Correct/Enhance Images window appears.
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Note

= You can also display the Correct/Enhance Images window by clicking i} (Correct/Enhance
Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.

= See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the

Correct/Enhance Images window.

The image appears in Preview.

Note

= If only one image is selected, the thumbnail does not appear below Preview.

3. Click Manual, then click Correct/Enhance.

4. Click Face Brightener.

Move the cursor over the image. The shape of the cursor changes to + (Cross).
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5. Drag to select the area you want to correct, then click OK that appears over the
image.

The entire image is corrected so that the selected area containing the face becomes brighter, and
the & (Correction/Enhancement) mark appears on the upper left of the image.

Note

= You can also drag to rotate the rectangle.
= Click Undo to undo the preceding correction operation.
= Effect levels can be changed using the slider below Face Brightener.

6. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

Note

= To save only the image you like, click Save Selected Image. To save all images, click Save All
Corrected Images.
= Only JPEG/EXif file format is available for corrected images.

7. Click Exit.
Note

= The corrections will be lost if you exit before saving corrected images.
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Using the Face Sharpener Function

You can sharpen out-of-focus faces in a photo.
You can perform the Face Sharpener function either automatically or manually.

1. Select photos in the Select Images screen, then click } (Correct/Enhance
Images).

The Correct/Enhance Images window appears.
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Note

= You can also display the Correct/Enhance Images window by clicking 3} (Correct/Enhance
Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview
can be corrected/enhanced.

m See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

= If only one image is selected, the thumbnail does not appear below Preview.

Auto Correction
3. Make sure that Auto is selected.
4. Click Face Sharpener.

5. Click OK.

The face is sharpened and the & (Correction/Enhancement) mark appears on the upper left of the
image.
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== Note

Ctp. 128 u3 334 crp.

= Effect levels can be changed using the slider below Face Sharpener.

= Click (Compare) to display the images before and after the correction side by side so that
you can compare and check the result.

= Click Reset Selected Image to undo the correction operation.

= If you want to apply the correction to all the selected images at once, select the Apply to all
images checkbox.

Manual Correction
3. Click Manual, then click Correct/Enhance.

4. Click Face Sharpener.

Move the cursor over the image. The shape of the cursor changes to + (Cross).
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5. Drag to select the area you want to correct, then click OK that appears over the
image.

The facial area in and around the selected area is sharpened and the J’ (Correction/
Enhancement) mark appears on the upper left of the image.

E.fl Note

= You can also drag to rotate the rectangle.
= Click Undo to undo the preceding correction operation.
= Effect levels can be changed using the slider below Face Sharpener.

6. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

——! Note

= To save only the image you like, click Save Selected Image. To save all images, click Save All
Corrected Images.
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= Only JPEG/EXif file format is available for corrected images.

7. Click Exit.

Note

= The corrections will be lost if you exit before saving corrected images.
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Enhancing Photos > Using the Digital Face Smoothing Function

Using the Digital Face Smoothing Function

You can enhance skin beautifully by removing blemishes and wrinkles.

You can perform the Digital Face Smoothing function either automatically or manually.

1. Select photos in the Select Images screen, then click f (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

. Comest/Erkance Image:

e e

,&Q. Aut Fsts Fie
'E'_;H RedEps Conection
Q_& Face Shapenst

Q_&_ Digited Face Smcathing

Ex

C e\ Uiedtlame Pnenda jpg Selecred: 3

E Note

You can also display the Correct/Enhance Images window by clicking -’b (Correct/Enhance
Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview
can be corrected/enhanced.

See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.

2. Select the image you want to enhance from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

——! Note

If only one image is selected, the thumbnail does not appear below Preview.

Auto Enhancement
3. Make sure that Auto is selected.
4. Click Digital Face Smoothing.

5. Click OK.

Skin is enhanced beautifully and the J (Correction/Enhancement) mark appears on the upper left
of the image.
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E.j Note

Effect levels can be changed using the slider below Digital Face Smoothing.

Click (Compare) to display the images before and after the enhancement side by side so
that you can compare and check the result.

Click Reset Selected Image to undo the enhancement operation.

If you want to apply the enhancement to all the selected images at once, select the Apply to all
images checkbox.

Manual Enhancement
3. Click Manual, then click Correct/Enhance.

4. Click Digital Face Smoothing.

Move the cursor over the image. The shape of the cursor changes to -+ (Cross).
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5. Drag to select the area you want to enhance, then click OK that appears over the
image.

Skin in and around the selected area is enhanced beautifully and the & (Correction/Enhancement)
mark appears on the upper left of the image.

E.j Note

You can also drag to rotate the rectangle.
Click Undo to undo the preceding enhancement operation.
Effect levels can be changed using the slider below Digital Face Smoothing.

6. Click Save Selected Image or Save All Corrected Images.
You can save enhanced images as new files.

E.j Note

To save only the image you like, click Save Selected Image. To save all images, click Save All
Corrected Images.
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Only JPEG/EXif file format is available for enhanced images.

7. Click Exit.

E.fl Note

The enhancements will be lost if you exit before saving enhanced images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting and
Enhancing Photos > Using the Blemish Remover Function

Using the Blemish Remover Function

You can remove moles.

1. Select photos in the Select Images screen, then click H}’ (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

’;g.-gl At Phets Fie

ﬂ"__bt' FledEys Conection

Q_@ Face Shapenst

D& DipdfaeSosting

O\ Users Udertlame gitl ey Seleered: 3

Note

= You can also display the Correct/Enhance Images window by clicking H;b (Correct/Enhance
Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview
can be corrected/enhanced.

= See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.

2. Select the image you want to enhance from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

= |f only one image is selected, the thumbnail does not appear below Preview.

3. Click Manual, then click Correct/Enhance.

4. Click Blemish Remover.

Move the cursor over the image. The shape of the cursor changes to + (Cross).
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5. Drag to select the area you want to enhance, then click OK that appears over the
image.

Moles in and around the selected area are removed and the - (Correction/Enhancement) mark
appears on the upper left of the image.

Note

= Click Undo to undo the preceding enhancement operation.

6. Click Save Selected Image or Save All Corrected Images.

You can save enhanced images as new files.

Note

= To save only the image you like, click Save Selected Image. To save all images, click Save All
Corrected Images.
= Only JPEG/EXif file format is available for enhanced images.

7. Click Exit.
Note

= The enhancements will be lost if you exit before saving enhanced images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting and
Enhancing Photos > Adjusting Images

Adjusting Images

You can make fine adjustments to the overall brightness, contrast, etc. of images.

1. Select photos in the Select Images screen, then click @ (Correct/Enhance
Images).

The Correct/Enhance Images window appears.
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Note

= You can also display the Correct/Enhance Images window by clicking @ (Correct/Enhance
Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview
can be corrected/enhanced.

= See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.

2. Select the image you want to adjust from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

= |f only one image is selected, the thumbnail does not appear below Preview.

3. Click Manual, then click Adjust.

4. Move the slider of the item you want to adjust and set the effect level.
The following adjustments are available:
Brightness
Contrast
Sharpness
Blur
Show-through Removal
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Note

= Click Defaults to reset all adjustments.

5. Click Save Selected Image or Save All Corrected Images.
You can save adjusted images as new files.

Note

= To save only the image you like, click Save Selected Image. To save all images, click Save All
Corrected Images.
= Only JPEG/EXxif file format is available for adjusted images.

6. Click Exit.
Note

= The adjustments will be lost if you exit before saving adjusted images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting and
Enhancing Photos > Correct/Enhance Images Window

Correct/Enhance Images Window

You can correct/enhance images in this window.

To display the Correct/Enhance Images window, click H;b (Correct/Enhance Images) in the Select
Images or Edit screen, or in the Layout/Print screen of Photo Print.
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(D)Toolbar

Toolbar

@g @w (Zoom In/Zoom Out)

Displays the enlarged or reduced preview of the page.

El (Full Screen)

Displays the entire image in Preview.
(Compare)

Displays the Compare Images window. You can compare the images before and after the correction
side by side.

The image before the correction/enhancement is displayed on the left, and the image after the
correction/enhancement is displayed on the right.
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(2)Task Area
Available tasks and settings may vary between the Auto and Manual tabs.

Click Auto or Manual to display the corresponding tab.

Auto Tab

Select to correct automatically.
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Auto Photo Fix
Applies automatic corrections suitable for photos.

N important

= The Auto Photo Fix function is not available for Photo Print. Photo Print allows you to
automatically apply suitable corrections to all photos when printing. Select this option in Image
on the Advanced tab of the Preferences dialog box. To display the Preferences dialog box, click

'-'-'Fil-'l' (Settings) in the Layout/Print screen or select Preferences... from the File menu.

Red-Eye Correction
Corrects red eyes.

Note

= For Photo Print, you can also correct red eyes by selecting Enable Auto Photo Fix in Color
correction for printing on the Advanced tab of the Preferences dialog box and selecting the

Enable Red-Eye Correction checkbox.
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Face Sharpener

Sharpens out-of-focus faces.
You can adjust the effect level using the slider.

Digital Face Smoothing

Enhances skin beautifully by removing blemishes and wrinkles.
You can adjust the effect level using the slider.

Apply to all images

Automatically corrects all the images displayed in the list.
OK

Applies the selected effect to the selected image or all images.
Reset Selected Image

Cancels all corrections and enhancements applied to the selected image.
Save Selected Image

Saves the selected image.
Save All Corrected Images

Saves all the images displayed in the list.
Exit

Click to close the Correct/Enhance Images window.
Manual Tab

Select to correct manually.
Use Adjust to adjust brightness and contrast, or to sharpen the entire image.
Use Correct/Enhance to correct/enhance specific areas.
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Brightness

Adjusts the overall image brightness.
Move the slider to the left to darken and right to brighten the image.

Contrast

Adjusts the contrast of the image. Adjust the contrast when the image is flat due to lack of contrast.
Move the slider to the left to decrease and right to increase the contrast of the image.

Sharpness

Emphasizes the outline of the subjects to sharpen the image. Adjust the sharpness when the photo
is out of focus or text is blurred.
Move the slider to the right to sharpen the image.
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Blur

Blurs the outline of the subjects to soften the image.
Move the slider to the right to soften the image.

Show-through Removal

Removes show-through of text from the reverse side or removes the base color. Adjust the show-
through level to prevent text on the reverse side of thin document or the base color of the document
from appearing on the image.

Move the slider to the right to increase the show-through removal effect.

Defaults
Resets all adjustments (brightness, contrast, sharpness, blur, and show-through removal).
Reset Selected Image
Cancels all adjustments applied to the selected image.
Save Selected Image
Saves the selected image.
Save All Corrected Images
Saves all the images displayed in the list.
Exit

Click to close the Correct/Enhance Images window.

Correct/Enhance
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Red-Eye Correction

Corrects red eyes.
You can specify the area you want to apply the effect to. You can adjust the effect level using the
slider.

Note
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= For Photo Print, red eyes are automatically corrected when Enable Auto Photo Fix is selected in

Color correction for printing on the Advanced tab of the Preferences dialog box and the Enable
Red-Eye Correction checkbox is selected. To disable the automatic correction, deselect the
checkbox.

Face Brightener

Corrects the entire image so that the selected facial area is brightened.
You can adjust the effect level using the slider.

Face Sharpener

Sharpens out-of-focus faces.
You can specify the area you want to apply the effect to. You can adjust the effect level using the
slider.
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Digital Face Smoothing

Enhances skin beautifully by removing blemishes and wrinkles.
You can specify the area you want to apply the effect to. You can adjust the effect level using the
slider.

Blemish Remover

Removes moles.
You can specify the area you want to apply the effect to.

Undo

Cancels the latest correction/enhancement.
OK

Applies the selected effect to the specified area.
Reset Selected Image

Cancels all corrections and enhancements applied to the selected image.
Save Selected Image

Saves the selected image.
Save All Corrected Images

Saves all the images displayed in the list.
Exit

Click to close the Correct/Enhance Images window.
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Questions and Answers

= How Can | Move (or Copy) the Saved File?

=+ Which Side of the Displayed Image Does the Printing Start from?
= How Do | Print with Even Margins?

=+ What Is "C1" or "C4"?
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How Can | Move (or Copy) the Saved File?

If you want to move (or copy) a file created and saved with Easy-PhotoPrint EX from one folder to another,
you need to move (or copy) the folder that was automatically created when originally saving that file as
well.

For example, when you save a file named "MyAlbum.el1," a folder named "MyAlbum.el1.Data" is
automatically created in the same folder that contains the "MyAlbum.el1" file. If you want to move (or copy)
the "MyAlbum.el1" file to another folder, move (or copy) the "MyAlbum.el1.Data" folder as well.

The "MyAlbum.el1.Data" folder contains the photos used in the album.

| S ]

My Alburm,ell g
Data MyAlbum.ell
=5 Note

The icons may vary depending on the items.

@' Important

Do not change the Data folder name; otherwise you will not be able to display the photos you edited
with Easy-PhotoPrint EX.
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Which Side of the Displayed Image Does the Printing Start
from?

As shown below, printing starts from the left side of the image displayed in the Layout/Print screen.

B8 B

[ [ L —
o=

— L m

(] [=a] L}

Outputs the paper in the direction as the arrow indicates.
See your printer manual for details on how to load paper (to print on the front/back, etc.).

Page top#-



How Do | Print with Even Margins? Ctp. 145 13 334 cTp.

Adyanced Gnde’

Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Questions and Answers
> How Do | Print with Even Margins?

How Do | Print with Even Margins?

When you print on a bordered layout, the margins on the left and right or the top and bottom may become
wider than the other, depending on the image and printer.

To always print with even margins, select the Always crop images when selecting a layout with margins
checkbox on the Advanced tab of the Preferences dialog box.

.
To display the Preferences dialog box, click *'-?-T (Settings) in the Layout/Print screen or select
Preferences... from the File menu.
Crop the photo to apply even margins individually.
Cropping Photos (Photo Print)

EEI Note

The following setting is available for Photo Print only.
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What Is "C1" or "C4"?

When an album is printed, labels such as "C1" and "C4" are printed as page numbers.
The "C1" and "C4" represent the front cover and back cover, respectively.

1 C1: Front cover
2 C2: Inside the front cover
3 C3: Inside the back cover

4 C4: Back cover
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Appendix 1. Easy-PhotoPrint EX Settings

= Printing Vivid Photos

= Reducing Photo Noise

=} Cropping Photos (Photo Print)

= Printing Dates on Photos (Photo Print)
= Printing Multiple Photos on One Page
= Printing an Index

= Printing 1D Photos (ID Photo Print)

= Printing Photo Information

= Saving Photos

= Opening Saved Files

= Changing Layout

= Changing Background

=+ Adding Photos

= Swapping Positions of Photos

= Replacing Photos

= Changing Position, Angle and Size of Photos
= Cropping Photos

= Framing Photos

= Printing Dates on Photos

= Attaching Comments to Photos

=+ Adding Text to Photos

= Saving

=k Setting Holidays

=} Setting Calendar Display
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Printing Vivid Photos

Select the Vivid Photo checkbox in the Select Paper screen to boost the colors in a photo before printing.

| 3, Mew hictio Print - Easy-PhatcRrint £X = ion == |
Bile [dit Wiew Hep
B Select e pomber boge, then seleci e e aned ipos of paper b printrg.
Exif Print
Preder Comreor 000 '| Plags 5 puren Fles Tisy -
(@ Select Images I ot Mzn Fieehaction [ o E]
¥ P Sim Hiia Tyem
l{z.‘- Solock Paper =
E O
@ Layout/Prink
0 5w PhotaPapes Py Photo Paps Pioll
WSerm HER RS Gleagy
FiwtoPage Fia Fito Pager Pl
BL;&;-' “ Ltim Semighis
Gl PretaPogar MatsProta P
0 L — i s e
Hhicn -

\‘ Important

= This function is available only with a printer that supports Vivid Photo.
= This function is not available when Enable ICC Profile is selected on the Advanced tab of the
Preferences dialog box.

Note

= Even if you select the Vivid Photo checkbox, this effect applies only to the print result. The original
image or preview image will not be affected.
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Reducing Photo Noise

When a photo is taken in a dark location such as night scene using digital camera, noise may appear in
the image.

Select the Photo Noise Reduction checkbox in the Select Paper screen to reduce noise in the image and
make the printed photos more vivid.

| 56 M st Brint - Ersy-PhatePrint EX =RoE
Ele it Yiew Help
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\‘ Important

= This function is not available when Enable ICC Profile is selected on the Advanced tab of the
Preferences dialog box.

Note

= When the noise is severe, change Normal to Strong.
= The noise reduction effect applies only to the print result. The original image or preview image will
not be affected.
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Cropping Photos (Photo Print)

Cropping a photo is the act of removing the unnecessary portions of the photo by selecting the
necessary portions.

Click tl- (Crop Image) in the Layout/Print screen.
Move the white frame to the portion to print and click OK.

& Crop o o

B == e . - =

[] The Rude of Thrds 7] Crep Coe ) Coneel ][ Heb ]

Note

= To move the cropping area, place the cursor within the white frame and drag it. Drag the white lines
to enlarge/reduce the cropping area.

= Select the The Rule of Thirds checkbox to display white broken lines. To create a balanced
composition, drag any of the intersecting points (white squares) or white broken lines over the main
subject of the photo.

= The cropping effect applies only to the print result. The original image will not be cropped.
= See Help for details on the Crop window.
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Printing Dates on Photos (Photo Print)

To print the date the photo was taken on the photo, click (Date Settings) in the Layout/Print screen,
then select the Print date checkbox in the Date Settings dialog box.

Date Settings @

Text Orientation ; A @ Landscape =T, () Paorbrait

Position :
__| Bottam Right -

[T &pply ta all images

[ 0k, ][ Cancel H Defaultz ][ Help ]

EEI Note

The date is displayed in the short date format (mm/dd/yyyy, etc.) specified in your operating system.
In the Date Settings dialog box, you can change the orientation, position, size and color of the date
according to the orientation and background of the photo. See Help for details.
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Printing Multiple Photos on One Page

You can print multiple photos on one page by selecting a multiple-photo layout in the Layout/Print screen.

|55 Mew Bt Print - Easy-PhitePrint EX =
Bile [dit Yiew Hep
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Note

= See the following section for details on how to select photos.

= Selecting a Photo
= The available number of photos and layout may vary depending on the media type.
= Photos are arranged in the following order.

Example: Borderless (x4)

1|3
2 4

= You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.
You can select the printing order from By Date, By Name and By Selection.

To display the Preferences dialog box, click ‘—ET‘L'I' (Settings) or select Preferences... from the File
menu.
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Printing an Index

You can print an index of selected photos. An index print shows the thumbnails of the photos in one
page. It is convenient for managing your photos.

To print an index, select Index from the layouts in the Layout/Print screen.

5. P Bscto Print - Easy-PhatcPrint EX (=T IoE =
Hie [dit yiew Hep

Select Hhe Lyt wousward o gk
Phaoko Prnk Chesch thes Presvess aved ek thee Prink baston:

Preding thals Exif Print

[E=] ,

Note

= See the following section for details on how to select photos.
= Selecting a Photo
= |ndex print will be disabled if you select any of the following paper sizes.
- Credit Card
- Fine Art A4
- Fine Art A3
- Fine Art A3+
- Fine Art Letter
= Up to 80 thumbnails can be printed on one page.
= Photos are arranged in the following order.
Example: Index (x20)

L ]2][3]fa][s
'6([7] 8]/ 910
111]/12|[13||14|[15
116/[17]/18]]19| 20

= You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.
You can select the printing order from By Date, By Name, and By Selection.

To display the Preferences dialog box, click 5 (Settings) or select Preferences... from the File
menu.
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Printing ID Photos (ID Photo Print)

You can print a variety of ID photos.

\‘ Important

= The photo may not qualify as an official ID photo depending on its use.
For details, contact the party to whom you will be submitting the photo.

To print ID photos, select 4"x6" 10x15cm for Paper Size in the Select Paper screen, and select a layout of
the ID photo from the layouts in the Layout/Print screen.

5, Mew Phcta rint - Exsy-PhetePrint EX =T I =

Ele [dit Yiew Hep
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Note

= See the following section for details on how to select photos.
= Selecting a Photo

= Photos are arranged in the following order.
Example: ID Photo 3.5x4.5cm

139
2 4 6

= You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.
You can select the printing order from By Date, By Name, and By Selection.

To display the Preferences dialog box, click &T (Settings) or select Preferences... from the File
menu.
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Printing Photo Information

Select Captured Info from the layouts in the Layout/Print screen to print the photo and the Exif information
side by side.

p. Fiewr Picta Print - Easy-PhatePrint EX
Bl Edit e Hep

Sebat He Lyt wous w10 pnk
Chesch thes Fresesr ared chok thee Frink bitton

ok s Exif Print |

' e LR
ki }ili!iiuh'.-ii!l!i!i i ity
| |

Note
= See the following section for details on how to select photos.

= Selecting a Photo
= This function is available only on paper sizes Letter 8.5"x11" and A4.
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Saving Photos

You can save edited photos. The information of cropping and layout can be saved.

Click Save in the Layout/Print screen.

. e Fhwcho Print - Ensy-PhatePrint EX =R =
Ele it Yiew Help
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When the Save As dialog box appears, specify the save location and file name, then click Save.

Y important

= |f you edit a saved file and save it again, the file will be overwritten.

To save a file again with a new name or to a different location, select Save As... from the File menu
and save.

Note

= Save will not be displayed in the Select Images or Select Paper screen.
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Opening Saved Files

You can open files created with Easy-PhotoPrint EX.

1. Click Library from Menu.

5. Ensy-PhetoPrint BX
Eile  [dit Yiew Hep

SRR

Select Tbem
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Selan tha gam e want T8 £1aat2 from the many.,

Selat LDRy [0 a0 sved foms.

Tos

Layout Print

Libirary

The Open dialog box appears.
You can check files created and saved with Easy-PhotoPrint EX by icon view (only for Windows Vista)

or thumbnail view.

\‘ Important

= When using 64bit Edition of Windows Vista or Windows XP, the contents of files cannot be

displayed on Explorer.

. Select the file you want to open and click Open.

The Edit or Select Paper screen appears.

Note

= Easy-PhotoPrint EX supports the following file formats (extensions).
- Easy-PhotoPrint EX Photo Print file (.el6)
- Easy-PhotoPrint EX Album file (.el1)
- Easy-PhotoPrint EX Stickers file (.el2)
- Easy-PhotoPrint EX Calendar file (.el4)
- Easy-PhotoPrint EX Layout file (.el5)

. Edit the file if necessary.

Note

= See the following sections for details on the editing procedures.
Editing Album
Editing Calendar
Editing Stickers
Editing Layout Print

Note

= You can open files created with Easy-PhotoPrint EX with the following methods, besides from
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Library in Menu.

- Double-click or click the file.

- From the File menu, click Open..., then select the file you want to edit.

You can also open a recently used file by clicking the file name shown in the File menu.
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Changing Layout

You can change the layout of each page separately.

Select the page you want to change the layout of in the Edit screen, then click ‘i/ (Change Layout).

Select the layout you want to use in the Change Layout dialog box and click OK.

Album
Change Layout
O | @ - £
. ]| O
001 002
Edit Took D j - _j
@@@E [7] &pply to all pages
el -
- [ & Cancel | [ Hep |

\‘ Important
The album layouts that can be selected may vary depending on the Paper Size, Orientation, or the

type of page selected (front cover, inside pages or back cover).
If the new layout has a different number of frames per page from the current layout, the following will

happen:

If the number of layout : Images will move from the subsequent pages to fill all the frames
frames is increased in the new layout.

If the number of layout : Pages with the new layout will be added until all the images on the
frames is decreased pages with the current layout can be fitted.

If you change the selected layout for the front or back cover to one that has fewer layout frames, any
image that does not fit in the new layout will be deleted, starting with the last image that was added

to the former layout page.

E= Note
Select the Apply to all pages checkbox to change the layouts of all pages to the one you newly
selected.

Calendar



Changing Layout Ctp. 160 13 334 cTp.

—_—
Change Layout

no1 0oz 003 Qg 0a3

nog

B
leo)e
ENEE

\‘ Important

= The layouts that can be selected may vary depending on the Paper Size and Orientation.
= The layouts of all pages are changed to the selected layout.
= All images that do not fit in the new layout will be collected on one page.

[#] &pply to 2ll pages

Ok, Cancel || Hep |

Layout Print

Change Layout @
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\‘ Important

= The layouts that can be selected may vary depending on the Paper Size and Orientation.
= |f the new layout has a different number of frames per page from the current layout, the following will

happen:

If the number of layout : Images will move from the subsequent pages to fill all the frames
frames is increased in the new layout.

If the number of layout : Pages with the new layout will be added until all the images on the
frames is decreased pages with the current layout can be fitted.

Note

= Select the Apply to all pages checkbox to change the layouts of all pages to the one you newly
selected.
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Changing Background

You can change the background of each page.

\‘ Important

= You cannot change the background of the Photo Print, Stickers, and Layout Print.

Select the page you want to change the background of in the Edit screen, then click (Change
Background).

Note

= The screens for Album printing are used as examples in the following descriptions. The screens
may vary depending on what you create.

Change Background
Background Type: (@ [Select from sampled
() Single color
() Image file
() Ho background
Samgles:
001 ooz o3
0os 0oe
Al LI ] | | [ 1 -
@I [ Apply to all pages
EOES _
.0k [ Cencel | [ Heb

Select the type of background you want to use in the Change Background dialog box.

When Select from samples is Selected
Select the image you want to use from Samples and click OK.

Note

= Select from samples will be displayed only if Album has been selected.

When Single color is Selected
Select the color you want to use from Standard color or Custom color and click OK.
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Change Background |

Backaround Type: Select from samples

Image file
Mo background

Background Colar;

@) Standard color |:|

Custom color Customize. .

Apply to all pages

] ]| Cancel || Help

When Image file is Selected
Set Image File Path and Image Layout, then click OK.



Changing Background

Change Background

Backaround Type: 1 Select from samples

1 Single color
@ Image file
' Mo background

Image File Path:
a C:hUzerzhdze amehlMGO032_s.jpg

[] Semitranzparent
10

Image Layaout:
@ Crop to fit page
) Auto zoale bo fit page
) Tile

! Original gize

[] Apply to all pages

Ok II Cancel JI

Help

E.j Note

Ctp. 163 u3 334 c1p.

See Help for details on how to set the background in the Change Background dialog box.
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Adding Photos

You can add images to pages.

i
Select the page you want to add photos in the Edit screen, then click (Add Image).

Note

= The screens for Album printing are used as examples in the following descriptions. The screens
may vary depending on what you create.
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Select the folder containing the image you want to add from the folder tree area on the left of the Add
Image dialog box, and select the image you want to add from the thumbnail window on the right.

Note

= Click an image to select it (background turns blue) or deselect it (background turns white). You can
also select multiple images.

Select an option for Add to and click OK.

\‘ Important

You can add up to 20 images at one time to a single page.

Up to 99 of the same images can be added to all pages combined.

You cannot add two or more of the same image at one time. In that case, add it one at a time.
If you increase the number of pages to add images, you cannot add images beyond page 400.

Note

= In the Add Image dialog box, you can select all images at one time or change the display size and
order of the thumbnails. See Help for details.
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Swapping Positions of Photos

You can swap the positions of images.

Click @ (Swap Image Positions) in the Edit screen.

Note

= The screens for Album printing are used as examples in the following descriptions. The screens
may vary depending on what you create.
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Select the target and source images you want to swap, then click Swap.
When you finish swapping all images you want to swap, click Back to Edit.

HHH
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Replacing Photos

You can replace an image with another image.

"Tu
Select the image you want to replace in the Edit screen, then click (Replace Selected Image).
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=

Select the folder containing the image you want to replace with from the folder tree area on the left of the

Replace Image dialog box.

Select the image you want to replace with from the thumbnail window on the right of the screen and click

OK.

If you want to select from the images already imported, click the Imported Images tab and select the
image you want to replace with from the thumbnail window and click OK.

\‘ Important

= You cannot select multiple images in the Replace Image dialog box.

Note

= If you select multiple images in the Edit screen and use the replacement function, all the images
selected in the Edit screen will be replaced with the image selected in the Replace Image dialog

box.

= When images are replaced, the following settings of the old image are inherited to the new image.

- Position

- Size

- Frame

- Position and size of the date

The cropping information and image orientation are not inherited.
= In the Replace Image dialog box, you can change the display size and order of the thumbnails. See

Help for details.
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Changing Position, Angle and Size of Photos

You can adjust the position, angle and size of images.

Select the image of which you want to change the position or size in the Edit screen and click (Edit
Image) or double-click the image.

Edit Image
Pasition & Size | Crop | Frame | Date | Comments
e e
& File Mame: [MGO03Z_s.jpg
= o |
Center Posgtion
Fiom Lelt of Fage: EEEI_%I mm Fiom Top of Page: 14842 mm
FBotation; =
Sizer
@) Cuslom size
[7] Lpck aspect ratio
itk 1270 %_ i Height: 246 %_ i
() Stapdard zize
Size 4'E
oK Cancel | [  Hep

Set the Center Position, Rotation and Size, then click OK.
EEI Note

= You can also change the position and size of an image by dragging it in the Edit screen.

S

= Select an image in the Edit screen, then click ' (Free Rotate) and drag a corner of the image to
rotate it.

= See Help for details on the position and size of images.
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Cropping Photos

Cropping an image is the act of removing the unnecessary portions of the image by selecting the
necessary portions.

Select the image you want to crop in the Edit screen and click (Edit Image) or double-click the
image.
Click the Crop tab in the Edit Image dialog box.

2 ———

I F-uei;'rnn&ﬁizel Crop | Frame | Date | Comments |

Drag the portion within the whits freme onto the ares to orop. Drag any squsrs on thefreme o resize
the croppmg arsa.

Drag the white squares on the image to change the area to be cropped and click OK.

E Note

= See Help for details on cropping.
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Framing Photos

You can add frames to images.

\3 Important

= You cannot add frames to images in Photo Print, Stickers, and Layout Print.

(i
Select the image you want to frame in the Edit screen and click (Edit Image) or double-click the
image.
Click the Frame tab in the Edit Image dialog box.

EditImage

| Postion & Size| Crop | Frame | Date [ Comments |

Framas

Mo Frama

L]
n

[ Apely 1o allimages in the page

Select the frame you want to use from Frames and click OK.

\3 Important

= You cannot print dates on framed photos.

Note

= Select the Apply to all images in the page checkbox to add the same frame to all the images on a
selected page at one time.
= See Help for details on frames.
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Printing Dates on Photos
You can print dates on images.

(i
Select the image you want to print the date in the Edit screen and click (Edit Image) or double-click
the image.

Click the Date tab in the Edit Image dialog box.

| EditImage @

| Postion & Size | Crop | Freme | Date | Comments |

................

[¥)ighaw date!
Text Orizntation: A @ Landscape =r} [0 Portrait
Pastion:
__| Bottom Right -

[ Ay to l images

0K || Cancel |[ Hep |

Select the Show date checkbox.

Set the Text Orientation, Position, Font Size and Color, then click OK.

N Important

= You cannot print dates on framed images.

Note

= The date is displayed in the short date format (mm/dd/yyyy, etc.) specified in your operating system.
= See Help for details on setting dates.
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Attaching Comments to Photos

You can attach comments to images and display them in your album. The photo name, shooting date
and comments are displayed (from top to bottom) in a comment box.

A memory of summer
Fami ing with sa

\‘ Important

= You cannot attach comments to Photo Print, Calendar, Stickers, and Layout Print.

Select the image you want to attach comments to in the Edit screen and click (Edit Image) or

double-click the image.
Click the Comments tab in the Edit Image dialog box.
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| EditImage
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Select the Show comment box checkbox.
Select the checkboxes of the items you want to display, and enter comments.
Set the size and color of font, and position, etc. of the comments, then click OK.

Note

= See Help for details on comments.
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Adding Text to Photos

You can add text to photos.

A
Click (Add Text) in the Edit screen and drag the mouse over the area in which you want to add text.

Note

= The screens for Album printing are used as examples in the following descriptions. The screens

may vary depending on what you create.
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Select the Text tab in the Edit Text Box dialog box and enter text.

Note

= |n the Edit Text Box dialog box, you can change the position, angle and size of the text. You can also
set the color and line of the text box. See Help for details.

= To change the entered text, select it and click (Edit Text Box). The Edit Text Box dialog box

appears. You can change the text.
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Saving
You can save edited items.

Click Save in the Edit or Print Settings screen.

Note

= The screens for Album printing are used as examples in the following descriptions. The screens
may vary depending on what you create.
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When the Save As dialog box appears, specify the save location and file name, then click Save.

'L\ Important

= |f you edit a saved file and save it again, the file will be overwritten.

To save a file again with a new name or to a different location, select Save As... from the File menu
and save.

Note

= Save will not be displayed in the Page Setup or Select Images screen.
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Setting Holidays

You can add holidays to your calendar.

Click Set Holidays... in the Page Setup screen of Calendar, or click (Setup Period/Holiday) in the
Edit screen and click Set Holidays... in the Calendar General Settings dialog box to display the Holiday
Settings dialog box.

Holiday Settings (3]
Period: From 242009 to 4,/2003
Date Holiday Mame Set az Holiday add...
Edit...
Delete
Clear
k. ] [ Cancel ] [ Help

To add a holiday, click Add.... The Add/Edit Holiday dialog box appears. To edit a saved holiday, select it
and click Edit....

To delete a holiday, select it and click Delete. To delete all the saved holidays within your calendar
period, click Clear.

Add/Edit Holiday |

Haliday Marne: |

Set az Holiday

Period: From 2/2003 to 4,/2003
Month /*'ear: [Februar_l,l 2009 w7
Dran:
() Day of week First Sunday
(] [ Cancel ] [ Help

Enter the name in Holiday Name and specify the date.
Select the Set as Holiday checkbox to display that day as a holiday in your calendar.

——1 Note
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See Help for details on each dialog box.
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Setting Calendar Display

You can customize the calendar display (fonts, lines, colors, position, size, etc.).

Click Settings... in the Page Setup screen of Calendar, or select a calendar in the Edit screen and click
(Setup Calendar) to display the Calendar Settings dialog box.

\‘ Important

= The Position & Size tab is displayed only when the Calendar Settings dialog box is displayed from
the Edit screen.

 Calendar Settings
Stie | Options | Color | Fostion & Sizz]
Syl for Year and Maonth
. Eoni; [#nal "]
e ' Fomat: |3/2008 M
Y N I I N
_'.1 L ‘ *- '-I [ Style for Days of Weeak
” : Week Stars on: [Smdar v]
Style for Days
Fort: Erial -
Defaults
ok | [ Cancel |[ Hep |

Note

= See Help for details on the Calendar Settings dialog box.
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Printing with Other Application Software

= Various Printing Methods
= Changing the Print Quality and Correcting Image Data
= Overview of the Printer Driver

Page top #
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Various Printing Methods

= Printing with Easy Setup

= Setting a Page Size and Orientation

= Setting the Number of Copies and Printing Order
= Setting the Stapling Margin

= Borderless Printing

= Fit-to-Page Printing

= Scaled Printing

= Page Layout Printing

= Poster Printing

=+ Booklet Printing

= Duplex Printing

= Stamp/Background Printing

= Saving a Stamp Setting

= Saving Image Data to be Used as a Background
= Printing an Envelope

= Displaying the Print Results before Printing

= Setting Paper Dimensions (Custom Size)
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Printing with Easy Setup

The procedure for setting the basic print setup, which is necessary to print data properly with this printer,
is as follows:

1. Open the printer driver setup window

2. Select the media type
Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the print quality
Select High, Standard, or Fast for Print Quality.

4. Select color/intensity

Select Auto for Color/Intensity.

5. Check the settings

Check the specified settings such as paper type and the position of paper thickness lever displayed
in the Settings Preview on the left side of the window.

6. Complete the setup

Click OK.
When you execute print, the document will be printed in accordance with the type of media.
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Setting a Page Size and Orientation
The paper size and orientation are essentially determined by the application. If the page size and
orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the

application, you do not need to select them on the Page Setup tab.

If you are not able to specify them with the application, the procedure for selecting a page size and
orientation is as follows:

1. Open the printer driver setup window

2. Select the paper size
Select a page size from the Page Size list on the Page Setup tab.
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3. Select Orientation

Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box if you want to
perform printing with the original being rotated 180 degrees.

4. Complete the setup

Click OK.
The document will be printed with the selected page size and the orientation.
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Setting the Number of Copies and Printing Order

Default Setting Print from Last Page

g// {/// |

Collate Print from Last Page + Collate

The procedure for specifying the number of copies and printing order is as follows:
1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Page Setup tab, specify the number of copies to be printed.
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3. Specify the print sequence

Check the Print from Last Page check box if you want to print from the last page in order. If you do
this, you do not need to sort pages into their correct order after printing.

4. Set up collated printing when you specify multiple copies in the Copies box

Check the Collate check box if you are specifying multiple copy together.
Uncheck this check box to print all pages with the same page number together.

5. Complete the setup

Click OK.
The specified number of copies will be printed with the specified printing order.

!3 Important
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If your application has the same function, make the settings with the application. If you specify the
number of copies and the printing order with both the application and this printer driver, the number
of copies may be multiplied numbers of the two settings or the specified printing order may not be
enabled.

Print from Last Page and Collate appear grayed out and are unavailable if Booklet Printing is
selected for Page Layout.

Print from Last Page appears grayed out and is unavailable if Poster Printing is selected for Page
Layout.

E.j Note

By setting both Print from Last Page and Collate, you can perform printing so that papers are
collated one by one starting from the last page.

These settings can be used in combination with Borderless Printing, Normal-size Printing, Fit-to-
Page Printing, Scaled Printing, Page Layout Printing, and Duplex Printing.
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Setting the Stapling Margin

The procedure for setting the stapling direction and the width of the stapling margin is as follows:
1. Open the printer driver setup window

2. Specify the side to be stapled

Check the position of the stapling margin from Staple Side on the Page Setup tab.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
staple position. If you want to change the setting, select from the list.
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3. Set the margin width
If necessary, click Specify Margin... and set the width of the stapling margin, and then click OK.
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4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified staple side and margin.

\‘ Important

= Staple Side and Specify Margin... appear grayed out and are unavailable when:
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Poster Printing or Booklet Printing is selected for Page Layout.
Scaled Printing is selected for Page Layout (If Duplex Printing is also selected, only Staple Side is

selectable).
Borderless Printing check box is checked (If Duplex Printing is also selected, only Staple Side is
selectable).
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Borderless Printing

The borderless printing function allows you to print data without any margin by enlarging the data so that
it extends slightly off the paper. Without the borderless printing function, a margin is provided around the
printed data. If you want to print data such as a photo without providing any margin around it, select
Borderless Printing.

The procedure for performing borderless printing is as follows:

Setting Borderless Printing
1. Open the printer driver setup window

2. Set borderless printing
Check the Borderless Printing check box on the Page Setup tab.
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Click OK when the confirmation message appears.
When a message prompting you to change the media type appears, select a media type from the
list and click OK.

3. Check the paper size

Check the Page Size list. If you want to change, select another page size from the list. The list
displays only sizes that can be used for borderless printing.

4. Adjust the amount of extension from the paper

Adjust the amount of extension using the Amount of Extension slider as necessary.
Moving the slider to the right makes the amount larger and moving the slider to the left makes the
amount smaller.



Borderless Printing Ctp. 187 n3 334 cp.

It is recommended to set the slider at the second position from the right for most cases.

XX 0 N8l

\‘ Important

If you set the slider at the rightmost position, the back side of the paper may become smudged.

5. Complete the setup

Click OK.
The data will be printed without any margins on the paper.

\‘ Important

If a page size that cannot be used for borderless printing is selected, the size is automatically
changed to the valid page sizes for borderless printing.

When High Resolution Paper, T-Shirt Transfers, or Envelope is selected from the Media Type list on
the Main tab, you cannot perform borderless printing.

When Borderless Printing is checked, the Printer Paper Size, Page Layout, Staple Side (when
Duplex Printing is not selected) settings, and the Stamp/Background... button on the Page Setup tab
appear grayed out and are unavailable.

Print quality may deteriorate or the sheet may be stained at the top and bottom depending on the
type of the media used.

When the ratio of the height to the width differs greatly from the image data, a portion of the image
may not be printed depending on the size of the media used.

In this case, crop the image data with an application software according to the paper size.

E.j Note

When Plain Paper is selected for Media Type on the Main tab, borderless printing is not
recommended, and therefore the dialog box for media selection appears.
If you are using plain paper for test printing, select Plain Paper, and click OK.

Expanding the range of the document to print

Specifying a large amount of extension allows you to perform borderless printing with no problems.
However, the portion of the document that extends off the paper range will not be printed. Subjects
around the perimeter of a photo may not be printed.

Try borderless printing once. If you are not satisfied with the result of borderless printing, reduce the
amount of extension. The extension amount becomes shorter as the Amount of Extension slider is
moved to the left.

\‘ Important

If the Amount of Extension is shortened, an unexpected margin may be produced on the print,
depending on the size of the paper.

E.j Note

If Preview before printing is checked on the Main tab, you can confirm before printing whether there
will be no border.
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Fit-to-Page Printing

| The 10h Amiversary |
Festival

Festival

4

Gowme. i firin it !

Eomte mn.ﬂ!'_;.nm Wi !

The procedure for printing document, which is enlarged or reduced to fit to the page size, is as follows:
1. Open the printer driver setup window

2. Set fit-to-page printing
Select Fit-to-Page Printing from the Page Layout list on the Page Setup tab.
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3. Select the paper size for the data

Using Page Size, select the page size that was set with your application.

Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
If the printer paper size is smaller than the Page Size, the page image will be reduced. If the printer
paper size is larger than the page size, the page image will be enlarged.

The current settings are displayed in the Settings Preview on the left side of the printer driver.
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5. Complete the setup
Click OK.

When you execute print, the document will be enlarged or reduced to fit to the page size.

@ Important

Ctp. 189 n3 334 ctp.

= When Borderless Printing check box is checked, Fit-to-Page Printing cannot be selected.
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Scaled Printing
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The procedure for printing a document with pages enlarged or reduced is as follows:
1. Open the printer driver setup window

2. Set scaled printing
Select Scaled Printing from the Page Layout list on the Page Setup tab.

W
[ Maim| 3 Page Sehup | oF EMects | 05 Prcties | B B |

Bl poge g [Lemer 857117 -
& Onentaton B @ Poimg |i] O Largiscags
|7 Rstate 1B0 dogrees
& prg e sor  [Lewas -
Page Layout ] Geretrtens Pty
Mol sive Prnting -
lmm-r s FMDFE“H .Jl
Lemer 8 575177 216 20375 4mm T .|
sy 00 R 000
] Duupeng Prirting
L Long-side staphng (Left) - Spacy Margn
ik
! | Pt from Linat Pager
Ol

[on ][ Concel [ dpete [ Hew |

3. Select the paper size for the data

Using Page Size, select the page size that was set with your application.

4. Set the scaling rate by using one of the following methods:
e Select a Printer Paper Size
Select a printer paper size, which is different from the Page Size, from the Printer Paper Size list.

If the printer paper size is smaller than the Page Size, the page image will be reduced. If the
printer paper size is larger than the page size, the page image will be enlarged.
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e Specify a scaling factor
Directly type in a value into the Scaling box.
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The current settings are displayed in the Settings Preview on the left side of the printer driver.

5. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.

!3 Important
= |f the application software with which you created the original has the scaled printing function,
configure the settings on your application software. You do not need to also configure the same

setting in the printer driver.
= When Scaled Printing is selected, the Staple Side list box appears grayed out and is unavailable

(when Duplex Printing is not selected).
= When Borderless Printing check box is checked, Scaled Printing cannot be selected.

Note

= Selecting Scaled Printing changes the printable area.
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Page Layout Printing

The page layout printing function allows you to print more than one page image on a single sheet of
paper.

The procedure for performing page layout printing is as follows:
1. Open the printer driver setup window

2. Set page layout printing

Select Page Layout Printing from the Page Layout list on the Page Setup tab.
The current settings are displayed in the Settings Preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
Now you have finished setting the layout of the document from left to right.

4. Set the number of pages to be printed on one sheet and the page sequence

If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, and
click OK.
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Pages
To increase the number of pages to be included on a single sheet of paper, select a desired
number of pages from the list.

Page Order
To change the page arrangement order, select an icon from the list to change the page placement
order.

Page Border
To print a page border around each document page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in
the specified order.

\‘ Important

When Borderless Printing check box is checked, Page Layout Printing cannot be selected.
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Poster Printing

The poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. When the pages are pasted together, they form a large print
like a poster.

S

The procedure for performing poster printing is as follows:

Setting Poster Printing
1. Open the printer driver setup window
2. Set poster printing

Select Poster Printing from the Page Layout list on the Page Setup tab.
The current settings are displayed in the Settings Preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
Now you have finished setting 2 by 2-page poster printing.

4. Set the number of image divisions and the pages to be printed.

If necessary, click Specify..., specify the following settings in the Poster Printing dialog box, and then
click OK.
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Image Divisions

Select the number of divisions (vertical x horizontal) from the Image Divisions list. As the number of
divisions increases, the number of sheets used for printing increases, allowing you to create a
larger poster.

Print "Cut/Paste" in margins
To leave out words "Cut" and "Paste", uncheck this check box.

\‘ Important

This feature is unavailable when the 64-bit printer driver is used.

Print "Cut/Paste" lines in margins
To leave out cut lines, uncheck this check box.

Pages
To reprint only specific pages, enter the page number you want to print. To print multiple pages,
specify by separating the pages with commas or entering a hyphen between the page numbers.

EEI Note

You can also specify the print range by clicking the pages in the setup preview.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document will be divided into several pages during printing.
After all poster pages have been printed, paste the pages together to create a poster.

Printing Only Specific Pages

If ink becomes faint or runs out during printing, you can print the pages you still need, by following the
procedure below:

1. Set the print range

In the Settings Preview on the left of the Page Setup tab, click the pages that do not need to be
printed.
The pages that were clicked are deleted, and only the pages to be printed are displayed.
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Note

= Click the deleted pages to display them again.
= Right-click the Settings Preview to select Print all pages or Delete all pages.

2. Complete the setup

After completing the page selection, click OK.
When you execute print, only specified pages will be printed.

\.‘ Important
= When Poster Printing is selected, the Duplex Printing and Print from Last Page check boxes and the
Staple Side list box appear grayed out and are unavailable.
= When Borderless Printing check box is checked, Poster Printing cannot be selected.
= Since poster printing enlarges the document when printing it, the print results may become coarse.
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Booklet Printing

The booklet printing function allows you to print data for a booklet. Data is printed on both sides of the
paper. This type of printing ensures that pages can be collated properly, in page number order, when the
printed sheets are folded and stapled at the center.

‘--'3
The procedure for performing booklet printing is as follows:

1. Open the printer driver setup window

2. Set booklet printing

Select Booklet Printing from the Page Layout list on the Page Setup tab.
The current settings are displayed in the Settings Preview on the left side of the window.
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3. Select the print paper size
Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the margin for stapling and the margin width
Click Specify..., specify the following settings in the Booklet Printing dialog box, and then click OK.
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Margin for stapling
Select which side the stapling margin should be on when the booklet is completed.
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Insert blank page
To leave one side of a sheet blank, check Insert blank page check box, and select the page to be left
blank.

Margin
Enter the margin width. The specified width from the center of the sheet becomes the margin for one
page.

Page Border
To print a page border around each document page, check the Page Border check box.

5. Complete the setup
Click OK on the Page Setup tab.

When you execute print, the document will be printed on one side of a sheet of paper. When the
printing of one side is complete, set the paper correctly by following the message and click OK.
When the printing of the other side is complete, fold the paper at the center of the margin and make
a booklet.

\‘ Important

Booklet Printing is unavailable when:

A media type other than Plain Paper is selected from the Media Type list.

Borderless Printing check box is checked.
When Booklet Printing is selected, Duplex Printing, Staple Side, Print from Last Page, and Collate
appear grayed out and are unavailable.

E.j Note

The stamp and background are not printed on blank sheets inserted with the Insert blank page
function of Booklet Printing.
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Duplex Printing

The procedure for printing data on both sides of a sheet of paper is as follows:

1. Open the printer driver setup window

2. Set duplex printing

T TRT I i m

Check the Duplex Printing check box on the Page Setup tab.
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. Select the layout

Select Normal-size Printing (or Fit-to-Page Printing, Scaled Printing, or Page Layout Printing) from
the Page Layout list.

. Specify the side to be stapled

The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
Staple Side. If you want to change the setting, select another value from the list.

. Set the margin width
If necessary, click Specify Margin... and set the width of the stapling margin, and then click OK.

. Complete the setup
Click OK on the Page Setup tab.

When you execute print, the document will be printed on one side of a sheet of paper. When the
printing of one side is complete, set the paper correctly by following the message and click OK. The
document will be printed on the opposite side.

!3 Important
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Duplex Printing is unavailable when:

A media type other than Plain Paper is selected from the Media Type list.

Poster Printing is selected from the Page Layout list.
When Booklet Printing is selected from the Page Layout list, Duplex Printing and Staple Side
appear grayed out and are unavailable.

<=1 Note
If the Media Type dialog box appears when performing borderless printing during duplex printing,
select Plain Paper.
If the back side of the paper becomes smudged during duplex printing, perform Bottom Plate
Cleaning in the Maintenance tab.
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Stamp/Background Printing

This feature is unavailable when the 64-bit printer driver is used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. The
Background function allows you to print a light illustration behind the document data.

The procedure for performing stamp/background printing is as follows:

Printing a stamp
"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab
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3. Select a stamp

Check the Stamp check box, and select a desired stamp from the list.
The current settings are displayed in the Settings Preview on the left side of the Page Setup tab.

4. Set the stamp details
If necessary, complete the following settings, and then click OK.

Place stamp over text
To print the stamp on the front of the document, check this check box.
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E.j Note

The stamp is given priority because the stamp is printed over the document data in the
sections where the stamp and the document data overlap. If the Place stamp over text check
box is unchecked, the stamp is printed behind the document data and may be hidden in the
overlapping sections depending on the application used.

Stamp first page only
To print the stamp only on the first page, check this check box.

Define Stamp... button
To change the stamp text, bitmap, or position, click this (refer to Saving a Stamp Setting).

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified stamp.

Printing a background

1. Select the background for which the settings are to be changed

Two bitmap files are pre-registered as samples.

2. Click Stamp/Background... on the Page Setup tab
The Stamp/Background dialog box opens.

3. Select the background

Check the Background check box, and select a desired background from the list.
The current settings are displayed in the Settings Preview on the left side of the Page Setup tab.

4. Set the background details
If necessary, complete the following settings, and then click OK.

Background first page only
To print the background only on the first page, check this check box.

Select Background... button
To use another bitmap file or change the layout or density of a background, click this (refer to Saving
Image Data to be Used as a Background ).

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified background.

\‘ Important

When the Borderless Printing check box is checked, the Stamp/Background... button appears
grayed out and is unavailable.

E.j Note

The stamp and background are not printed on blank sheets inserted with the Insert blank page
function of Booklet Printing.

Related Topics
Saving a Stamp Setting

Saving Image Data to be Used as a Background
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Saving a Stamp Setting

This feature is unavailable when the 64-bit printer driver is used.

You can create and save a new stamp. You can also change and register some of the settings of an
existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:
Registering a new stamp
1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab
W
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3. Click Define Stamp...
The Stamp Settings dialog box opens.
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Configure the stamp while viewing the preview window
e Stamp tab

Select Text or Bitmap with Stamp Type.

When registering a text, the characters must already be entered in Stamp Text. Change the True
Type Font, Style, Size, and Outline settings, as necessary. You can select the color of the stamp
by clicking Select Color....

For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. Change the settings
of the Size and Transparent white area if necessary.

e Placement tab

Select the stamp position from the Position list. You can also select Custom from the Position
list and specify coordinates for X-Position and Y-Position.

You can also change the stamp position by dragging the stamp in the preview window.

To change the stamp position angle, type a value in the Orientation box directly.

Save the stamp

Click the Save settings tab and enter a new stamp title in the Title box, and then click Save.
Click OK when the confirmation message appears.

Complete the setup

Click OK. The Stamp/Background dialog box opens again.
The registered title appears in the Stamp list.

Changing and registering some of stamp settings

1.

Select the stamp for which the settings are to be changed

Check the Stamp check box in the Stamp/Background dialog box, and then select the title of the
stamp to be changed from the Stamp list.

Click Define Stamp...
The Stamp Settings dialog box opens.

Configure the stamp while viewing the preview window

Save the stamp

Click Save overwrite on the Save settings tab.
If you want to save the stamp with a different title, type a new title in the Title box and click Save.
Click OK when the confirmation message appears.

. Complete the setup

C1p. 204 n3 334 cTp.
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Click OK. The Stamp/Background dialog box opens again.
The registered title appears in the Stamp list.

Deleting an unnecessary stamp

1. Click Define Stamp... in the Stamp/Background dialog box
The Stamp Settings dialog box opens.

2. Select the stamp to be deleted

Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Then
click Delete.
Click OK when the confirmation message appears.

3. Complete the setup
Click OK. The Stamp/Background dialog box opens again.
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Saving Image Data to be Used as a Background

This feature is unavailable when the 64-bit printer driver is used.

You can select a bitmap file and save it as a new background. You can also change and register some
of the settings of an existing background. An unnecessary background can be deleted at any time.

The procedure for registering image data to be used as a background is as follows:

Registering image data to be used as a background

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab
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The Stamp/Background dialog box opens.
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3. Click Select Background...
The Background Settings dialog box opens.
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4. Select the image data to be registered to the background
Click Select File.... Select the target image data (bitmap file), and then click Open.

5. Specify the following settings while viewing the preview window

Layout Method

Select how the background image data is to be placed.

When Custom is selected, you can set coordinates for X-Position and Y-Position.

You can also change the background position by dragging the image in the preview window.

Intensity

Set the intensity of the background image data with the Intensity slider. To lighten the background,
move the slider to the left. To darken the background, move the slider to the right. To print the
background at the original bitmap intensity, move the slider to the rightmost position.

6. Save the background

Click the Save settings tab and enter a new stamp title in the Title box, and then click Save.
Click OK when the confirmation message appears.

7. Complete the setup

Click OK. The Stamp/Background dialog box opens again.
The registered title appears in the Background list.

Changing and saving some background settings

1. Select the background for which the settings are to be changed

Check the Background check box in the Stamp/Background dialog box, and then select the title of
the background you want to change from the Background list.

2. Click Select Background...
The Background Settings dialog box opens.

3. While viewing the preview, set the items on the Background tab

4. Save the background

Click Save overwrite on the Save settings tab. If you want to save the background with a different title,
type a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK. The Stamp/Background dialog box opens again.
The registered title appears in the Background list.



Saving Image Data to be Used as a Background C1p. 208 n3 334 cTp.

Deleting an unnecessary background

1. Click Select Background... in the Stamp/Background dialog box
The Background Settings dialog box opens.

2. Select the background to be deleted

Select the title of the background you want to delete from the Backgrounds list on the Save settings
tab, and then click Delete.
Click OK when the confirmation message appears.

3. Complete the setup
Click OK. The Stamp/Background dialog box opens again.
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Printing an Envelope

For details on how to load an envelope into the machine, refer to the "Loading Envelopes" in the manual:
Basic Guide.

The procedure for performing envelope printing is as follows:

1. Load an envelop into the printer

Fold down the envelope flap.
Orient the envelope so that the flap is on the left and the folded surface is facing down.

<C

2. Open the printer driver setup window

3. Select the media type
Select Envelope from the Media Type list on the Main tab.
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4. Select the paper size
Click the Page Setup tab, and select Youkei 4, Youkei 6, Comm.Env. #10, or DL Env. for Page Size.

5. Select the landscape for orientation

To print the addressee horizontally, select Landscape for Orientation.

6. Complete the setup

Click OK.
When you execute print, the information is printed on the envelope.
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Displaying the Print Results before Printing

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

1. Open the printer driver setup window

2. Set the preview
Check the Preview before printing check box on the Main tab.
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3. Complete the setup

Click OK.
The Canon IJ Preview will start and the print result will be displayed before printing.

Related Topic
=} Canon |J Preview
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Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper if its size cannot be selected in Page Size. Such a paper
size is called a custom size.

The procedure for specifying a custom size is as follows:

1. Set the custom size in the application software

On your application's paper size feature, specify your custom size.

\‘ Important

= If the application software that created the document has a function for specifying the height
and width values, use the application software to set the values. If the application software
does not have such a function or if the document does not print correctly, use the printer driver
to set the values.

2. Open the printer driver setup window

3. Select the paper size

Select Custom... for Page Size on the Page Setup tab.
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The Custom Paper Size dialog box opens.
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4. Set the custom size in the application software
Specify Units, and enter the Width and Height of the paper to be used. Then click OK.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.
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Changing the Print Quality and Correcting Image Data

= Selecting a Combination of the Print Quality Level and a Halftoning Method
= Printing a Color Document in Monochrome

= Specifying Color Correction

= Optimal Photo Printing of Image Data

= Adjusting Colors with the Printer Driver

= Printing with ICC Profiles

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast

= Simulating an lllustration

= Representing Image Data with a Single Color

= Presenting Image Data with Vivid Colors

= Smoothing Jagged Outlines

=+ Changing Color Properties to Improve Coloration
= Reducing Photo Noise
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Selecting a Combination of the Print Quality Level and a
Halftoning Method

You can set the print quality level and the halftoning method.

The procedure for setting the print quality level and the halftoning method is as follows:
1. Open the printer driver setup window

2. Select the print quality
Select Custom for Print Quality on the Main tab, and click Set....
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3. Setting the print quality and halftone expression method

Move the Quality slider to select the quality level.
Select Halftoning and click OK.

Note
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Halftones refer to color shades between the darkest color and the brightest color.

The printer replaces the color shades with a collection of small dots to express the halftones.
Dither arranges the dots according to fixed rules to express the halftones. Diffusion places the
dots randomly to express the halftones. When you select Auto, the data is printed with the
optimal halftoning method for the selected print quality.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed with the specified quality level and halftoning method.

\‘ Important

Certain print quality levels and halftoning methods cannot be selected depending on the settings of
Media Type.

=F Note
When the part of the object is not printed, selecting Diffusion for Halftoning may solve the problem.

Related Topics
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:
1. Open the printer driver setup window

2. Set grayscale printing

Check the Grayscale Printing check box on the Main tab.
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3. Complete the setup

Click OK.

When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

\‘ Important

= When the Grayscale Printing check box is checked, the printer driver processes image data as
sRGB data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sSRGB data
using an application software.

Note

= During Grayscale Printing, color inks may be used as well as black ink.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printed
with color tints that most people prefer. This method is suitable for printing sSRGB data.

If you want to print by using the color space of SRGB or Adobe RGB data effectively, select ICM. If you
want to use an application software to specify an ICC profile, select None.

The procedure for specifying color correction is as follows:
1. Open the printer driver setup window

2. Select the manual color adjustment
On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, select Color Correction setting suited to your purpose from the following, and
click OK.
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Driver Matching
By using Canon Digital Photo Color, you can print SRGB data with color tints that most people prefer.

Driver Matching is the default setting for Color Correction.

ICM
You can print by using the color space of sSRGB or Adobe RGB data effectively.

None

The printer driver does not perform color adjustment. Select this value if you are specifying an

individually created profile or a profile for special Canon paper in an application software to print
data.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed with the specified color adjustment method.

\‘ Important

= [f ICM is disabled in the application software, ICM is unavailable for Color Correction and the printer
may not be able to print the image data properly.

= When the Grayscale Printing check box on the Main tab is checked, Color Correction appears
grayed out and is unavailable.

Related Topics
Optimal Photo Printing of Image Data
Adjusting Colors with the Printer Driver
Printing with ICC Profiles
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones
differ from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing
method that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space. For Windows, a color management system called "ICM" is built into the operating system.

sRGB and Adobe RGB are popularly used as common color spaces. Adobe RGB has a wider color
space than sRGB.

ICC profiles convert device-dependent "colors" into a common color space.
By using an ICC profile and carrying out color management, you can draw out the color space of the
image data within the color reproduction area that the printer can express.

Selecting a printing method suited to the image data

The recommended printing method depends on the color space (Adobe RGB or sRGB) of the image
data or the application software to be used. There are two typical printing methods. Check the color
space (Adobe RGB or sRGB) of the image data and the application software to be used, and then select
the printing method suited to your purpose.

e To print using Canon Digital Photo Color

Target data: sRGB data

Printing method: Adjusting Colors with the Printer Driver
e To print using the color space of the data effectively

Target data: Adobe RGB data or sRGB data
Application software: An ICC profile can or cannot be specified.
Printing method: Printing with ICC Profiles
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Adjusting Colors with the Printer Driver

You can specify the color correction function of the printer driver to print SRGB data with color tints that
most people prefer (through the use of Canon Digital Photo Color).

The procedure for adjusting colors with the printer driver is as follows:
1. Open the printer driver setup window

2. Select the media type
Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the print quality
Select High, Standard, or Fast for Print Quality.

4. Select the manual color adjustment

Select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

5. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.
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6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.

Related Topics

= Selecting a Combination of the Print Quality Level and a Halftoning Method
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast

Page top



Printing with ICC Profiles C1p. 222 n3 334 cT1p.

Adyanced Ginde’

Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality and
Correcting Image Data > Specifying Color Correction > Printing with ICC Profiles

Printing with ICC Profiles

If the image data has a specified ICC profile, you can effectively use the color space (Adobe RGB or
sRGB) of the data when printing.

The printer driver setting procedure varies depending on the application software used to print.

Printing image data from the application software that can specify an ICC profile

When using Adobe Photoshop, Canon Digital Photo Professional, or any other application software that
allows you to specify an ICC profile, you can use the color management system (ICM) found in Windows
when printing the data. You can print the editing and touch-up results of an application software by
effectively using the color space of the ICC profile specified in the image data.

To use this printing method, you must first use an application software to specify an ICC profile in the
image data. For instructions on specifying an ICC profile with an application software program, refer to
the manual of the application software you are using.

1. Open the printer driver setup window

2. Select the media type
Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the print quality
Select High, Standard, or Fast for Print Quality.

4. Select the manual color adjustment

Select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

5. Select color correction
Click Matching tab, and select ICM for Color Correction.
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6. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

7. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

\‘ Important

Ctp. 223 n3 334 cTp.

= |f you print an image by specifying an individually created profile or a profile for special Canon paper
in an application software, select None from the Color Correction menu of the printer driver.

Printing image data from the application software that cannot specify an ICC profile

When printing from an application software that does not allow you to specify an ICC profile, specify the
ICC profile in the print settings of the printer driver and print the data. When printing Adobe RGB data, you

can print the data with the Adobe RGB color space even if the application software does not support
Adobe RGB.

1. Open the printer driver setup window

2. Select the media type
Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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Printing with ICC Profiles

3. Select the print quality
Select High, Standard, or Fast for Print Quality.

4. Select the manual color adjustment

Select Manual for Color/Intensity, and click Set....
Manual Color Adjustment dialog box opens.

5. Select color correction
Click Matching tab, and select ICM for Color Correction.
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6. Select the input profile
Select an Input Profile that matches the color space of the image data.
e For sRGB data or data without an ICC profile:
Select Standard.
e For Adobe RGB data:
Select Adobe RGB (1998).

\‘ Important
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If the application software specifies an input profile, the input profile setting of the printer driver
becomes invalid.

If no ICC profiles are installed on your computer, Adobe RGB (1998) is not displayed. You can
install ICC profiles from the Setup CD-ROM that accompanies the printer.

7. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

8. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed with the color space of the selected image data.

Related Topics
Selecting a Combination of the Print Quality Level and a Halftoning Method
Specifying Color Correction
Adjusting Color Balance
Adjusting Brightness
Adjusting Intensity
Adjusting Contrast
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Adjusting Color Balance

You can adjust the color tints during printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software if you want to change the color
balance significantly. Use the printer driver only if you want to adjust the color balance slightly.

The following sample shows the case when Color Balance is used to intensify cyan and to diminish
yellow so that the overall colors are more uniform.

No adjustment Adjusted in Color Balance

The procedure for adjusting color balance is as follows:
1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Adjust color balance

There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the
corresponding slider is moved to the right, and becomes weaker when the corresponding slider is
moved to the left. For example, if cyan becomes weaker, the color red becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

!3 Important

= When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellow
appear grayed out and are unavailable.

Related Topics

= Selecting a Combination of the Print Quality Level and a Halftoning Method
= Specifying Color Correction

= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast
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Adjusting Brightness

You can change the brightness of the overall image data during printing.

This function does not change pure white or pure black but it changes the brightness of the intermediate
colors.

The following sample shows the print result when the Brightness specification is changed.

Light is selected Normal is selected Dark is selected

The procedure for adjusting brightness is as follows:
1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Specify the brightness
Select Light, Normal, or Dark for Brightness, and click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the specified brightness.

Related Topics

=) Selecting a Combination of the Print Quality Level and a Halftoning Method
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Intensity

= Adjusting Contrast
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Adjusting Intensity

You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.

If you want to sharpen the print results, you should intensify the colors.

The following sample shows the case when the intensity is increased so that all colors become more
intense when the image data is printed.

No adjustment Higher Intensity

The procedure for adjusting intensity is as follows:
1. Open the printer driver setup window

2. Select the manual color adjustment

Select Manual for Color/Intensity on the Main tab, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Adjust intensity

Moving the Intensity slider to the right intensifies (darkens) the colors. Moving the slider to the left
dilutes (brightens) the colors.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
After adjusting each color, click OK.
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\‘ Important
= Adjust the slider gradually.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the adjusted intensity.

Related Topics

= Selecting a Combination of the Print Quality Level and a Halftoning Method
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Contrast
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Adjusting Contrast

You can adjust the image contrast during printing.

To make the differences between the light and dark portions of images greater and more distinct,
increase the contrast. On the other hand, to make the differences between the light and dark portions of
images smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:
1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Adjust the contrast

Moving the Contrast slider to the right increases the contrast, and moving it to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics

=) Selecting a Combination of the Print Quality Level and a Halftoning Method
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness

=+ Adjusting Intensity
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Simulating an Illustration

With the Simulate lllustration function, you can print full-color or 256-color image data so that it looks like
a hand-drawn illustration. You can add different effects to the original profile and colors.

The procedure for performing Simulate lllustration is as follows:
1. Open the printer driver setup window

2. Set the Simulate lllustration

Check the Simulate lllustration check box on the Effects tab, and adjust the Contrast as necessary.
Moving the slider to the right lightens the image data and moving the slider to the left darkens the
image data.

The current settings are displayed in the Settings Preview on the left side of the printer driver.
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3. Complete the setup

Click OK.
When you execute print, the image will be printed so that it looks hand-drawn.
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Representing Image Data with a Single Color

With the Monochrome Effects function, you can benefit from coloring effects such as changing a
photograph to a sepia tone image.

The procedure for performing Monochrome Effects is as follows:
1. Open the printer driver setup window

2. Set Monochrome Effects

Check the Monochrome Effects check box on the Effects tab and select your desired color.
If you use Select Color, move the Color slider to specify the color you want.
The current settings are displayed in the Settings Preview on the left side of the printer driver.
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3. Complete the setup

Click OK.
When you execute print, the image will be printed with a single color.

\.‘ Important

= When the Grayscale Printing check box on the Main tab is checked, Monochrome Effects appears
grayed out and is unavailable.
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Presenting Image Data with Vivid Colors

The Vivid Photo function allows you to print image data with vivid colors.

The notable feature of Vivid Photo is that it emphasizes the colors in background sceneries while
maintaining the human skin color natural. By using this function, you can make vivid hues appear even
more vivid.

The procedure for performing Vivid Photo is as follows:
1. Open the printer driver setup window

2. Set Vivid Photo
Check the Vivid Photo check box on the Effects tab.
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3. Complete the setup

Click OK.
When you execute print, the image will be printed with vivid colors.
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Smoothing Jagged Outlines

The Image Optimizer function allows you to smooth jagged outlines in photos and graphics that have
been enlarged with your application. This feature is especially useful when printing low-resolution
images from Web pages.

The procedure for performing Image Optimizer is as follows:

1. Open the printer driver setup window

2. Perform Image Optimizer
Check the Image Optimizer check box on the Effects tab.
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3. Complete the setup

Click OK.
The photos and graphics will be printed with jagged outlines smoothed.

Note

= Depending on application software or resolution of image data, the Image Optimizer may have no
discernible effects.
= It may take longer to complete printing if the Image Optimizer is used.
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Changing Color Properties to Improve Coloration

The Photo Optimizer PRO function corrects colors of digital camera images or scanned images. It is
specially designed to compensate for color shift, overexposure, and underexposure.

The procedure for performing Photo Optimizer PRO is as follows:
1. Open the printer driver setup window

2. Set the Auto Photo mode
Check the Photo Optimizer PRO check box on the Effects tab.
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Normally there is no need to check the Apply Throughout Page check box.
Images within each page are optimized on an image-by-image basis.

Note

= Check the Apply Throughout Page check box when printing image data that has been
processed, such as being cropped or rotated. In this case the entire page will be treated as a
single image to be optimized.

3. Complete the setup

Click OK.
When you execute print, the images will be printed with color compensation.

\.‘ Important

= Photo Optimizer PRO does not function when:
* Background is set in the Stamp/Background dialog box on the Page Setup tab.
* Define Stamp... is selected in the Stamp/Background dialog box on the Page Setup tab, and the
bitmapped stamp is configured.
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= Note

Depending on images, the Photo Optimizer PRO may have no discernible effect.
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Reducing Photo Noise

With the Photo Noise Reduction function, you can reduce the digital camera noise and improve the
image quality of the digital print.

The procedure for performing Photo Noise Reduction is as follows:
1. Open the printer driver setup window
2. Set Photo Noise Reduction

Check the Photo Noise Reduction check box on the Effects tab and select Normal or Strong for the
level.

3. Complete the setup

Click OK.
When you execute print, the image will be printed with the digital camera noise being reduced.

Note

= |tis recommended to select Normal for most cases. Select Strong if you have selected Normal and
the noise still bothers you.

= Depending on application software or resolution of image data, effects of digital camera noise
reduction may not be obvious.

= When this function is used for other than photos taken by digital cameras, image may be distorted.
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Overview of the Printer Driver

= Canon |J Printer Driver

= How to Open the Printer Driver Setup Window
= Maintenance Tab

= Canon |J Status Monitor

= The Canon IJ Preview

Page top



Canon |J Printer Driver C1p. 242 n3 334 cTp.

Adyanced Ginde’

Advanced Guide > Printing from a Computer > Printing with Other Application Software > Overview of the Printer Driver
> Canon |J Printer Driver

Canon |J Printer Driver

The Canon |J printer driver is software that is installed on your computer for printing data on this printer.

The Canon IJ printer driver converts the print data created by your Windows application into data that your
printer can understand and sends the converted data to the printer.

Because the format of print data varies depending on the your model, you need to have a Canon IJ
printer driver for the specific model you are using.

How to Use Help
You can display the Help describing the driver setting items through the Printing Preferences screen of
the Canon |J printer driver.

e To view all descriptions of atab...

Click the Help button on each tab.
A description for each item on the tab appears.
You can also display a description for a dialog box by clicking the link that appears on the
corresponding tab.
e To see a description for each item...
Right-click the item you want to learn about and then click the Help button.

Alternatively, click [Help] button at the right end of the title bar and then click the item you want
to learn about.
A description of the item is displayed.

Related Topic
How to Open the Printer Driver Setup Window
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How to Open the Printer Driver Setup Window

The printer driver setup window can be displayed through the application software in use or the Start
menu of the Windows.

E.j Note
This guide mainly describes operations on the Windows Vista. Operations may differ depending on
versions of the Windows.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure print settings when printing.

1. Select the command you perform printing on the application software in use

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)
The printer driver setup window appears.

E.j Note

Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

Open the Printer Driver Setup Window through the Start Menu

Follow the procedure below to perform maintenance operations such as print head cleaning, or to
configure print settings that are common for all application software.

1. Select items from the Start menu as shown below:

e |n Windows Vista, select the Start menu -> Control Panel -> Hardware and Sound -> Printers.
e In Windows XP, select the Start menu -> Control Panel -> Printers and Other Hardware ->

Printers and Faxes.
e |In Windows 2000, select the Start menu -> Settings -> Printers.

2. Right-click your model name icon, and then select Printing Preferences from the
displayed menu.
The printer driver setup window appears.

\F Important

Opening the printer driver setup window through Properties displays such tabs regarding the
Windows functions as the Ports (or Advanced) tab. Those tabs do not appear when opening
through Printing Preferences or application software. About tabs regarding Windows functions,
refer to the user's manual for the Windows.
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Maintenance Tab

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.
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Features

= Cleaning the Print Heads

= Cleaning the Paper Feed Rollers
= Aligning the Print Head Position
= Checking the Print Head Nozzles
= Cleaning Inside the Printer

= Setting the Ink Cartridge

= Managing the Printer Power

Related features
= Reducing the Printer Noise/Quiet Mode
= Changing the Printer Operation Mode
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Canon |J Status Monitor

The Canon |J Status Monitor is an application software that shows the status of the printer and the
progress of printing on the Windows screen. You will know the status of the printer with graphics, icons,
and messages.

Launching the Canon IJ Status Monitor

The Canon |J Status Monitor launches automatically when data is sent to the printer. When launched, the
Canon IJ Status Monitor appears as a button on the Task Bar.
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Note

= To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup
window and click View Printer Status... on the Maintenance tab.

When Errors Occur

The Canon IJ Status Monitor is automatically displayed when an error occurs (e.g., if the printer runs out
of paper or if the ink is low).
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In such cases, take the appropriate action as described.
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The Canon |IJ Preview

The Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print sequence, and number of pages. You can also change the media type settings.

If you want to display a preview before printing, open the printer driver setup window, click the Main tab,
and check the Preview before printing check box.

If you do not want to display a preview before printing, uncheck the check box.

Related Topic
Displaying the Print Results before Printing
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Maintenance

= Cleaning Your Printer
= Performing Maintenance from a Computer
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Cleaning Your Printer

= Cleaning
= Cleaning the Exterior of the Printer
= Cleaning the Protrusions Inside the Printer
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Cleaning

This section describes the cleaning procedure that is needed to maintain your printer.

Acaution

Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as
not to scratch the surface. Paper tissue powder or fine threads may remain inside the printer and
cause problems such as Print Head blockage and poor printing results. Be sure to use a soft cloth.
Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to
clean the printer, as this may cause a malfunction or damage the printer's surface.

Cleaning the Exterior of the Printer
Cleaning the Protrusions Inside the Printer
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Cleaning the Exterior of the Printer

Be sure to use a soft cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently.
Smooth out wrinkles on the cloth if necessary before cleaning.

Acaution

Be sure to turn off the power and disconnect the power plug before cleaning the printer.
Do not use tissue paper, paper towels, rough-textured cloth, or similar materials, as this may

scratch the surface.
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Cleaning the Protrusions Inside the Printer

If protrusions inside the printer are stained, wipe off any ink from the protrusions using a cotton swab or
the like.

Acaution

= Be sure to turn off the power and disconnect the power plug before cleaning the printer.
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Performing Maintenance from a Computer

= Cleaning the Print Heads
= Cleaning the Paper Feed Rollers
= Aligning the Print Head Position
= Checking the Print Head Nozzles
= Cleaning Inside the Printer
Page top #
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Cleaning the Print Heads

The print head cleaning function allows you to remove any blockages in the print head nozzles. Perform
print head cleaning if printing is faint or a specific color fails to print, even though there is enough ink.

The procedure for cleaning the print heads is as follows:

Cleaning
1. Open the printer driver setup window

2. Make sure that the printer is on and then click Cleaning on the Maintenance tab

Print head cleaning starts.

3. Complete cleaning

Click OK when the confirmation message appears.
Next, the Nozzle Check dialog box opens.

4. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

If cleaning the head once does not resolve the print head problem, clean it once more.

Deep Cleaning

Deep Cleaning is more thorough than Cleaning. Perform deep cleaning when two cleaning attempts do
not resolve the print head problem.

1. Open the printer driver setup window

2. Click Deep Cleaning on the Maintenance tab

The Deep Cleaning dialog box opens. Follow the instruction shown in the dialog box.
Click Initial Check Items to display the items you need to check before performing Deep Cleaning.

3. Make sure that the printer is on and then click Execute.

Click OK when the confirmation message appears.
Print head deep cleaning starts.

\‘ Important

Cleaning consumes a small amount of ink. Deep Cleaning consumes a larger amount of ink than
Cleaning.

Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Consequently,
perform cleaning only when necessary.

E.j Note
If there is no sign of improvement after Deep Cleaning, switch off the printer and perform again. If

there is still no sign of improvement, the ink may have run out. For details on the remedial action to
be taken, see "Machine Moves But Ink Is Not Ejected.”
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Related Topic
Checking the Print Head Nozzles
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Cleaning the Paper Feed Rollers

The feed roller cleaning function allows you to clean the paper feed roller. Perform feed roller cleaning
when there are paper particles sticking to the paper feed roller and paper is not fed properly.

The procedure for cleaning the feed rollers is as follows:

g

Roller cleaning

1. Prepare the printer

Remove all sheets of paper from the rear tray.
2. Open the printer driver setup window

3. Click Roller Cleaning on the Maintenance tab

The confirmation message appears.

4. Execute paper feed roller cleaning

Make sure that the printer is on and click OK.
Paper feed roller cleaning starts.

5. Complete paper feed roller cleaning

After the rollers have stopped, follow the instruction in the message, load three sheets of plain
paper into the rear tray, and click OK.

Paper will be ejected and feed roller cleaning will be completed.
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Aligning the Print Head Position

Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.

The procedure for performing print head alignment is as follows:

Print Head Alignment
1. Open the printer driver setup window

2. Click Print Head Alignment on the Maintenance tab

A message appears.

3. Load paper in the printer

Set the paper thickness lever to the left, and load a sheet of A4 size or Letter size plain paper into the
rear tray.

4. Execute head alignment

Follow the instruction in the message.
The Print Head Alignment dialog box opens.

5. Check the printed pattern

Enter the numbers of the patterns with the least amount of streaks in the associated boxes.
Clicking the patterns with the least amount of streaks in the preview window, will automatically set
their numbers in the associated boxes.

When you have entered all the necessary values, click OK.

E.j Note

If you look at the print results and still cannot determine which pattern is the one with the least
amount of streaks, see your printer manual.
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Checking the Print Head Nozzles

The nozzle check function allows you to check whether the print heads are working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

Nozzle Check
1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.
To display a list of items that you should check before printing the check pattern, click Initial Check
ltems.

3. Load paper in the printer

Set the paper thickness lever to the left, and load a sheet of A4 size or Letter size plain paper into the
rear tray.

4. Print a nozzle check pattern

Make sure that the printer is on and click Print Check Pattern.
The nozzle check pattern is printed.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print result. If the print result is normal, click Exit.
If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print
head.

Related Topic
Cleaning the Print Heads
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Cleaning Inside the Printer

The bottom plate cleaning function allows you to prevent smudges on the reverse side of a sheet of
paper. Perform bottom plate cleaning before you perform duplex printing.

Also perform bottom plate cleaning if ink smudges caused by something other than print data appear on
the printed page.

The procedure for performing bottom plate cleaning is as follows:

1. Open the printer driver setup window

Bottom Plate Cleaning

2. Click Bottom Plate Cleaning on the Maintenance tab

The Bottom Plate Cleaning dialog box opens.

3. Load paper in the printer

As instructed in the dialog box, fold the A4 size or Letter size plain paper in half horizontally, and then
unfold the sheet.
Load the paper into the rear tray in the portrait orientation with the crest of the crease facing down.

4. Perform the bottom plate cleaning

Make sure that the printer is on and click Execute.
Bottom plate cleaning starts.
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Changing the Printer Settings

= Changing Printer Settings from Your Computer

Page top #
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Changing Printer Settings from Your Computer

= Changing the Print Options

= Saving a Changed Printing Profile

= Setting the Ink Cartridge

=+ Managing the Printer Power

= Reducing the Printer Noise

= Changing the Printer Operation Mode
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Changing the Print Options

You change detailed print driver settings for print data that is sent from an application software.
Specify this option if you encounter print failures such as part of an image data being cut off.

The procedure for changing the print options is as follows:
1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab
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3. Change the individual settings
If necessary, change the setting of each item, and then click OK.
The Page Setup tab is displayed again.
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Saving a Changed Printing Profile

You can assign a name to the settings made on the Main, Page Setup, and Effects tabs and save them
as a printing profile. The saved printing profile can be retrieved and used from the Profiles tab at any
time. Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:
Registering a printing profile
1. Open the printer driver setup window

2. Set the necessary items
Make your desired settings on the Main, Page Setup, and Effects tabs.

3. On the Profiles tab, click Add to Profiles...
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4. Save the settings

Set Name, Icon, and Description, then click OK.
The profile is saved and the Profiles tab is displayed again.
The name and icon are added to the Printing Profiles list.

Note

= |f you install the printer driver again or upgrade the version of the printer driver, the print settings you
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registered will be deleted from Printing Profiles.
Registered print settings cannot be saved and preserved. In this case, register the print settings
again.

Using registered print settings

1. Select the print settings to be used

Select a printing profile in the Printing Profiles list on the Profiles tab.
The parameters and settings of the profile are displayed in the Details box.

2. Retrieve from Profiles

Click Retrieve from Profiles.
Click OK when a message appears.
Settings of the selected profile are applied to the Main, Page Setup, and Effects tabs.

E.j Note
If you want to revert a profile to the default settings, select Default Settings in the Printing Profiles list
and click Retrieve from Profiles.

Deleting unnecessary printing profile

1. Select the printing profile to be deleted

Select the printing profile you want to delete from the Printing Profiles list on the Profiles tab.

2. Delete the printing profile

Click Delete. When the confirmation message appears, click OK.
The selected printing profile is deleted from the Printing Profiles list.

E.j Note

Current Settings and Default Settings cannot be deleted.
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Setting the Ink Cartridge

When printing, you can specify the ink cartridge you use.
If one of the ink cartridges becomes empty, you can continue printing by specifying the ink cartridge that
still has ink.

The procedure for specifying the ink cartridge is as follows:

Ink Cartridge Settings
1. Open the printer driver setup window

2. Click Ink Cartridge Settings on the Maintenance tab
The Ink Cartridge Settings dialog box appears.

3. Select the ink cartridge to be used

Select the ink cartridge to be used for printing and click OK.
The specified ink cartridge will be used from the next printing.

\F Important

When the following settings are configured, Black Only is disabled. The color ink cartridge is also

used to print.
A media type other than Plain Paper, Hagaki, or Envelope is selected for Media Type on the Main
tab.
Borderless Printing is checked on the Page Setup tab.
Canon recommends that you use the ink cartridges installed in the printer and not remove them
until the ink runs out.

Page top



Managing the Printer Power Ct1p. 265 13 334 cTp.

Advance ksinde
Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer > Managing the Printer
Power

Managing the Printer Power
This function allows you to manage the printer power from the printer driver.

The procedure for managing the printer power is as follows:

[+] |
Power Off

The Power Off function turns off the printer. If you use this function, you will not be able to turn the printer
on from the printer driver.

1. Open the printer driver setup window

2. Execute power off
Click Power Off on the Maintenance tab. When the confirmation message appears, click OK.

The printer power switches off, and the Maintenance tab is displayed again.
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Noise

Reducing the Printer Noise

This function allows you to reduce the operating noise of the printer. Select if you wish to reduce the
operating noise of the printer at night, etc.
Using this function may lower the print speed.

The

1.

2.

procedure for changing the quiet mode settings is as follows:

Quiet Mode
Open the printer driver setup window

Click Quiet Mode on the Maintenance tab
The Quiet Mode dialog box opens.

. Set the silent function

If necessary, specify one of the following items:

Do not use quiet mode
The operating noise of the printer is at normal volume.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode within specified time

The operating noise of the printer can be reduced during a specified period of time.

Set the Start time and End time when you wish the quiet mode to be activated.

\‘ Important

The time specified in Start time and in End time must be different.

Transmit the settings

Make sure that the printer is on and click Send.
Click OK when the confirmation message appears.

The selected settings are enabled hereafter.

Ej Note

Depending on print quality settings, effects of the quiet mode may be less.
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Changing the Printer Operation Mode
This function allows you to switch between various modes of printer operation.

The procedure for changing the printer settings is as follows:

° Custom Settings

1. Open the printer driver setup window

2. Make sure that the printer is on, and then click Custom Settings on the Maintenance
tab

The Custom Settings dialog box opens.

E.j Note

If the printer is off or bi-directional communication is disabled, a message may appear
because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Ink Drying Wait Time

You can set the length of the printer rest time until printing of the next page begins. Moving the slider
to the right increases the pause time and moving the slider to the left decreases the time.

If the paper gets stained because the next page is ejected before the ink on the printed page dries,
increase the ink drying wait time.

Reducing the ink drying wait time speeds up printing.

4. Transmit the settings
Click Send. When the confirmation message appears, click OK.
The printer runs in the changed mode hereafter.

Page top
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Troubleshooting

= If an Error Occurs

= The Printer Can Not Be Powered On

= Alarm Lamp Flashes Orange

= Power Lamp Flashes Green and Alarm Lamp Flashes Orange Alternately
= Cannot Install the Printer Driver

= Cannot Connect to Computer Properly

= Print Results Not Satisfactory

= Printing Does Not Start

= Printing Stops Before It Is Completed

= Printer Moves But Ink Is Not Ejected

= Printing Speed Not as Fast as Expected

= FINE Cartridge Holder Does Not Move to the Position for Replacing
= Paper Does Not Feed Properly

=} Paper Jams

= Message Appears on the Computer Screen

= For Windows Users

= FAQs

= If You Cannot Resolve the Problem

= Instructions for Use (Printer Driver)
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If an Error Occurs

When an error occurs in printing such as the printer is out of paper or paper is jammed, a
troubleshooting message is displayed automatically. Take the appropriate action described in the
message. The message may vary depending on the version of your operating system.

¢ |n Mac OS X v.10.5.x:

Printing ‘el
a Priniting
u.-d.... Error Rumber : 1000 No paper. Load the paper correctly and press the RESUME

button on the printer.

- Sranus | Rame (her { _
Prirsting e Fo—t DB/02/07 13:18

e |n Mac OS X v.10.4.x or Mac OS X v.10.3.9:

Error Number : 1000
) Mo paper. Load the paper correctly and press the
._1* RESUME button on the printer.

{ Delete job ) { StepAlijobs ) ( Stepjeb )
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The Printer Cannot Be Powered On

e Check 1: Press the Power button.

e Check 2: Make sure that the power plug is securely plugged into the

Power Cord Connector of the printer, then turn it back on.

e Check 3: Unplug the printer from the power supply, then plug the
printer back in and turn the printer back on after leaving it for at least 5

minutes.
If the problem is not resolved, contact your Canon service representative.
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Alarm Lamp Flashes Orange

When a printer error occurs, the Alarm lamp flashes orange as shown below. The number of flashes
indicates the type of error that has occurred. Count the flashes and take the appropriate action to correct

the error.

0@

(A)

(A) Note the number of flashes
(B) Flashes repeatedly

Number of flashes/Cause

Two flashes:
Printer is out of paper. /Paper does not
feed.

Three flashes:
Paper jam.

Four flashes:
Ink has run out.

Five flashes:
The FINE Cartridge cannot be
recognized.

Seven Flashes:
FINE Cartridge is not installed in the
correct position.

Eight flashes:
Ink absorber is almost full.

Fourteen Flashes:
The FINE Cartridge cannot be
recognized.

Fifteen Flashes:
The FINE Cartridge cannot be
recognized.

Sixteen Flashes:
Ink level cannot be detected.

®® 00— (B)

Reload paper on the Rear Tray and press the
RESUME/CANCEL button.

The paper may be jammed. Remove the jammed paper,
reload paper properly in the printer, and then press the
RESUME/CANCEL button.

Paper Jams

Ink has run out.

Replace the ink cartridge and close the cover.

If printing is in progress and you want to continue printing,
press the RESUME/CANCEL button for at least 5 seconds
with the ink cartridge installed. Then printing can continue
under the ink out condition.

The function for detecting the remaining ink level will be
disabled.

Replace the empty ink cartridge immediately after the
printing. The resulting print quality is not satisfactory, if
printing is continued under the ink out condition.

The FINE Cartridge may not be installed properly or it may
not be compatible with this printer.

Open the Front Cover and install the FINE Cartridge properly
or install the one compatible with this printer.

If the problem is not resolved, the FINE Cartridge may be
faulty. In this case, contact your Canon service
representative.

Make sure that each FINE Cartridge is installed in the correct
position.
Routine Maintenance

The ink absorber is becoming full.

The printer has a built-in ink absorber to hold the ink used
during Print Head Cleaning.

Press the RESUME/CANCEL button to cancel the error so you
can continue printing. Before the ink absorber becomes
completely full, contact a Canon service representative. (You
will need to replace a particular part of the printer.)

The FINE Cartridge may not be compatible with this printer.
Install the appropriate FINE Cartridge.
Routine Maintenance

The FINE Cartridge may not be installed properly or it may
not be compatible with this printer.
Install the appropriate FINE Cartridge.

Routine Maintenance

Ink may have run out.
The function for detecting the remaining ink level will be



Alarm Lamp Flashes Orange C1p. 272 n3 334 cTp.

disabled since the ink level cannot be correctly detected.

If you want to continue printing without this function, press
the RESUME/CANCEL button for at least 5 seconds.

Canon recommends to use new genuine Canon cartridges
in order to obtain optimum qualities.

Please be advised that Canon shall not be liable for any
malfunction or trouble caused by continuation of printing
under the ink out condition.
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Power Lamp Flashes Green and Alarm Lamp Flashes Orange
Alternately

A printer problem has occurred.

Disconnect the printer cable from the printer, turn the printer off, and then unplug the printer from the
power supply.

Plug the printer back in and turn the printer back on.
If the problem is not resolved, contact your Canon service representative.
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Cannot Install the Printer Driver
e If the installation does not start even after the Setup CD-ROM is inserted

into your computer's disc drive:

0

Start the installation following the procedure below.

1. Click Start then Computer.
In Windows XP, click Start then My Computer.

In Windows 2000, double-click the H My Computer icon on the desktop.

2. Double-click the "' CD-ROM icon on the displayed window.
If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.

&
acinto

Double-click the 'l CD-ROM icon on your desktop to start installation.
=l note
If the CD-ROM icon is not displayed, try the following:
Remove the CD-ROM from your computer, then insert it again.

Restart your computer.
If the icon is still not displayed, try different discs and see if they are displayed. If other discs are

displayed, there is a problem with the Setup CD-ROM. In this case, contact your Canon service
representative.

e If you are unable to proceed beyond the Printer Connection screen:

Printer Connection

ake sure that the pnnter 15 connectad to the computer, and tum on

the printer
STEP 3 1 2 9
i . .
Setup I.<
Primter Connaction
Print Head Alignmeart . i
Recammended A
Instalation Resulls r ,} 5 Ll ' =
STEP 4 = .
Information \3

¢ The printeris not detected. Check the
connechon

Help

Cancel. I

If you are unable to proceed beyond the Printer Connection screen, make sure that the USB cable is
securely plugged into the USB port of the printer and is connected to the computer, and then follow
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the procedure below to reinstall the printer driver.

Ej note

In Windows Vista, "The printer is not detected. Check the connection." may be displayed
depending on the computer you use. In this case, wait for a while. If you still cannot proceed to
the next step, follow the procedure below to reinstall the printer driver.

1. Click Cancel on the Printer Connection screen.

2. Click Start Over on the Installation Failure screen.

3. Click Back on the screen that appears next.

4. Click Exit on the PIXMA XXX screen, then remove the CD-ROM.
5. Turn the printer off.

6. Restart the computer.

7. Make sure that you have no application software running.

8. Follow the procedure described in your setup manual to reinstall the printer
driver.

¢ In other cases:

Follow the procedure described in your setup manual for proper installation.

If the driver was not installed correctly, uninstall the printer driver, restart your computer, then reinstall
the driver.

Uninstalling the Printer Driver

If you reinstall the printer driver, select Custom Install on the Setup CD-ROM.
E= note

If the installer was forced to be terminated due to a Windows error, the system may be in an
unstable condition and you may not be able to install the driver. Restart your computer before
reinstalling.
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Cannot Connect to Computer Properly

The Printer Is Not Recognized Properly

e Check 1: Is a USB hub used?
Connect the printer directly to the computer's USB port without using a hub.

000

e Check 2: Is the latest USB driver installed correctly?

Obtain the latest version of the USB driver and install it in your computer.

Page top
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Print Results Not Satisfactory

If the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm the
paper and print quality settings first.

e Check 1: Do the page size and media type settings match the size and

type of the loaded paper?

When these settings are incorrect, you cannot obtain a proper print result.

If you are printing a photograph or an illustration, incorrect paper type settings may reduce the quality
of the printout color.

Also, if you print with an incorrect paper type setting, the printed surface may be scratched.

In borderless printing, uneven coloring may occur depending on the combination of the paper type
setting and the loaded paper.

Confirm the page size and media type settings using the printer driver.
Printing with Easy Setup

e Check 2: Make sure that the appropriate print quality is selected

according to the media type and printing data using the printer driver.

Select a print quality option suitable for the paper and image for printing. If you notice blurs or uneven
colors, increase the print quality setting and try printing again.

Confirm the print quality setting using the printer driver.
Changing the Print Quality and Correcting Image Data

e Check 3: If the problem is not resolved, there may be other causes.

See also the sections below:
Cannot Print to End of Job
No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks
Colors Are Unclear
Lines Are Misaligned
Printed Paper Curls or Has Ink Blots
Paper Is Smudged/Printed Surface Is Scratched
Back of the Paper Is Smudged
Colors Are Uneven or Streaked

Page top -
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Cannot Print to End of Job

* Check 1: Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet. Then, select the Prevent loss of print data check box in
the displayed dialog.

e Check 2: Is the space of your computer's hard disk sufficient?

Delete unnecessary files to free disk space.

Page top
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No Printing Results/Printing Is Blurred/Colors Are Wrong/White
Streaks

= No Printing Results

= Printing Is Blurred

ABCD

»» Colors Are Wrong

- White Streaks

" 'L-

._-__-_----r“

Illlq"

e Check 1: Did you confirm the paper and print quality settings?
= Print Results Not Satisfactory

e Check 2: Is the FINE Cartridge installed properly?
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Remove the FINE Cartridge, then reinstall it. The print result may be improved by reinstalling the
FINE Cartridge.

(A)

* Check 3: Print the Nozzle Check Pattern and perform any necessary

maintenance operations such as Print Head Cleaning.

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head
nozzles.

Refer to Routine Maintenance for the Nozzle Check Pattern printing, Print Head Cleaning, and Print
Head Deep Cleaning.

e |f the Nozzle Check Pattern is not printed correctly:
After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the
pattern.
e |f the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning.
If the problem is not resolved after performing the Print Head Deep Cleaning, try it again.
o [f the problem is not resolved after performing the Print Head Deep Cleaning twice:
Ink may have run out. Replace the FINE Cartridge.

e Check 4: When a FINE Cartridge runs out of ink, replace it with a new

one.

e Check 5: When using paper with one printable surface, make sure that

the paper is loaded with the printable side facing up.
Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.

Refer to the instruction manual supplied with the paper for detailed information on the printable side.

* Check 6: Change the Paper Thickness Lever setting.

Adjust the position of the Paper Thickness Lever according to the type of paper you are printing on.
Refer to Loading Paper-

Depending on the printing content, the printing surface may become scratched or the corners or
edges of the paper may become smudged even for the types of paper which require you to set the
lever to the left. In this case, set the Paper Thickness Lever to the right.

* Reset the Paper Thickness Lever to the left when you finish printing. If the lever is not set back to
the left, the inside of the printer is more likely to get dirty due to the wider clearance between the print
head and the loaded paper. It may also reduce print quality.
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If the corners or edges of the paper are smudged, try to print with the Paper Thickness Lever
set to the right.
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Colors Are Unclear

e Check 1: Enable color correction.

When printing photographs or other graphics, enabling color correction in the printer driver may
improve color.

Select Vivid Photo in the Effects sheet in the printer properties dialog box.

ks
ACINIOSN

Select Color Options in the pop-up menu in the Print dialog box, and then select Vivid Photo on the

Color Mode.

In Mac OS X v 10.4.x or Mac OS X v 10.3.9, select Special Effects in the Print dialog box, and then

select Vivid Photo.

e Check 2: Is the FINE Cartridge installed properly?

Remove the FINE Cartridge, then reinstall it. The print result may be improved by reinstalling the
FINE Cartridge.

(A)

e Check 3: When a FINE Cartridge runs out of ink, replace it with a new

one.

* Check 4: Is the Nozzle Check Pattern printed properly?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head
nozzles.

Refer to Routine Maintenance for the Nozzle Check Pattern printing, Print Head Cleaning, and Print
Head Deep Cleaning.

o [f the Nozzle Check Pattern is not printed correctly:
After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the
pattern.

e |f the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning.
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If the problem is not resolved after performing the Print Head Deep Cleaning, try it again.
e |f the problem is not resolved after performing the Print Head Deep Cleaning twice:
Ink may have run out. Replace the FINE Cartridge.

Ej note

Printed colors may not match screen colors due to basic differences in the methods used to
produce colors. Color control settings and environmental differences can also affect how colors
appear on the screen.
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Lines Are Misaligned

” Ta

* Check 1: Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

e Check 2: Perform Print Head Alignment

If you did not align the Print Head after installation, straight lines may be printed misaligned.

Routine Maintenance

e Check 3: Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet. Then, select the Prevent loss of print data check box in
the displayed dialog.

e Check 4: Is the Printing layout printing or Binding margin function being

used?
When the Printing layout printing or Binding margin function is being used, thin lines may not be
printed. Try thickening the lines in the document.
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Printed Paper Curls or Has Ink Blots

- Printed Paper Curls

2O0OOOOOOOOOOOOOOOOOOOOOOOOOOOOOCOOOOROO0OL
= Printed Paper Has Ink Blots

e Check 1: Did you confirm the paper and print quality settings?
= Print Results Not Satisfactory

e Check 2: If the intensity is set high, reduce the Intensity setting in the

printer driver and try printing again.

If you are using plain paper to printimages with high intensity, the paper may absorb too much ink
and become wavy, causing paper abrasion.

Confirm the intensity using the printer driver.
= Adjusting Intensity

e Check 3: Is Photo Paper being used for printing photographs?

When printing data with high color saturation such as photographs or images in deep color, we
recommend using Photo Paper Plus Glossy Il or other Canon speciality paper.

= Loading Paper

Page top
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Paper Is Smudged/Printed Surface Is Scratched

= Paper Is Smudged

The Edges of Paper Printed Surface
Are Smudged Is Smudged

. Printed Surface Is Scratched

e Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

e Check 2: Is the appropriate type of paper being used? Check the

following:

e Check to see if the paper you are printing on is suitable for your printing purpose.
Loading Paper
e When performing Borderless Printing, make sure that the paper you are using is suitable for
Borderless Printing.
If the paper you are using is not suitable for Borderless Printing, the print quality may be
reduced at the top and bottom edges of the paper.
Printing Area

e Check 3: Load the paper after correcting its curl.

e For Plain Paper
Turn the paper over and reload it to print on the other side.

Leaving the paper loaded on the Rear Tray for a long time may cause the paper to curl. In this
case, load the paper with the other side facing up. It may resolve the problem.

We recommend putting unused paper back into the package and keep it on a level surface.

e For Other Paper

1. With the printing side (A) facing up, cover the paper with a fresh sheet of plain paper to
avoid staining or scratching the surface.

2. Roll up the paper in the opposite direction to the paper curl as seen below.

(A)

3. Check to see that the paper curl is within approximately 0.08 to 0.2 inches / 2 to 5 mm (B) in
height.
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' (A)
| )
We recommend printing curl-corrected paper one sheet at a time.

Ej note

Depending on the media type, the paper may be smudged or may not be fed properly even if it
is not curled. In such cases, follow the procedure described above to curl the paper before
printing. This may improve the print result.

e Check 4: If intensity is set high, reduce the Intensity setting in the printer

driver and try printing again.

If you are using plain paper to print images with high intensity, the paper may absorb too much ink
and become wavy, causing paper abrasion.

Reduce the Intensity setting in the printer driver and try printing again.

1. Open the printer properties dialog box.
Opening the Printer Properties Dialog Box (Windows)

2. On the Main sheet, select Manual for Color/Intensity, and then click Set.

3. Drag the Intensity slide bar on the Color Adjustment sheet to adjust the intensity.

M-'-z_-:«'.,w-.'-:q:-' =
(L B

1. Open the Print dialog box.
Opening the Page Setup and Print Dialog Box (Macintosh)

2. Select Color Options in the pop-up menu.
3. Drag the Intensity slide bar to set the intensity.

e Check 5: Is printing performed beyond the recommended printing area?

If you are printing beyond the recommended printing area of your printing paper, the lower edge of
the paper may become stained with ink.

Resize your original document in your application software.
Printing Area

e Check 6: Is the Paper Feed Roller dirty?

Clean the Paper Feed Roller.
Routine Maintenance

Ej note

Cleaning the Paper Feed Roller will wear the roller, so perform this procedure only when
necessary.

e Check 7: Is the inside of the printer dirty?

When performing duplex printing, the inside of the printer may become stained with ink, causing the
printout to become smudged.

Perform the Bottom Plate Cleaning to clean the inside of the printer.
Cleaning Inside the Printer

E note

To prevent the inside of the printer from stains, set the paper size correctly.
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e Check 8: Set Ink Drying Wait Time longer.

Doing so gives the printed surface enough time to dry so that paper smudged and scratched are
prevented.

1. Make sure that the printer is turned on.

2. Open the printer properties dialog box.
Opening the Printer Properties Dialog Box (Windows)

3. Click the Maintenance tab and then Custom Settings.
4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click Send.

5. Confirm the message and click OK.

1. Make sure that the printer is turned on.

2. Open the Canon IJ Printer Utility.
Opening the Canon IJ Printer Utility (Macintosh)

3. Select Custom Settings in the pop-up menu.
4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click Send.
5. Confirm the message and click OK.

* Check 9: Change the Paper Thickness Lever setting.

Adjust the position of the Paper Thickness Lever according to the type of paper you are printing on.
Refer to Loading Paper-
Depending on the printing content, the printing surface may become scratched or the corners or

edges of the paper may become smudged even for the types of paper which require you to set the
lever to the left. In this case, set the Paper Thickness Lever to the right.

* Reset the Paper Thickness Lever to the left when you finish printing. If the lever is not set back to
the left, the inside of the printer is more likely to get dirty due to the wider clearance between the print
head and the loaded paper. It may also reduce print quality.

Ej note

If the corners or edges of the paper are smudged, try to print with the Paper Thickness Lever
set to the right.

* Check 10: Is the paper scratched by other loaded paper?

Depending on the media type, the paper may be scratched by other loaded paper when feeding from
the Rear Tray. In this case, load one sheet at a time.

Page top
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Back of the Paper Is Smudged

&

e Check 1: Did you confirm the paper and print quality settings?
Print Results Not Satisfactory

* Check 2: Perform the Bottom Plate Cleaning to clean the inside of the

printer.
Cleaning Inside the Printer

——Inote

= When performing duplex printing or too much printing, the inside may become stained with ink.
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Colors Are Uneven or Streaked

> Colors Are Uneven

e Check 1: Did you confirm the paper and print quality settings?
= Print Results Not Satisfactory

e Check 2: Print the Nozzle Check Pattern and perform any necessary

maintenance operations such as Print Head Cleaning.

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head
nozzles.

Refer to Routine Maintenance for the Nozzle Check Pattern printing, Print Head Cleaning, and Print
Head Deep Cleaning.

o [f the Nozzle Check Pattern is not printed correctly:
After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the
pattern.
o |f the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning.
If the problem is not resolved after performing the Print Head Deep Cleaning, try it again.
e |f the problem is not resolved after performing the Print Head Deep Cleaning twice:
Ink may have run out. Replace the FINE Cartridge.

e Check 3: Perform Print Head Alignment.

=+ Routine Maintenance

Page top #
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Printing Does Not Start

* Check 1: Make sure that the power plug is securely plugged in, then

turn the printer on.

While the Power lamp is flashing green, the printer is initializing. Wait until the Power lamp stops
flashing and remains lit green.

E note

When printing large data such as a photo or graphics, it may take longer to start printing. While
the Power lamp is flashing green, the computer is processing data and sending it to the
printer. Wait until printing starts.

e Check 2: Make sure that the USB cable is securely plugged in to the

printer and the computer, then check the following:

e |f you are using a relay device such as a USB hub, disconnect it, connect the printer directly to
the computer, and try printing again. If printing starts normally, there is a problem with the relay
device. Consult the reseller of the relay device for details.

® There could also be a problem with the USB cable. Replace the USB cable and try printing
again.

e Check 3: Restart your computer.

If there are any unnecessary print jobs, delete them.
Deleting the Undesired Print Jobs

e Check 4: Make sure that your printer's name is selected in the Print

dialog box.
The printer will not print properly if you are using a driver for a different printer.

In Windows, make sure that your printer's name is selected in the Print dialog box.
On a Macintosh, make sure that your printer's name is selected in Printer in the Print dialog box.

EE note
To make the printer the one selected by default, select Set as Default Printer (Windows),
Default Printer or Make Default (Macintosh).

e Check 5: Configure the printer port appropriately.

Configure "USBnnn" (where "n" is a number) as the printer port.
1. Log on as a user account with administrator privilege.

2. Click Control Panel, then Printer under Hardware and Sound.

In Windows XP, click Control Panel, Printers and Other Hardware, then Printers and Faxes.
In Windows 2000, click Control Panel then Printers.

3. Right-click the Canon XXX icon, then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named USBnnn (where "n" is a number) with Canon XXX appearing in the
Printer column is selected for Print to the following port(s).
If the setting is incorrect, reinstall the printer driver or change the printer port to the correct one.
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Printing Stops Before It Is Completed

* Check 1: Has the printer been printing continuously for along period?

If the printer has been printing continuously for a long time, the Print Head may overheat. To protect
the Print Head, the printer may stop printing at a line break for a period of time and then resume
printing.

In this case, interrupt your print session at a convenient time and turn the printer off for at least 15
minutes.

Additionally, if the printer has been printing graphics or photos with intense colors continuously over
a period of time, the printer may stop printing to protect the Print Head. In this case, printing will not
resume automatically. Turn the printer off for at least 15 minutes.

Acaution

The Print Head and the surrounding area can become extremely hot inside the printer. Never
touch the Print Head or nearby components.

* Check 2: Is the paper loaded?

Make sure that paper is loaded in the Rear Tray.
If the printer has run out of paper, load paper.

e Check 3: Do the printing documents have lots of photographs or

illustrations?

Printing large data such as photos or graphics takes time for the printer and the computer to
process, during which the printer may appear to have stopped operating.

In addition, when printing data that uses a large amount of ink continuously on plain paper, the
printer may pause temporarily. In either case, wait until the process is complete.

Ej note

If you are printing a document with a large printing area or printing multiple copies of a
document, printing may pause to allow the ink to dry.
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Printer Moves But Ink Is Not Ejected

* Check 1: Are the Print Head nozzles clogged?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head
nozzles.

Refer to Routine Maintenance for the Nozzle Check Pattern printing, Print Head Cleaning, and Print
Head Deep Cleaning.

e [f the Nozzle Check Pattern is not printed correctly:
After performing the Print Head Cleaning, print the Nozzle Check Pattern and examine the
pattern.
e |f the problem is not resolved after performing the Print Head Cleaning twice:
Perform the Print Head Deep Cleaning
If the problem is not resolved after performing the Print Head Deep Cleaning, try it again.
e |f the problem is not resolved after performing the Print Head Deep Cleaning twice:
Ink may have run out. Replace the FINE Cartridge.

e Check 2: Is the FINE Cartridge installed properly?

Remove the FINE Cartridge, then reinstall it. The print result may be improved by reinstalling the
FINE Cartridge.

(A)

e Check 3: When a FINE Cartridge runs out of ink, replace it with a new

one.
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Printing Speed Not as Fast as Expected

e Check 1: Is printing performed in Quiet Mode?

Print speed is reduced if you specified to print in Quiet Mode in the printer driver. For faster printing,
do not print in Quiet Mode.

Reducing the Printer Noise

e Check 2: Is the print quality set too high?

Increase the printing speed setting in the printer driver. Setting to prioritize speed makes printing
faster.

000

1. Open the printer properties dialog box.
Opening the Printer Properties Dialog Box (Windows)

2. On the Main sheet, select Fast for the Print Quality setting.

Depending on the media type, the Fast option may not be available.
| acintosh

1. Open the Print dialog box.
Opening the Page Setup and Print Dialog Box (Macintosh)

2. Select Quality & Media in the pop-up menu and then select Fast for the Print
Quality setting.

Depending on the media type, the Fast option may not be available.

—=l note

Printing speed may not improve noticeably by following the instructions above, depending on your
system environment.
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FINE Cartridge Holder Does Not Move to the Position for
Replacing

e Check 1: Is the Power lamp off?

Check if the Power lamp is lit green.

The FINE Cartridge Holder will not move unless the power is on. If the Power lamp is off, close the
Front Cover and turn the printer on.

While the Power lamp is flashing green, the printer is initializing. Wait until the Power lamp stops
flashing and remains lit green, and then open the Front Cover again.

e Check 2: Is the Alarm lamp flashing?

Close the Front Cover, confirm the number of times the Alarm lamp is flashing, take the appropriate
action to resolve the error, and then reopen it. For details on how to resolve the error, see Alarm
Lamp Flashes Orange-

e Check 3: Has the Front Cover been left open for 10 minutes or longer?

If the Front Cover is left open for more than 10 minutes, the FINE Cartridge Holder moves to the right
to prevent the Print Head from drying out. Close and reopen the Front Cover to return the FINE
Cartridge Holder to the left.

e Check 4: Has the printer been printing continuously for along period?

Close the Front Cover, wait a while, then reopen it.

If the printer has been printing continuously for a long time, the Print Head will overheat, and the
printer stops printing temporarily to protect the Print Head.

Ej note

Opening the Front Cover while printing moves the FINE Cartridge Holder to the right. Close the
Front Cover, and reopen it after printing is complete.
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Paper Does Not Feed Properly

e Check 1: Make sure of the following when you load paper.

e When loading two or more sheets of paper, align the edges of the sheets before loading.

e When loading two or more sheets of paper, make sure that the paper stack does not exceed the
paper support load limit.
However, proper feeding of paper may not be possible at this maximum capacity depending on
the type of paper or environmental conditions (either very high or low temperature and humidity).
In such cases, reduce the sheets of paper you load at a time to less than half of the paper
support load limit.

e Always load the paper in portrait orientation, regardless of the printing orientation.

e When you load the paper, load the paper with the print side facing UP. Align the paper stack
against the right side of the Rear Tray and slide the Paper Guide so that it just touches the left
edge of the stack.

Loading Paper

e Check 2: Check to see if the paper you are printing on is too thick or

curled.
Loading Paper

e Check 3: Make sure of the following when you load envelopes.

e When printing on envelopes, refer to Loading Paper, and prepare the envelopes before printing.
Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are
placed in landscape orientation, they will not feed properly.

o Set the Paper Thickness Lever to the right.

Loading Paper

e Check 4: Remove any foreign objects from the Rear Tray.

* Check 5: Turn off the printer, open the Front Cover, and remove the
foreign object.

Be careful not to touch the components inside the printer.

* Check 6: Clean the Paper Feed Roller.

Routine Maintenance

Ej note

Cleaning the Paper Feed Roller will wear the roller, so perform this procedure only when
necessary.
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Paper Jams
== note

If you need to turn off the printer to remove jammed paper during printing, press the
RESUME/CANCEL button to cancel print jobs before turning off the printer.

If the paper is jammed in the Paper Output Slot or the Rear Tray:
Remove the paper following the procedure below.

1. Slowly pull the paper out, either from the Rear Tray or from the Paper Output Slot,
whichever is easier.

Eﬂ note

If the paper tears and a piece remains inside the printer, turn the printer off, open the
Front Cover, and remove the paper.

Be careful not to touch the components inside the printer.

After removing all paper, close the Front Cover, and turn the printer back on.

If you cannot pull the paper out, turn the printer off and turn it back on. The paper may be
ejected automatically.

2. Reload the paper, and press the RESUME/CANCEL button on the printer.

If you turned off the printer in step (1), all print jobs in the queue are canceled. Reprint if
necessary.

—=I note

When reloading the paper, confirm that you are using the correct paper and are loading it
correctly.

Loading Paper
Ab-sized paper is suited to printing documents consisting mainly of text. We do not
recommend using such paper to print documents with photos or graphics, since the
printout may curl and cause paper exit jams.

If you cannot remove the paper or the paper tears inside the printer, or if the paper jam error
continues after removing the paper, contact your Canon service representative.

In other cases:

Make sure of the following:

e Check 1: Are there any foreign objects in the Rear Tray or around the Paper
Output Slot?

e Check 2: Is the paper curled?

Check 3: Load the paper after correcting its curl.
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Message Appears on the Computer Screen

Service Error 5100 Is Displayed

ﬂmWriting Error/Output Error/Communication Error
M0 Error Number: 300 s Displayed

M0 Error Number: 1700 1 Displayed
M= 1k Info Number: 1688 Is Displayed

M= |0k Info Number: 1686 Is Displayed
iy
W= Other Error Messages

Service Error 5100 Is Displayed

e Check: Is the movement of the FINE Cartridge Holder blocked?

Cancel printing from your computer, turn off the printer. Then clear the jammed paper or
protective material that is preventing the FINE Cartridge Holder from moving.

\-‘ important

Be careful not to touch the components inside the printer. The printer may not print out
properly if you touch it.

Turn the printer back on.

If the problem is not resolved, contact your Canon service representative.

Eilmﬂ:EﬂE’Writing Error/Output Error/Communication Error

e Check 1: If the Power lamp is off, make sure that the power plug is plugged in,
then turn the printer on.

While the Power lamp is flashing green, the printer is initializing. Wait until the Power lamp
stops flashing and remains lit green.

e Check 2: Make sure that the printer port is configured appropriately in the printer
driver.

* In the following instructions, " XXX" signifies your printer's name.
1. Log on as a user account with administrator privilege.

2. Click Control Panel, then Printer under Hardware and Sound.

In Windows XP, click Control Panel, Printers and Other Hardware, then Printers and
Faxes.
In Windows 2000, click Control Panel then Printers.

3. Right-click the Canon XXX icon, then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named USBnnn (where "n" is a number) with Canon XXX appearing
in the Printer column is selected for Print to the following port(s).

If the port setting is not correct, reinstall the printer driver or change the port setting
according to the interface you are using.

e Check 3: Make sure that the USB cable is securely plugged in to the printer and
the computer.

e |f you are using a relay device such as a USB hub, disconnect it, connect the printer
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directly to the computer, and try printing again. If printing starts normally, there is a
problem with the relay device. Consult the reseller of the relay device for details.

e There could also be a problem with the USB cable. Replace the USB cable and try
printing again.

e Check 4: Make sure that the printer driver is installed correctly.

Uninstall the printer driver following the procedure described in Uninstalling the Printer Driver
and reinstall it following the procedure described in your setup manual.

e Check 5: Check the status of the device on your computer.

Follow the procedure below to check the status of the device.

1. cClick Control Panel, Hardware and Sound, then Device Manager.

If the User Account Control screen is displayed, follow the on-screen instructions.

In Windows XP, click Control Panel, Performance and Maintenance, System, then click
Device Manager on the Hardware sheet.

In Windows 2000, click Control Panel, System, then Device Manager on the Hardware
sheet.

2. Double-click Universal Serial Bus controllers then USB Printing Support.

If USB Printing Support is not displayed, make sure that the printer is correctly connected
to the computer.

Check 3: Make sure that the USB cable is securely plugged in to the printer and the
computer.

3. Click the General tab and make sure that there is no indication of a problem with the
device.

If a device error is displayed, refer to Windows help to resolve the error.

__ acintosh Error Number: 300 Is Displayed

e Check 1: If the Power lamp is off, make sure that the power plug is plugged in,
then turn the printer on.

While the Power lamp is flashing green, the printer is initializing. Wait until the Power lamp
stops flashing and remains lit green.

e Check 2: Make sure that the USB cable is securely plugged in to the printer and
the computer.

e |f you are using a relay device such as a USB hub, disconnect it, connect the printer
directly to the computer, and try printing again. If printing starts normally, there is a
problem with the relay device. Consult the reseller of the relay device for details.

e There could also be a problem with the USB cable. Replace the USB cable and try
printing again.

e Check 3: Make sure that your printer's name is selected in the Print dialog box.
Opening the Page Setup and Print Dialog Box (Macintosh)

__acintosh Error Number: 1700 Is Displayed

e See Eight flashes: in Alarm Lamp Flashes Orange and take the appropriate
action.

__acintosh Ink Info Number: 1688 Is Displayed

e See Four flashes: in Alarm Lamp Flashes Orange and take the appropriate
action.
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__acintosh Ink Info Number: 1686 Is Displayed

e See Sixteen Flashes: in Alarm Lamp Flashes Orange and take the appropriate
action.

i\:il\-’lmﬂﬂzlglOther Error Messages

e Check: If an error message is displayed outside the printer status monitor, check
the following:

e "Could not spool successfully due to insufficient disk space"”
Delete any unnecessary files to increase the amount of free space on the disk.
e "Could not spool successfully due to insufficient memory"
Quit other running applications to increase available memory.
If you still cannot print, restart your computer and retry printing.
e "Printer driver could not be found"
Uninstall the printer driver according to the procedure described in Uninstalling the
Printer Driver, and then reinstall it.
e "Could not print Application name - File name"
Try printing again once the current job is complete.
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For Windows Users

Printer Status Monitor Is Not Displayed

e Check: Is the printer status monitor enabled?

Make sure that Enable Status Monitor is selected on the Option menu of the printer status
monitor.

1. Open the printer properties dialog box.
Opening the Printer Properties Dialog Box (Windows)

2. On the Maintenance sheet, click View Printer Status.

3. Select Enable Status Monitor on the Option menu if it is not selected.

The Inkjet Printer/Scanner Extended Survey Program Screen Is Displayed

If the Inkjet Printer/Scanner Extended Survey Program is installed, the confirmation screen asking
to send the printer usage information will be displayed three months and then six months after the
installation. After that, it will be displayed every half a year for about four years.

Read the instructions on the screen and follow the procedure below.

= Inkjet PrinterScarner Edended Survey Pragram
Thank you for your cooperation in Inkjet PrinterfScanner Extended Survey Program.
The folowing nformation recorded in your Canon nkjet printer/'scanner wil be colected and sent ta Canon,

<05 version and bnguage, dsplay setting nformation
-Dewice drver and applcation software usage logs

If Canon inkjet printer & used, the folowng nformation, recorded in your printer, wil also be colected and sent.

Primter's ID nurmber, Instalaton date and time, Ink use nforrmation, Number of sheets panted, and Maintenance
niformaton

Amy inforrration about your computer ather than that above of any of your personal nformation will not be colected or
sent. For this reason, from the colecbed nformation that & sent to us, we are unable to dentify specfic customers, We
are therefora unable to respond to requests to disclose any collacted nformation.

If you agres that we colect and send the niomration abowe and that we annat dscose any colected nformation, cick
Apgree. Othenwse, chik Do not agres.

Detas

| Da not agree Agree

e |f you agree to participate in the survey program:

Click Agree, then follow the on-screen instructions. The printer usage information will be sent
to Canon via the Internet.

note

= When sending the information, the caution screen such as an Internet security screen
may be displayed.
In this case, confirm the program name is "IJPLMUI.exe", then allow it.

e |f you do not agree to participate in the survey program:

Click Do not agree. The confirmation screen will be closed, and the survey at that time is
skipped. The confirmation screen will be displayed again three months later.

e To uninstall the Inkjet Printer/Scanner Extended Survey Program:
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To uninstall the Inkjet Printer/Scanner Extended Survey Program, click Details, then click
Uninstall on the detail description screen. Once the program has been uninstalled, neither
the survey nor the transmission of the printer usage information will be performed.

Inkjet Prntes/Scanner Extended Survey Program

For development and marketing of products that better meet customer needs, this survey requests that the folowing
Canon nkjet prntes/scanner related information ba cobectad by the survey program.

-0 version and bnguage, deplay settng mformation
Device diver and applcation software usage logs

If Canon inkjet printer = used, the folowing nformation, recorded in your printer, will also be collected.
-Prnter's ID number, Instalation date and time, Ink use nforrmation, Number of sheets pented, and Mantenance
Information

Infoerration about every Canon nijet prnter/sanner connected to ths computer wil be colected on ths computer at
ntervak of about one month. Information will be collected automatically, requinng no customer operation.

Inforrration wil be sent to Canon through the Intamet after three months, after s months, and then samannualy for
four years. To sand information, the program reguires you to connedt to the Intemet; & deplys a confimation window
reganding transmission. Your cooperation is requested F it is convenient for you, The Intermet connection fee shal be

bome by you. Ary of your personal information wil not be sent,

If you wish to uninstal ths program, chck Uninstal. This will uninstall the program, and no further survey wil be made.

=)

o ]
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FAQs

= No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks
= Printer Moves But Ink Is Not Ejected

= Cannot Install the Printer Driver

= Printing Does Not Start

= Printing Stops Before It Is Completed

= MWriting Error/Output Error/Communication Error
= Print Results Not Satisfactory

= Paper Jams

= Paper Does Not Feed Properly
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If You Cannot Resolve the Problem

If you cannot resolve the problem with any of the workarounds in this chapter, please contact the seller of
the printer or a Canon service representative.

Canon support staff are trained to be able to provide technical support to satisfy customers.

ﬁcaution

If the printer emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the power
cord from the outlet and contact the seller or your Canon service representative. Never attempt to

repair or disassemble the printer yourself.
Attempts by customers to repair or take apart the printer will invalidate any warranty regardless of

whether the warranty has expired.

Before contacting your Canon service representative, confirm the following:

e Product name:
* Your printer's name is located on the front cover of the setup manual.

e Serial number: please refer to the setup manual
e Details of the problem
e What you tried to solve the problem, and what happened
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using
the printer driver.

Restrictions on the Printer Driver

o With some applications, the Copies setting in the Page Setup tab of the printer driver may not be
enabled.
In this case, use the copies setting in the Print dialog box of the application software.

o [f the selected Language in the About dialog box does not match the operating system interface
language, the driver screen may not be displayed properly.

e Do not change the Advanced tab items of the printer properties. If you change any of the items, you
will not be able to use the following functions correctly.
Also, if Print to file is selected in the Print dialog box of the application software and with applications
that prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the following
functions will not operate.
e Preview before printing on the Main tab
e Prevent loss of print data in the Print Options dialog box
e Page Layout Printing, Poster Printing, Booklet Printing, Duplex Printing, Specify Margin..., Print from

Last Page, Collate, and Stamp/Background... on the Page Setup tab

e Since the resolution in the preview display differs from the printing resolution, text and lines in the
preview display may appear different from the actual print result.

e With some applications, the printing is divided into multiple print jobs.
To cancel printing, delete all divided print jobs.

e |f image data is not printed correctly, display the Print Options dialog box from the Page Setup tab
and change the setting of Disable ICM required from the application software. This may solve the
problem.

e Software windows may not appear correctly on Windows Vista when fonts are set to Larger scale. If
you want to display the windows with Larger scale fonts, set the desktop theme to Windows Classic
as follows:

1. Select Control Panel from the Start menu.

2. Select Appearance and Personalization -> Personalization -> Theme.
The Theme Settings dialog box opens.

3. At the Theme Settings dialog box, click the Themes tab, and select Windows Classic from
Theme.

4. Click OK.
Desktop changes to Windows Classic display.

Points to Note with Applications

e There are following restrictions in Microsoft Word (Microsoft Corporation).
e |f Microsoft Word has the same printing functions as the printer driver, use Word to specify them.
e \When selecting Scaled Printing, Fit-to-Page Printing, or Page Layout Printing from the Page Layout
list on the Page Setup tab, the selected printing function may not be effective, depending on the
version of Word.
If this happens, follow the procedure below.
1. Open Word's Print dialog box.
2. Open the printer driver setup window, specify Page Layout on the Page Setup tab, and click
OK.
Without starting printing, close the Print dialog box.
Open Word's Print dialog box again.
Open the printer driver setup window again and click OK.
Start printing.

ook w

e |llustrator/Adobe Systems Inc.
If Bitmap Printing takes effect, printing may take time or some data may not be printed. Print after
clearing the Bitmap Printing check box in the Print dialog box.
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Appendix

= Printing Area

= Deleting the Undesired Print Jobs

= Updating the Printer Driver

= Uninstalling the On-Screen Manuals

= Transporting and Storing the Printer

= Opening the Printer Properties Dialog Box (Windows)

= Opening the Page Setup and Print Dialog Box (Macintosh)
= Opening the Canon IJ Printer Utility (Macintosh)

= Connecting the Printer to the Network
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Printing Area

To ensure the best print quality, the printer allows a margin along each edge of media. The actual
printable area will be the area inside these margins.

Recommended printing area -: Canon recommends that you print within this area.

Printable area I:I: The area where it is possible to print.
However, printing in this area can affect the print quality or the paper feed precision.

——i note

Borderless Printing
By selecting Borderless Printing option, you can make prints with no margins.
When performing Borderless Printing, slight cropping may occur at the edges since the printed
image is enlarged to fill the whole page.
For Borderless Printing, use the following paper.
Glossy Photo Paper "Everyday Use" GP-501
Photo Paper Glossy GP-502
Photo Paper Plus Semi-Gloss SG-201
Photo Paper Plus Glossy Il PP-201
Photo Paper Pro || PR-201
Matte Photo Paper MP-101
Performing Borderless Printing on any other type of paper may substantially reduce printing
quality and/or result in printouts with altered color hues.
Borderless Printing on plain paper may result in printouts with reduced quality. Use them only
for test printing.
Depending on the type of paper, Borderless Printing may reduce the print quality at the top and
bottom edges of the paper or cause these parts to become smudged.

Letter, Legal
Envelopes
Other Sizes than Letter, Legal, Envelops

Page top
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Other Sizes than Letter, Legal, Envelops

Size Printable Area (width x height)

A5 5.56 x 7.95 inches / 141.2 x 202.0 mm

Ad 8.00 x 11.38 inches / 203.2 x 289.0 mm

B5 6.90 x 9.80 inches / 175.2 x 249.0 mm
4"x6"/10x 15 cm 3.73 x5.69 inches / 94.8 x 144.4 mm

4" x8"/10x 20 cm 3.73 x 7.69 inches / 94.8 x 195.2 mm
5"x7"/13x18 cm 4.73 x 6.69 inches / 120.2 x 169.8 mm
8"x10"/2x25cm 7.73 x9.69 inches / 196.4 x 246.0 mm

Wide 3.73 x6.80 inches / 94.8 x 172.6 mm

40.12in /3.0 mm .-
-T- -} [1.51 in/38.3 mm

|
0.20in /5.0 mm - [ 1.23in/31.2 mm

= .

W _i
0.13 in/ 3.4 mm 0.13 in/ 3.4 mm

F

-Recommended printing area

: Printable area
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Letter, Legal

Size Printable Area (width x height)
Letter 8.00 x 10.69 inches / 203.2 x 271.4 mm
Legal 8.00 x 13.69 inches / 203.2 x 347.6 mm

}4.0.12in /3.0 mm L
T- - |-1.5‘| in/ 38.3 mm

o | |-1.23 in/31.2mm

0.20 in [ 5.0 mm

r 1

1 I

1 1

1 1
i B brarsl W [y

0.25in/ 6.4 mm 0.25in/ 6.3 mm

-Recommended printing area

I: Printable area
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Envelopes
Size Recommended Printing Area (width x height)
European DL* 4.06 x 7.12 inches / 103.2 x 180.8 mm
US Comm. Env. #10* 3.86 x 7.96 inches / 98.0 x 202.1 mm

¥
0.32in/8.0 mmZ_

=

1.23in/312mm § _
-

0.13 in/ 3.4 mm 0.

e

3in/3.4 mm

- -
1

-Recommended printing area
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Deleting the Undesired Print Jobs

If the printer does not start printing, the print job data cancelled or failed may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Display the Canon IJ Status Monitor

Click the Status Monitor button displayed on the Task Bar.
The Canon IJ Status Monitor appears.

2. Display the print jobs

Click Display Print Queue....
The Print Queue window opens.

3. Delete the print jobs

Select Cancel All Documents from the Printer menu.
When the confirmation message appears, click Yes.

The print job is deleted.
\F Important

Users who have not been granted access permission for printer management cannot delete the
print job of another user.
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Updating the Printer Driver

= Obtaining the Latest Printer Driver
= Uninstalling the Printer Driver

= Before Installing the Printer Driver
= Installing the Printer Driver

Page top
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Obtaining the Latest Printer Driver

By updating the printer driver to the latest version of the printer driver, unresolved problems may be
solved.

You can check the version of the printer driver by clicking the About... button on the Maintenance tab.

Access our web site through the Internet and download the latest printer driver for your model.

\‘ Important

You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

Before installing the latest printer driver, delete the previously installed version.

For information on how to delete the printer driver, refer to Uninstalling the Printer Driver -

Related Topics
Before Installing the Printer Driver

Installing the Printer Driver
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Uninstalling the Printer Driver

The printer driver you no longer use can be deleted.
When deleting the printer driver, first exit all programs that are running.

The procedure to delete the unnecessary printer driver is as follows:

If there is an uninstaller

1.

Start the uninstaller

e |n Windows Vista or Windows XP, select the Start menu -> All Programs -> "Your model name"
Printer Driver Uninstaller.

e |In Windows 2000, select the Start menu -> Programs -> "Your model name" -> Printer Driver
Uninstaller.

The Printer Driver Uninstaller dialog box is displayed.

\‘ Important

->

In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstalling
or starting software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged on to an administrator account, click Continue or Allow to continue.

Some applications require an administrator account to continue. If you are logged on to a
standard account, switch to an administrator account, and restart the operation from the
beginning.

Execute the uninstaller

Click Execute. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the Printer Driver is completed.

If there is no uninstaller

If there is no uninstaller in the Start menu of Windows Vista, follow these steps:

1.

Select the printer to be deleted

Select the Start menu -> Control Panel -> Hardware and Sound -> Printers.
Click the model to delete, then press the Alt key on your keyboard. On the File menu, click Delete.

. Delete the printer

If the User Account Control dialog box appears, click Continue. Then when the confirmation
message appears, click Yes.
The icon is deleted.

Select the printer driver to be deleted

Press the Alt key. On the File menu, select Run as administrator, and then click Sever Properties....
If the User Account Control dialog box appears, click Continue.

Click the Drivers tab. In the Installed printer drivers list, click the printer to delete.

Delete the printer driver

When you click Remove..., Remove Driver And Package dialog box is displayed.
Select Remove driver and driver package, and then click OK.
In the confirmation dialog box, click Yes.

When data collection is completed in the Remove Driver Package dialog box, click Delete.

. Click OK.
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The deletion of the printer driver is complete.

\‘ Important

You may not be able to delete the printer driver properly from the Installed printer drivers list.
If this happens, restart your computer, and try again.
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Before Installing the Printer Driver

This section describes the items that you should check before installing the Printer Driver. You should
also refer to this section if the Printer Driver cannot be installed.

Check the printer status

e Properly connect the personal computer and the printer. For details on connection instructions, refer
to the "Install the Software" in the manual: Getting Started.

e Turn off the printer.

Check the Personal Computer Settings
e Terminate all running applications.

® |n Windows Vista, log on as a user who has the administrator rights.
In Windows XP, log on as the computer administrator.
In Windows 2000, log on as a member of the Administrators group.

EEI Note

If an old version of the Printer Driver is already installed, first delete (uninstall) that version. For
instructions on deleting the Printer Driver, see Uninstalling the Printer Driver -

Related Topics
Obtaining the Latest Printer Driver
Installing the Printer Driver
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Installing the Printer Driver

You can access our web site through the Internet and download the latest Printer Driver for your model.

The procedure for installing the downloaded Printer Driver is as follows:

1. Turn off the printer
\‘ Important

If you turn on the computer while the printer is on, the Windows Plug and Play function is
executed automatically, and the Found New Hardware window (Windows Vista) or Found New
Hardware Wizard window (Windows XP, Windows 2000) is displayed. In this case, click
Cancel.

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

\‘ Important

In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstalling
or starting software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged on to an administrator account, click Continue or Allow to continue.

Some applications require an administrator account to continue. If you are logged on to a
standard account, switch to an administrator account, and restart the operation from the
beginning.

3. Install the driver

At the Welcome window, click Next.
Read the contents of the License Agreement window. After checking the contents, click Yes.
Installation of the Printer Driver begins.

After the Installation Complete window is displayed, check that the printer and the computer are
connected through a cable.

To select the connection port for your printer manually, check the Select printer port check box, and
click Manual selection. At the Select printer port window, select the connection destination, and then
click OK.

4. Complete the installation

Click Complete.
Turn on the printer, and wait awhile until the connection is recognized.

This procedure installs the Printer Driver.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

\‘ Important

When you expand the downloaded compressed file, save the file to a folder such as "temp". Do not
use the characters other than English in the folder name. Otherwise, the printer driver may not be
installed correctly.

You can download the printer driver for free, but any Internet access charges incurred are your
responsibility.

Related Topics
Obtaining the Latest Printer Driver
Before Installing the Printer Driver
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Uninstalling the On-Screen Manuals

Follow the procedure below to uninstall all of the installed on-screen manuals from your computer.

000

All of the installed on-screen manuals will be deleted at the same time.

1. Click Start > All Programs (Programs in Windows 2000) > Canon XXX Manual
(where "XXX" is your printer's name) > Uninstall.

2. Click OK when the confirmation message appears.

—— note

When the message prompting you to restart your computer is displayed, click OK to restart your
computer.

M-'-L-.‘-L!'\-.'-&'-l:-' =
I

On-screen manuals other than printer driver's help are uninstalled at a time.
1. Select Applications on the Go menu.
2. Double-click the Canon Utilities folder, and then the |J Manual folder.

3. Drag the folder of your printer's name into the trash.

4. Drag the | d XXX On-screen Manual icon (where "XXX" is your printer's name) on
your desktop into the trash.
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Transporting and Storing the Printer

When relocating the printer or storing the printer for a long period of time, pack the printer using the
original packing materials.

If you do not have the original packing materials, pack the printer carefully using protective material and
place it inside a sturdy box.

Acaution

Do not transport or store the printer slanted, vertically, or upside-down, as the ink may leak and
damage the printer.

1. Turn the printer off.

2. Confirm that the Power lamp is off and unplug the printer.

\‘ important

Do not unplug the printer while the Power lamp is lit or flashing green, as it may cause
malfunction or damage to the printer, making the printer unable to print.

3. Close the Paper Support.

4. Disconnect the printer cable from the computer and from the printer, and then
disconnect the power plug from the printer.

5. Use adhesive tape to secure all the covers on the printer to keep them from opening
during transportation. Then pack the printer in the plastic bag.

6. Attach the protective material to the printer when packing the printer.

\‘ important
Pack the printer with the FINE Cartridges left installed in the printer.

E note

Clearly label the box as "FRAGILE" or "HANDLE WITH CARE".
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Opening the Printer Properties Dialog Box (Windows)

The printer driver setup window can be displayed through the application software in use or the Start
menu of the Windows.

Open the Printer Properties Dialog Box through the Application Software

Follow the procedure below to configure print settings when printing.

1. Select the command you perform printing on the application software in use.

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties).

The printer properties dialog box opens.

E-j note

Opening the printer properties dialog box through Properties displays such tabs
regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not
appear when opening through Printing Preferences or application software. About tabs
regarding Windows functions, refer to the user's manual for the Windows.

Open the Printer Properties Dialog Box through the Start Menu

Follow the procedure below to perform maintenance operations such as print head cleaning, or to
configure print settings that are common for all application software.

1. Select items from the Start menu as shown below.
In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.
In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware >

Printers and Faxes.
In Windows 2000, select the Start menu > Settings > Printers.

2. Right-click your model name icon. and then select Printing Preferences from the displayed
menu.
The printer properties dialog box opens.
\‘ important
Depending on application software you use, command names or menu names may vary
and there may be more steps. For details, refer to the user's manual of your application
software.
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Opening the Page Setup and Print Dialog Box (Macintosh)
You can open the Page Setup dialog box and the Print dialog box from the application program you are

using.

Opening the Page Setup Dialog Box
Open the Page Setup dialog box to specify page (paper) settings before printing.

1. Select Page Setup... on the File menu in your application program.

The Page Setup dialog box opens.

Opening the Print Dialog Box
Open the Print dialog box to specify print settings before printing.

1. Select Print... on the File menu in your application program.

The Print dialog box opens.
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Opening the Canon IJ Printer Utility (Macintosh)
To open the Canon IJ Printer Utility, follow the procedure below.
In Mac OS X v.10.5.x

1. Select System Preferences on the Apple menu.

2. Click Print & Fax.

3. Select your printer's name in the Printers and click Open Print Queue....

The job list of your printer is displayed.

4. Click Utility.

The Printer List opens.

5. Select your printer's name in the Product list and click Maintenance.

(ue @
smraduer s Type :
PLG0D series Canon [ Printer

The Canon |J Printer Utility starts up.

In Mac OS X v.10.4.x or Mac OS Xv 10.3.9
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1. Select Applications on the Go menu.

2. Double-click the Utilities folder, and then double-click the Printer Setup Utility icon.

The Printer List opens.

3. Select your printer's name in the Name list and click Utility.

ana Printer List (=]

8 =QFE|¥ o

Make Dafaul Add  Deletd Unility _LolorSyng  Show knfo
Mame & Sratus Kind
= 1900 series Canon (P1900 series

4. Select your printer's name in the Product list and click Maintenance.
afan Printer List

Muse

o Pduer & Type
LS00 series Canan [} Printer

'f. Cancel ;I Metwoark Setting

The Canon |J Printer Utility starts up.
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Connecting the Printer to the Network

If multiple computers are being used in the network environment, you can share the printer connected to

one computer with other computers.
The Windows versions of the computers connected to the network do not necessarily have to be the

same.

Print Seever
"'—.‘
Metwork
S — [ — o —
Chent PC Client PC Client PC

e Settings on Print Server
Describes the procedure for setting up a computer directly connected to a printer with a USB cable.

e Settings on Client PC

Describes the procedure for setting up those computers that will use this printer through the

network.
When you execute print, the data is sent through the print server system to the printer.

\‘ Important

In case an error occurred when a document is printed by the client system to a shared printer, the
error message of Canon IJ Status Monitor will be displayed both on the client system and the print
server system. For regular printing, Canon IJ Status Monitor will be displayed only on the client

system.

-=l Note
Install the printer driver from the Setup CD-ROM that accompanies the printer on the print server
system and each of the client systems according to the OS of each system.

Related Topic
Restrictions on Network Printing
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Settings on Print Server

To use a printer in a network, set printer sharing on the print server system.

The procedure for setting up the print server systems is as follows:

1. Install the printer driver on the print server system

For installation instructions, see the user's manual.

2. Select items from the Start menu as shown below:

e In Windows Vista, select the Start menu -> Control Panel -> Hardware and Sound -> Printers.

e |n Windows XP, select the Start menu -> Control Panel -> Printers and Other Hardware ->
Printers and Faxes.

e |n Windows 2000, select the Start menu -> Settings -> Printers.

The Printers window (Windows Vista, Windows 2000) or Printers and Faxes window (Windows XP)
is displayed.

3. Click the icon for the model name of printer to be shared

e |In Windows Vista, press the Alt key on your keyboard and then select Run as administrator ->
Sharing... from the displayed File menu.
e |In Windows XP or Windows 2000, select Sharing... from the File menu.

E.j Note

Windows XP may display a message recommending the user to use the Network Setup
Wizard to set up sharing.
When this message appears, choose not to use the wizard and then set up sharing.

4. Set sharing

Select Share this printer (Windows Vista, Windows XP) or Shared as (Windows 2000) on the
Sharing tab to set a shared name as desired, and click OK.

\F Important

In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstalling,
or starting software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged on to an administrator account, click Continue or Allow to continue.

Some applications require an administrator account to continue. If you are logged on to a
standard account, switch to an administrator account, and restart the operation from the
beginning.

This completes the setup on the print server system. Next, set up the client systems.
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Settings on Client PC

After setting up the print server system, set up the client system.

The procedure for setting up the client systems is as follows:

In Windows Vista

1. Install the printer driver on the client systems

Select Custom Install for the installation method.
For details on connection instructions, refer to the "Install the Software" in the manual: Getting
Started.

E.j Note

During the installation, a screen prompting you to turn the printer on appears. Click Manual
Selection and then select an appropriate port to complete your installation.

2. Start the wizard

Select the Start menu -> Network -> Add a printer.
The Add Printer window appears.

3. Add a printer

Select Add a network, wireless or Bluetooth printer, and click the icon for the printer that you have
configured on the print server system to be shared, and then click Next.

E.j Note

If the icon for the printer is not displayed, check that the printer is actually connected to the print
server.
It may take some time for the icon for the printer to appear.

4. Complete the setup

Take the appropriate action as described on the screen and then click Finish.
The icon for the shared printer will be created in the Printers window.

This completes the setup on the client systems. You can now share the printer in the network.

In Windows XP/Windows 2000

1. Install the printer driver on the client systems

Select Custom Install for the installation method.
For details on connection instructions, refer to the "Install the Software" in the manual: Getting
Started.

E.j Note

During the installation, a screen prompting you to turn the printer on appears. Click Manual
Selection and then select an appropriate port to complete your installation.

2. Start the wizard

e |n Windows XP, select the Start menu -> Control Panel -> Printers and Other Hardware ->
Printers and Faxes -> Add a printer.
e In Windows 2000, select the Start menu -> Settings -> Printers -> Add a printer.

When Welcome to the Add Printer Wizard screen appears, click Next.

3. Add a printer
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Select A network printer, or a printer attached to another computer (Windows XP) or Network printer
(Windows 2000), then click Next.

On the Specify a Printer window (Windows XP) or Locate Your Printer window (Windows 2000), click
Next and then search for the print server system.

Click the icon for the printer that you have configured on the print server system to be shared, and
then click Next.

E.j Note

If the icon for the printer is not displayed, check that the printer is actually connected to the print
server.

4. Complete the setup

Take the appropriate action as described on the screen and then click Finish.
The icon for the shared printer will be created in the Printers and Faxes window (Windows XP) or
Printers window (Windows 2000).

This completes the setup on the client systems. You can now share the printer in the network.
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Restrictions on Network Printing

These are restrictions that apply if you are using a printer in a network environment. Check the
restrictions for the environment you are using.

If you are sharing a printer in a network

e A print completion message may be displayed. To disable the message display, follow the
procedure below.

e |In Windows Vista:

Press the Alt key from the Printers window on the client system. Open Run as administrator ->
Server Properties... from the displayed File menu.

Uncheck Show informational notifications for network printers on the Advanced tab, and then
restart the computer.

e In Windows XP or Windows 2000:

Open Server Properties from the File menu of the Printer and Faxes window (Windows XP) or the
Printers window (Windows 2000) on the print server system.

Uncheck Notify when remote documents are printed on the Advanced tab, and then restart the
computer.

e The bi-directional communication function is disabled so that the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box on the Ports tab unchecked, the bi-directional function of the printer server system
may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.

e When you print from a client system, you cannot use Canon |J Preview.

o [f the functions on the Maintenance tab cannot be set properly from a client system, they may be
grayed out. In this case, change the settings from the print server.
When you change the settings of the print server, you should delete the icon of the shared printer
from the client system, and then specify the shared settings again in the client system.

If the same printer driver is installed in the print server system and the client system as
the local printer

e The net crawl function may automatically create a network printer icon on the client system.
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Using Easy-PhotoPrint EX

--- Transforming Your Photos into Creative Works of Art ---

Easy-PhotoPrint EX allows you to create albums, calendars and stickers easily using photos taken with
digital cameras.

You can also print borderless photos easily.

Start Easy-PhotoPrint EX

\33 Click Here: Easy-PhotoPrint EX

Note

= See the section below for details on how to use Easy-PhotoPrint EX.
= Printing with the Bundled Application Software

Create a Personalized Photo Album

Creating a personalized photo album is an easy task if you use Easy-PhotoPrint EX!

All you need to do is select which photos to use, select a layout, then load paper into your printer and
print. After you bind the printed sheets, you'll have the one and only album of your memories!

m Er\?l:‘ ;

You can change the layout and background, and attach
comments to photos.

You can arrange a photo across the left and right
pages.

You can also select the size and orientation.

CHECK! ssssssssnsnsnns
Select a theme (background design) to create a single-themed album.

Decorate Items with Text and Frames

You can add text and frames to photos. Attach a description of the photo in an album, and add a frame to
enhance the photo's atmosphere.
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CHECK! ssssssssnssnnss
Select Album to add text and frames. You cannot decorate photos with Photo Print.

Create a Calendar Using Your Favorite Photos

Create calendars easily with Easy-PhotoPrint EX. Create your own calendar using your favorite photos!
It'll be exciting to turn the calendar pages.

2008

You can also create 2-month, 6-month and 12-month

You can use all kinds of photos.
calendars.

Create Stickers

Create stickers easily with Easy-PhotoPrint EX!
Create stickers of your favorite photos and share them with your friends!

CHECK' R R T TN

You can add text to photos.
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About Solution Menu

Quick Shortcut!! Solution Menu

Solution Menu is a menu window that provides quick access from your desktop to Canon applications,
manuals, and online product information.

Solution Menu =[=)I[-1Ed ]

(3=
X :E-.tp' Scanfimport photos or decuments. Print photos or albums, elc.

Ha

l aeClick o PRato Prin 'r-lv,, Goloa web page full of fun,
[~ ok A afa| ready-to-wuse materials.
Change settings or find solutions to [‘_ Gat help for your Cancn product or
prablams., | software.
Registar online. @ Le=giin gnline.

Find information on Canon products.

€ © A

How to Use This Screen

Paoint o @ bulion on the screen to display the description of each function. To use & function, click the
comaspanding butlan.

Click the butlons on the tile bar to change the screen siza.

[+ Stan Sefuticn Menu when Windows stans
L -

\‘ Important

= The number and types of buttons displayed in the window may vary depending on your printer and
region.

Starting Solution Menu

J\# Click Here: Solution Menu

To start from desktop, see below.

Double-click the Solution Menu icon on the desktop. Alternatively, from the Start menu, select (All)
Programs > Canon Utilities > Solution Menu > Solution Menu.

From the next time, Solution Menu starts when Windows starts.

If the Start Solution Menu when Windows starts checkbox at the bottom left of the window is not selected,
Solution Menu does not start when Windows starts.

\‘ Important

= Solution Menu will start automatically when you install it using the Setup CD-ROM that
accompanies the printer.

Changing the Window Size

Click @ (window size: large) or E] (window size: small) on the title bar to change the window size
(large or small).

Solution Menu opens with the last used window size next time it is started.

e \When screen size is small
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Starting an Application

1. Point to a button on the window to display the description of each application.

2. By clicking each button, the introduced application starts.

Follow the same steps to view the manuals or online product information.

@ Important

= Internet connection is required to access the online information. Internet connection fees apply.

Exiting Solution Menu

Click ﬁ (Close) on the title bar.

Restriction on Use of Solution Menu

This software is subject to the following restriction. Keep this point in mind when using it.

e Allicons of the installed applications that support Solution Menu are displayed in the window. After
the installation, you cannot rearrange the icons or delete only the icons.
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